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The EasyCAD screen

When you start EasyCAD, you see a screen with a menu bar, a color bar, an icon bar, and a 
command/prompt line surrounding a large drawing window that contains an arrow-shaped cursor.

The menu bar across the top of the screen contains the titles of the pull-down menus from which 
you can choose a command.

The color bar on the left shows the colors available on your display.    The current color is marked 
with a smaller rectangle.    You can use the color bar to select a different color at any time, even in 
the middle of drawing or editing.

The icon bar on the right gives you quick access to several useful commands such as zooms.

The command/prompt line along the bottom lets you and EasyCAD communicate. Usually, the 
prompt reads "Command:". EasyCAD is asking, What is your command?"

The most important part of your screen is the drawing window through which you view all or part 
of your drawing.

Use the cursor to choose commands from the pull-down menus and to select screen locations. The
cursor is a small arrow which changes shape during drawing and editing, usually to a crosshairs, 
stretching line (rubber band), or stretching rectangle.

Related Topics
Using the menus
Entering commands
Special Keys
Using icon, color and button bars



Using the menus

To choose a menu command, move the arrow cursor to the menu bar at the top of the screen. 
When the cursor is over the title of the menu you want, press the left mouse button. A pull-down 
menu appears with several commands. Holding the left mouse button down, move the highlight up 
and down until it is over the command you want, then release the left button. If you pull down the 
wrong menu, de-select it by pressing the left button over the menu title, or just press the left button 
over the menu title you wish to select.

EasyCAD's commands are grouped in the pull-down menus according to what they do:

· FILE commands manage drawings and files;

· CLIP commands give you access to Windows' Clipboard;

· VIEW commands control what you see in the drawing window;

· DRAW commands add new entities (like lines and circles);

· EDIT commands modify entities that you have already drawn;

· COPY commands let you create multiples of existing entities;

· INSERT commands manage parts and symbols;

· SPECS commands control your drawing environment;

· MOD commands work within commands to refer to existing entities;

· INFO commands report on entities, do caluculations and measurements;

· MACROS commands let you load, edit, and save your own routines;

· HELP commands access EasyCAD's on-line Help facility.



Entering commands

Some commands are carried out immediately while other commands may prompt you for additional
information.    Use the following methods to enter, repeat or cancel commands.

Use the mouse to select commands from the pull-down menus
· Click the left button to choose commands, locations, and values;

· Click the right button to accept the default value, or to cancel or complete a command when no 
default value is present.

Use the keyboard to enter commands
· Type the command's text equivalent at the "Command:" prompt.

Repeat a command EasyCAD has just finished by
· Pressing either mouse button;

· Pressing the ENTER key.

Cancel commands by:
· Choosing another command from a menu;

· Pressing the right mouse button until you see the "Command:" prompt again (you may have 
to press the button several times to cancel a command with many steps).

· Pressing the ESC key will interrupt most commands and redraws.



Entering filenames

Several commands ask you to specify a file name. EasyCAD displays a dialog box prompting you 
to select a file name.    Dialog box options are described below.

File Name- select or type the name of the file you want to open. Listed in this box are all files with 
the extension of the file type as selected in the List Files of Type box.

List Files of Type - Select the file with the extension you want to see in the File Name box.
EasyCAD (ECW) lists all EasyCAD for Windows drawings files in the current directory with the 

extension ECW;

EasyCAD Drawing (ECW) are the same as EasyCAD (ECW) drawings;

EasyCAD 2.33+ Drawing (FCD) lists all EasyCAD (and FastCAD) version 2.33 and newer 
drawings with the extension FCD in the current directory;

AutoCAD (DXF) lists all AutoCAD drawing exchange format files in the current directory with the
extension DXF;

EasyCAD MNU lists all EasyCAD menu files in the current directory with the extension MNU;

EasyCAD SCR lists all EasyCAD script files in the current directory with the extension SCR;

Windows Metafile lists all files in the current directory with the extension WMF.

Directories - select the current directory where the file you want is located.

Drives - select the drive where the file you want is located.



Selecting entities

EasyCAD displays the entity selection dialog box to ask how you will select entities to edit.    As you 
select entities, EasyCAD highlights them in grey.

Next, EasyCAD displays the combine selections dialog box.    You can cancel or modify the 
selection.    If you modify the selection with the logical operators AND, OR, or NOT, EasyCAD 
returns you to the entity selection dialog box.

Repeat the process of refining the selection with AND, OR, or NOT as many times as needed.    
Each time you change the selection, EasyCAD shows which entities are selected by highlighting 
them in grey.    When the selection is exactly what you want, choose DO IT (from the combining 
selections dialog box) to go on with the editing command.

Combine selections by logical operators
You can use the logical operators AND, OR, and NOT to refine your selections until they include 
only the entities you want to edit.

After you select entities by one of the methods in the "Select entities by:" dialog box, EasyCAD 
displays the "Combine selections by:" dialog box. You can select OK to go ahead with the 
command--or choose AND, OR, or NOT to modify the selection.

For example, you might need to erase everything within a selection rectangle (window) except for a 
certain line. You might need to rotate all green text entities on layer3, but not green text on other 
layers. You might want to move entities from layer1, layer2, and layer3 to layer4, or to erase 
everything thats outside a selection window. In most cases, you could accomplish these tasks by 
selecting entities one by one or by repeating the editing command--the logical operators just make 
your work quicker and easier.

This is how the selection process works from EasyCAD's point of view: When you use the entity 
selection dialog box, you are asking EasyCAD to select entities that pass a test. For example, when
you select by WINDOW, EasyCAD searches your drawing, testing each entity to see whether it falls
within the selection rectangle. Logical operators tell EasyCAD to apply two (or more) tests and 
compare the results. If you use AND, entities must pass all the tests to be included in the selection. 
If you use OR, entities only need to pass one of the tests. If you use NOT, only entities that do not 
pass the test are included.

Related Topics
Entity selection dialog box
Combine selections dialog box



Prompts for information

Watch the command line at the bottom of the screen.    EasyCAD prompts you there for any 
additional information (like locations, angles, numeric values, etc.) it needs to complete a 
command.    You can type a response or indicate it visually with the cursor.

Message boxes
If you give EasyCAD a command it does not understand or, needs to alert you to a potential 
problem, a mid-screen window or message box appears containing EasyCAD's message. Click the 
"OK" button or, press the spacebar or ENTER, to clear the message and go on with your work.



Using dialog boxes

When you choose some commands, dialog boxes appear with options for you to select (dimmed 
options are not available.)    Clicking the Cancel button closes the dialog box without saving 
changes.

Selecting dialog box options
Use the mouse.    Click the option or button of your choice with the mouse.    Enter text and 

numeric values as described below.

Use the keyboard.    For example, press TAB to move to the next option, press ENTER to select 
the OK button, and press ESC to select the Cancel button.    You can also press the ALT key 
and type the first underlined letter of the option you of your choice instead of using the 
pointer--for example, ALT-O for "OK."

Entering numbers and text in a dialog box
Text boxes are used to type numbers and edit text (the default value or text is highlighted.)

Drop-down lists click an arrow to see more of the list, click or drag the cursor to select one or 
more options from the list.

Check boxes click the desired check box to select or clear options (selected options are 
specified with an "X".)

Command buttons click a button to perform an action (OK, Cancel, etc.) or to display another 
dialog box.

When you finish typing, choose OK. You may also choose "Cancel" or "Help" at any time.



Using special keys
Use the ALT (Alternate) key for typing special characters:
Hold down ALT while typing the 3-digit ASCII value or the 4-digit ANSI value of the character you 
want to enter. Type the digits on the numeric keypad (the typewriter-style number keys will not 
work). The special character appears when you release the ALT key.
For example, type ALT-248 to enter a degree symbol (°).    EasyCAD draws a space if you type a 
special character that is not defined in the current font.

Use the SHIFT key with the dynamic cursors:
Hold down the SHIFT key to "move" an entitiy while placing it.

Use the CTRL (Control) key with the dynamic cursors:
Hold down the CTRL key to "scale" (enlarge or shrink) an entity while placing it.

Use the SHIFT-CTRL combination with the dynamic cursors:
Hold the SHIFT-CTRL keys together to "rotate" an entity while placing it.



Using dynamic cursors

For some commands that draw arcs, circles, or text, EasyCAD displays special dynamic cursors 
that show you exactly how the new entities will look. You can use the SHIFT    and CTRL keys as 
shortcuts to further modify some of these commands.



Using the icon, color, and button bars
The Icon Bar
The icon bar is located on the right edge of the screen.    When the cursor is over the icon you want,
press the left mouse button. Icons functions are described below, in order of appearance.

    Zoom In icon (zoom in 2.0 times), showing less of the drawing;

    Zoom Out icon (zoom out 2.0 times), showing more of the drawing;

    Zoom Center icon (select new view center);

    Zoom Window icon (zoom into window);

    Zoom Extents icon (recalculate and zoom to extent of drawing);

    Zoom Last icon (restore previous view);

    Layer icon to select, hide, and display different layers.

    Entity Style icon to select or edit the line, fill, and arrow styles EasyCAD uses to draw entities;

    Dimension Style icon to select or edit different dimension formats;

    Text properties icon to select the metrics, font, and character style EasyCAD uses to draw text;

    Help icon Click this icon to display EasyCAD's Help Contents.

The Button Bar
The button bar is located on the bottom, right edge of the screen.    When the cursor is over the 
button you want, press the left mouse button. Button functions are described below, in order of 
appearance.

    Tools button to toggle display of the scroll bars (PAN), color bar, icon bar, and the tracking/status 
line on and off;

 Grid button to toggle grid display on and off;

 Ortho button to toggle orthogonal locking on and off;

 Csr Snap button to toggle cursor snap locking on and off;

 Snap button to toggle snap locking on and off,

 Unlock button to toggle Group Locking off and on.

The Color Bar
The color bar is on the left edge of the screen.    When the cursor is over the color button you want, 
press the left mouse button.    There are 16 colored buttons representing the sixteen drawing colors 
(0-15).    Use the color bar any time you are asked for a color.    Select a different color from the 
color bar, or type a color number

Related Topics
BACKGROUND command 



Entity selection dialog box
Each
The prompt read "Select entity [RIGHT button ends]:".    Use the crosshairs and left button to a point
on an entity you wish to edit.    (To select entities that are very close together, zoom in to get a more 
detailed view).    EasyCAD searches the drawing for all entities that cross or are included in the 
cursor pick box.    EasyCAD marks the entities found by drawing over them in grey.    The prompt 
still reads "Select entity [RIGHT button ends]:".    Continue selecting points or press the right mouse 
button to move on to the next step. Special cases: Pick text entities on their baseline. Pick wide 
paths and polys on their outside edges, or on the center line if frames are showing. Pick smooth 
polygons and splines on their frames if showing, or on the curves themselves if frames are hidden.

Window
The prompt reads "Selection window corner:".    Use the crosshairs and left button to select one 
corner of a rectangular window.    Now the prompt reads Opposite corner:".    Press the left button 
when the stretching rectangle cursor encloses at least one significant point on each entity you want 
to edit.

Layer
The prompt reads "Entities on layer name [Dialog]:".    Press the right button, the SPACEBAR, or 
ENTER to see the Layer Management dialog box, or type the name of the layer, if known. If the 
layer you select contains an entity that is part of a group, EasyCAD selects the entire group. You 
can also use the LIKE modifier to select entities whose layer is the same as a selected entity.

All
Selects every entity in the drawing, including those outside the current view. Entities on frozen and 
hidden layers are not affected, unless they are part of groups that include visible entities.

Type
Opens the Select Entity Type dialog box listing the entity types. Use the cursor and left button to 
select the kind of entity you want to edit.    If entities of the type you select are part of a group, 
EasyCAD selects the entire group.

Color
The prompt reads "Entities with color:". Select a different color from the color bar, or type a color 
number. If entities in the color you select are part of a group, EasyCAD selects the entire group. 
You can also use the LIKE modifier to pick entities whose color is the same as a selected entity.

Style
The prompt reads "Entities with style name [Dialog]:" Type the name of the style, or press the right 
button, then use the cursor and left button to select the style of the entities you want to select. You 
can also use the LIKE modifier to pick entities whose style is the same as a selected entity. 
Dimension styles are picked when you select a dimension.

Prior
Select the entities used by the last successfully completed drawing, editing, or copying command 
so you can perform a series of operations on a collection of entities.    Copy commands do not 
include the original entity in this selection.

Related Topics
Selecting entities



Combine selections dialog box
And
Restricts the selection.    When you choose AND, EasyCAD displays the entity selection dialog box 
again.    Now you can add another set of selection criteria, telling EasyCAD to perform the editing 
operation only on entities that pass both the first test and the second test.    For example, you could 
select LAYER "Standard", then AND, then by LINE to edit only Lines on the Standard Layer.

Or
Adds to the selection.    When you choose OR, EasyCAD displays the entity selection dialog box 
again.    Now you can add another set of selection criteria, telling EasyCAD to perform the editing 
operation on entities that pass either the first test or the second test.    For example, you could 
select by WINDOW, then OR, then by WINDOW again to edit entities in either of two selection 
rectangles.

Not
Restricts the selection.    When you choose NOT, EasyCAD displays the entity selection dialog box 
again.    Now you can perform the editing operation on all entities that pass the second test.    For 
example, you could select by ALL, then NOT, then WINDOW to edit all entities outside of a window.

Do It
Tells EasyCAD that you are satisfied with the selection and wish to continue with the editing 
operation.

Cancel
Cancels the selection process and the editing operation.

Related Topics
Selecting entities
 



Useful Concepts
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Drawing concepts
Think of an EasyCAD drawing as a virtually unlimited sheet of graph paper on which you make a 
life-size drawing of something in the real world, a building, perhaps; or an office plan, circuit board, 
or piece of mechanical equipment. EasyCAD's drawing window is like a camera lens focused and 
centered on part of that unlimited paper.

Through the lens of the drawing window you can zoom ou  t   to see your entire drawing (reduced to fit
the screen), or zoom in for a magnified view of a detail. Later, when you use a printer to get a paper
copy of your work, you can plot it to fit the paper or to any scale. Once you have some experience 
using visual methods to draw and edit, you may wish to get more precise control of locations that 
you pick. You can combine several tools for complete control over your drawing environment.

Related topics
Modifiers 



Understanding entities
Entities are the individual geometric items (lines, circles, etc.) from which you build your drawing. 
EasyCAD stores mathematical information about the entities you draw. For example, EasyCAD 
knows the position of a Line by where it starts and ends, its length, and its angle. You can choose 
from the following types of entities:

· Points

· Lines (5 different ways to draw lines)

· Circles (7 different ways to draw circles)

· Arcs (6different ways to draw arcs)

· Ellipses (4 different ways including elliptical arcs)

· TrueType® text and ASCII file text

· Paths (including Wide Paths)

· Polygons (including Wide Polygons)

· Splines (Bezier, Cubic and Parabolic)

· Smooth Polygons (Cubic and Parabolic)

· Dimensions (6 different methods)

· Arrows and Double Arrows

· Fillets and Chamfers

· Multipolys



Understanding units
EasyCAD measures coordinates and distances with a user-definable system called Units.    Feet, 
inches, and meters are common examples of units, but you can create your own, like miles, 
microns, or parsecs.

Think of your drawing as a life-size model. For example, if you design a bridge, you might tell 
EasyCAD that each unit is equal to one foot before starting your drawing. For a city plan you might 
set each unit equal to a city block. Each time you plot the drawing, EasyCAD reproduces your 
design at whatever scale you choose for that plot.

When you start a new drawing, one unit is equal to one inch. You can set a different value with the 
UNITS command in the SPECS menu.



Changing default values
A default or prior value in brackets, like this: "radius [1.50000]:", is a suggested response. When 
you start a new drawing, EasyCAD suggests a standard or "normal" response--like 0.2 units for text
height--for each command that uses a default value. After you use each command, most default 
values change to the prior value you used. For example, each time you draw a circle, the default 
center is the center of the last circle you drew, making it easy to create concentric circles.

To accept the default or prior value press the right mouse button, the SPACEBAR, or the ENTER 
key.



Entering coordinates
Your drawing is like an unlimited piece of graph paper.    EasyCAD locates a specific location, or 
coordinate, measuring the horizontal and vertical distances to the desired spot. Each coordinate in 
your drawing has its own unique address, composed of x (horizontal) and y (vertical) numbers. The 
address is written with a comma between the two numbers, like this: x,y. Mathematicians call this 
the "Cartesian" coordinate system, after René Descartes who developed it in the 17th century.

When a new drawing is created, coordinate (0,0) is below and to the left of your screen. Coordinate 
(1,1) is one unit up and to the right of this point, while coordinate (-1,-1) is below and to the left of 
the (0,0) point. As you add to your drawing, it can extend in all directions from (0,0).

Methods for specifying coordinates
Select the point with the mouse
· Use the left button to choose commands, locations, and values.

· Use the right button to accept the default or prior value (standard or current value), or to cancel 
or complete a command when no default or prior value is present. (on three-button mice the 
middle button is ignored).

Type numeric coordinates
· Type exact coordinates at the keyboard, using absolute, relative, polar or relative polar 

coordinates.

· To enter numeric coordinates, type a pair of numbers separated by a comma, with no spaces 
between the characters, like this: 5,6 or this: -7.5,0.

Use Modifiers
· Select an item from the MOD menu, then use the cursor and left button to select an existing 

entity. EasyCAD locks the cursor to a specific point (center, endpoint, and so on) on the existing 
entity.

Related topics
Numeric coordinates
Absolute coordinates
Polar coordinates
Relative coordinates
Modifiers



Entering displacement values
EasyCAD often asks you to indicate movement through displacement. Commands like MOVE and 
STRETCH ask for "from:" and "to:" points. Enter displacement in one of two ways:

Use the cursor and left button to select two points anywhere in your drawing or type numeric 
coordinates. The points don't have to be on the entities being moved. EasyCAD simply 
calculates the distance and direction between the two points and moves the entities 
accordingly.

Press the right mouse button. EasyCAD's prompt reads "displacement:". Type a single pair of 
x,y coordinates. EasyCAD moves the entities the indicated distance from the (0,0) point. For 
example, to move 3 units to the right, type 3,0 and press ENTER when you see the 
"displacement:" prompt.



Entering distance values
When you enter a measurement of distance (for example, as part of a coordinate pair, radius, or 
text height), measurements may be typed in EasyCAD units, or decimal fractions of EasyCAD units.

· Type the measurement in conventional fractions of units, using a plus-sign (+) to separate 
whole numbers from fractional parts. Do not include spaces in the value or coordinate pair. 
Spaces will be displayed in dialog boxes, as well as in LIST and    with DIMENSIONS, instead of 
(+).

· Type the measurement in feet-and-inches. Use an apostrophe (') for feet, and a quote (") for 
inches. Do not include spaces in the value or coordinate pair.    EasyCAD automatically converts 
from feet and inches to whatever unit system you have defined. For example, if drawing units 
are defined as FEET and you type coordinates (24",18") EasyCAD converts this (internally) to 
(2,1.5).

Examples of entering distance values at the Command Line

Absolute
coordinates

Text
height

Radius of a
circle

Entered in decimal fractions
3.5,2 .75 3.375

Entered in conventional fractions
3+1/2,2 3/8 5+3/4

Entered in feet and inches
3'6",24" 3+7/16 3'4+1/2"

· Select distance visually.    For example, instead of typing a value for text height, use the cursor
and left button to select a point anywhere on the screen. Now the prompt reads "distance to:". 
Use the cursor to select another point at the desired distance from the first point. EasyCAD 
measures the distance between the two points and uses that value, just as if you typed it.



Working with angles
In EasyCAD, angles range from 0° (zero degrees) to 360°, measured counterclockwise from 0° at 
"3 o'clock:"

You can use decimal fractions or fractions of units (34.567 or 12+3/4) to specify angles precisely. 
Angles can be negative, in which case they are measured clockwise. (In other words, -45° is the 
same as 315°.)

EasyCAD uses this system of angles (also called bearing angles) for the ROTATE command, for 
inserting Text, Parts, and the Clipboard at an angle, for polar     coordinates  , and for the ANGLE TO 
and BEARING modifiers. Use the BEARING command (in the CALC menu) to find the angle of an 
imaginary line between two points.



Precision Drawing Tools

Close this window

Grid
Snap locking
Cursor snap
Ortho lock
Modifiers
Numeric coordinates
Absolute coordinates
Relative coordinates
Polar coordinates
Tracking/Status line



Grid, snaps, ortho locking, modifiers

Grid
EasyCAD can display a regular pattern of grid dots to help you keep track of distances and sizes.    
You can set horizontal and vertical grid spacing independently. The dots are only a visual aid and 
are not part of your final drawing. Toggle the display of the grid with the Grid button on the 
command line.

Snap locking
Snap locking makes points that you select on screen jump to coordinates at a spacing that you 
choose. Toggle with the Snap button on the command line.    The default setting is off.

Cursor snap
Cursor snap locks the cursor to snap points.    When snap locking is on, cursor snap makes cursors 
"jump" to snap points instead of moving smoothly over the screen.      Toggle with the CsrSnap 
button on the command line.    The default setting is off.

Orthogonal locking
Ortho locking temporarily forces new lines to be horizontal or vertical.    Rubber-band cursors also 
lock to horizontals and verticals when orthogonal locking is on. Toggle on and off with the Ortho 
button on the command line.

Modifiers
Modifiers are used within commands to refer to existing entities. Modifiers allow you to select the 
mathematically exact endpoint of a line, center of a circle, etc. Modifiers help you connect new 
entities to existing ones and edit with precision.    The LIKE modifier is unique in that it retrieves the 
color, layer, and style of other entities, then allows the selection of similar entities.

Related topics
Working with snap locking
The MODifiers menu 



Working with snap locking
When snap locking is turned on, EasyCAD rounds coordinates that you select visually (with the 
cursor and left button) to the nearest snap point. This powerful tool lets you make precision 
drawings with entities mathematically aligned, no matter how closely you zoom in on them. Snap 
divisions are related to grid dot spacing meaning you can snap to every grid dot, to points on and 
halfway between grid dots, and so on.

EasyCAD ignores snap locking when selecting entities for editing, and when specifying points with 
numeric coordinates or modifiers. If ORTHO lock is on, points you select line up vertically or 
horizontally with the nearest snap points.

EasyCAD uses the same snap spacing for all drawing views. If you zoom a window so far out that 
there are more snap points than pixels, you won't get the precision you expect. If you zoom in far 
enough that all snap points are outside the window, you won't be able to select points with the 
cursor. Snap may need to be changed as you zoom in and out.

Choosing the best snap spacing for your work takes experience. For best results, don't turn snap on
unless you display the grid, and keep snap spacing close to grid spacing (6 snap points or fewer 
per grid unit).

To turn snap locking on or off
· Click the Snap button on the command line or,

· Type SNAPON or SNAPOFF at the command line or,

· Choose SELECT GRID (Specs menu) and toggle the Snap on checkbox.

To change the snap division value
· Choose SELECT GRID (Specs menu), click the EDIT button, then type a new number in the 

Snap divisions edit box; or;

· Type SNAPV at the command line.



Numeric coordinates
Four kinds of numeric coordinates give you precise control over where an action takes place in your
drawing. EasyCAD measures absolute coordinates in units from the (0,0) point in your drawing, 
while the other three kinds are measured from the reference point. Select REF PT from the MOD 
(Modifiers) menu to change the current reference point to some other point--for example, the center
or endpoint of an existing entity. Because REF PT is a command modifier, you can use it only in the
middle of another command.

To help you understand numeric coordinates, EasyCAD can display the current cursor position 
below the "Command:" prompt in terms of absolute, relative, or polar coordinates. Click on theTools
icon to gain access to the Tracking/Status Line.



Absolute coordinates
These are Cartesian coordinates, counted in EasyCAD units from (0,0).

To enter absolute coordinates:
Type a pair of numbers separated by a comma (with no spaces between the characters). For 
example: 4,5.

Use negative numbers to indicate locations to the left and below of 0,0. For example:
-4,-5.



Relative coordinates
These coordinates tell EasyCAD to draw from the reference point (last selected point) to a 
coordinate location a relative x,y distance away.

To enter relative coordinates:
Type the "at" sign (@), followed by the x,y distance to the desired point.    For example, start a line 
at coordinates (5,2). Type @3,5 to end the line at (8,7).    EasyCAD draws the second point three 
units to the right and five units up from the first point. 

Use negative numbers to indicate locations to the left and below of 0,0. For example, 
@-6,3.



Polar coordinates
These coordinates use a bearing angle and distance (rather than a pair of x,y coordinates) to select
a location in your drawing.

To use polar coordinates:
Enter the "less than" sign (<), an angle, a comma, and a distance. For example, <90,2 tells 
EasyCAD to place a point 90° (direction) and two units (distance) from the last selected point.

Here's a real-life example of polar coordinates: When you give driving directions to a friend over the
telephone, you might say: "At the gas station, turn north and travel two miles." In EasyCAD, the 
"gas station" is the reference point (last point you used in drawing or editing), "north" is 90°, and two
miles could be the two units in the polar coordinate <90,2.



Relative polar coordinates
These are like polar coordinates except that you use a tilde (~) instead of the "less than" sign (<), 
and the angle you enter is relative to the angle defined by the last two points you used.

For example, suppose you just drew a line from coordinate (1,1) to coordinate (1,3)-a vertical line 
two units high, with an angle of 90°. If you are still in the LINE command and type ~90,1 the 
resulting line has an angle of 180° (horizontal) and is one unit long.

In a real-life example, you might tell your friend to "turn left and go one mile." If he or she had just 
driven two miles north, turning left (~90) would mean heading west (180°).



The Tracking/Status line
Displays the coordinates of the cursor location during commands and whenever EasyCAD asks you
to select a point. The Tracking/Status line is located below the Command line and is not displayed 
when you start a new drawing.    You can display the Tracking/Status line anytime, even in the 

middle of other commands, by selecting the     Tools button.

EasyCAD displays coordinates in the format you select.    Use the UNITS command (Specs menu) to 
select a different distance display format.    EasyCAD rounds the display to the number of decimal places 
selected in the Distance display format section of the Units dialog box.
Please note: The number of decimal places selected for the distance display format affects dialog boxes 
and the LIST command, as well as tracking.    The actual coordinates you select with the cursor are 
rounded to the nearest snap point if snap locking is on.    Tracking, if on, normally displays absolute x,y 
coordinates.    You can select relative or polar coordinates as described below.

Tracking/Status line switches
Absolute
turns tracking on and tells EasyCAD to display cursor movement in absolute coordinates, as x and 
y distances from (0,0).

Relative
turns tracking on and tells EasyCAD to display cursor movement in relative coordinates, as x and y 
distances from the reference point.

Polar
turns tracking on and tells EasyCAD to display cursor movement in polar coordinates, as an angle 
and distance from the reference point.
 



The File Menu
The FILE menu includes general commands for managing drawings and other files. You can use 
the auto repeat feature with the File menu commands.

File commands
New Print Restore Update
Open Print Setup Rename Menu
Save DXF Open Discard Script
SaveAs DXF Save Delete Exit

New command (File menu)
The NEW command opens a new, blank drawing named work.ecw, resetting all prior values (like 
text and dimension specifications) to EasyCAD's original values.    If changes have been made, 
EasyCAD asks (with a dialog box) if you want to save the current drawing before opening the new 
one.

Select RENAME to give the new "work" drawing a permanent name before saving it.

Please note: UNDO won't work after you select NEW, you must use RESTORE (Edit menu) to 
restore your drawing to the last version saved.

Text equivalent: NEW



Open command (File menu)
The OPEN command loads a previously saved drawing. EasyCAD displays the Open Draw dialog 
box listing existing drawings. Select an existing drawing name with the cursor or type a new name.

Open Drawing dialog box options
File Name
Select or type the name of the file you want to open. Listed in this box are the files with the 
extension selected in the List Files of Type box.

List Files of Type
Select the type of file you want to see in the File Name box. 

EasyCAD Drawing lists all files in the current directory with the extension ECW.

EasyCAD 2.33+ Drawing lists all files in the current directory with the extension FCD and at 
least as current as Version 2.33.

AutoCAD (DXF) lists all files in the current directory with the extension DXF (drawing exchange 
format).

Directories
Select the directory where the file is located.

Drives
Select the drive where the file is located.

Text equivalent: OPEN    or    LOAD

Macro equivalent: LOADM



Save command (File menu)
The SAVE command saves your current drawing on disk. Use SAVE frequently to protect your work
from power failure or computer malfunction. SAVE is also the ultimate protection from undesirable 
changes that you might make.

Text equivalent: SAVE



Save As command (File menu)
The SAVE AS command saves a copy of your drawing in a different file, then LOADs the newly-
named drawing file. EasyCAD displays the Save Drawing as dialog box listing existing drawings. 
Select an existing drawing name with the cursor, or type a new name before clicking OK.

If you select an existing drawing, EasyCAD double-checks (with a dialog box) before replacing it.

Use SAVE AS to preserve progressive versions of a drawing as separate files on disk. For example,
if you start EasyCAD with a drawing named plan1, you could use SAVE AS to make a copy with the
name plan2 and then work on it.

Save Drawing As dialog box options
File Name
Select or type the name of the file you want to open. Listed in this box are the files with the 
extension selected in the List Files of Type box.

List Files of Type
Select the type of file you want to see in the File Name box. 

EasyCAD Drawing lists all files in the current directory with the extension ECW.

Window Meta File lists all files in the current directory with the extension WMF.

AutoCAD (DXF) lists all files in the current directory with the extension DXF (drawing exchange 
format).

Directories
Select the directory where the file is located.

Drives
Select the drive where the file is located.

Text equivalent: SAVEAS

Macro equivalent: SAVEASM



Print command (File menu)

The PRINT command displays the Print dialog box enabling you to control how your drawing is 
printed. After you confirm your options and click OK, EasyCAD sends your print file to Windows 
Print Manager (if enabled), and you will be able to continue your    work before the print is finished.

Print dialog box options
Printer
Displays the name of the default printer and the printer connections.    To select a different printer, 
click the Setup button.    To install a different printer, see your Windows documentation.

View to print (select one)
Named view prints the view selected from the drop-down list, showing all the views named with 

SAVE VIEW (View menu).

Entire drawing prints the entire drawing.    This includes space occupied by entities on hidden 
layers. (It's the same view you would see if you selected the ZOOM EXTENTS command or 

icon .)    Hidden entities will not show in the printed drawing, but they do affect the print 
size and placement.

Current view prints the current view in the drawing window.

Print Scaling (select one)
Fit to page scales the selected view for a best fit on your paper. Remember to set the proper 

paper orientation by clicking the Setup button to access the Print Setup dialog box.

Scale factor uses the relationship between paper distance and drawing distance to print a 
scaled version of the selected view, centered on the center of the view. For example, to print at
"1/8th scale", many ways to describe it exists:

· Paper distance = 1/8"      and Drawing distance = 1'    

· Paper distance = 1/8          and Drawing distance = 12

· Paper distance =        1         and Drawing distance = 96

Print Quality
From the drop-down list, select the resolution at which you want your drawing printed.    Options 
available depend on the printer driver installed (see your Windows and printer documentation.) To 
select a different printer, click the Setup button.

Copies
Click on and type the number of copies you want to print.

Print to file
Checking this box prints the drawing to a new file on the current drive and directory instead of 
sending it to the system printer.    You may then print the drawing on a computer that does not have 
EasyCAD for Windows.    Type a new name in the edit box of the Print To File dialog box. A three 
letter extension is not required, but the filename is limited to eight characters.

Swap black and white
For printers that require it, checking this box allows color #0 (black) to print as white, and color #15 
(white) to print as black.

Preview
Click the Preview button to see an accurate representation of your drawing as it will appear on your 
paper.    EasyCAD interrogates the Windows Printer Driver for information on the capabilities of the 



printer.    All printers (and/or printer drivers) do not have the same ability to reproduce colors, fill 
patterns, and/or True Type fonts.

Setup
Setup enables you to configure a printer before printing an EasyCAD drawing.    One often used 
parameter is Portrait/Landscape Orientation.    EasyCAD uses the Windows System default setting 
for each new drawing printed for the first time.    Once you change the orientation to Landscape, 
EasyCAD will use that orientation with that drawing.

Text equivalent: PRINT
Related Topics
PRINT SETUP 



Print Setup command (File menu)
The PRINT SETUP command enables you to configure a printer before printing an EasyCAD 
drawing.    This command is similar to the Window's Control Panel Printers Option.    Before you 
print a drawing, you must be sure the proper driver for your printer is installed.    See your Windows 
documentation for information about installing printer drivers and setting up your printer. 
Parameters such as Paper Size, Portrait or Landscape Orientation, Print Resolution, and others 
(depending on your printer) are specified here.

Text equivalent: PRINTSU
Related Topics
Print



DXF Open command (File menu)

DXF OPEN converts drawings from AutoCAD®    Drawing Exchange Format (DXF) to EasyCAD's 
ECW drawing format. This function is found in an eXternal Procedure (XP) named DXFIN.XP. Its 
availability is listed in the Installed Modules dialog box (Configure XPs).

DXF (Open Drawing) dialog box options
File Name
Listed in this box are the files with the extension DXF.    Type or select a file name.

List File of Type
Only AutoCAD®    Drawing Exchange Format (DXF) files are listed in the current directory.

Directories
Select the directory where the file is located.

Drives
Select the drive where the file is located.

Text equivalent: DXFIN

Related topics
DXF SAVE



DXF Save command (File menu)

DXF SAVE creates an AutoCAD®    Drawing Exchange Format (DXF) file, suitable for importation 
into Autocad. This function is found in an eXternal Procedure (XP) named DXFOUT.XP. Its 
availability is listed in the Installed Modules dialog box (Configure XPs).

DXF (Save Drawing As) dialog box options
File Name
Listed in this box are the files with the extension DXF.    Type or select an existing or new file name.

List File of Type
Lists only AutoCAD    Drawing Exchange Format (DXF) files in the current directory.

Directories
Select the directory where the file is located.

Drives
Select the drive where the file is located.

Text equivalent: DXFOUT

Related Topics
DXF OPEN



Restore command (File menu)
The RESTORE command restores your drawing to the last version saved.

Use RESTORE if you inadvertently select NEW or DISCARD while in the middle of the current 
drawing.    EasyCAD asks (with a dialog box) if you want to discard changes to the current drawing 
before restoring.    If you want to keep the changes, select the CANCEL button and use SAVE AS 
(File menu) to save the drawing with a new name.

Please note: UNDO won't work after you select RESTORE.

Text equivalent: RESTORE
Related Topics
NEW 
DISCARD 
SAVE AS 



Rename command (File menu)
The RENAME command changes the name of the current drawing.    EasyCAD displays the 
Rename Drawing listing existing drawings. Select a drawing name with the cursor or type a new 
name.    Please note: RENAME does not save the drawing on disk with its new name, you still 
need to select SAVE or END.

Rename Drawing dialog box options
File Name
Select or type the name of the file you want to open. Listed in this box are the files with the 
extension selected in the List Files of Type box.

List File of Type
Only EasyCAD    ECW files in the current directory are listed.

Directories
Select the directory where the file is located.

Drives
Select the drive where the file is located.

Text equivalent: RENAME

Macro equivalent: RENAMEM



Discard command (File menu)
The DISCARD command clears all entities from the active drawing.    Until you next SAVE the 
drawing, RESTORE can be used to recover the previous drawing.

Text equivalent: DISCARD



Delete command (File menu)
The DELETE command deletes the drawing of your choice from the disk.    EasyCAD displays a 
dialog box listing existing drawings. You can select a drawing name with the cursor or type a new 
name.

Delete Drawing dialog box options
File Name
Select or type the name of the file you want to open. Listed in this box are the files with the 
extension selected in the List Files of Type box.

List Files of Type
Select the type of file you want to see in the File Name box. 

EasyCAD Drawing lists all files in the current directory with the extension ECW.

EasyCAD 2.33+ Drawing lists all files in the current directory with the extension FCD and at 
least as current as Version 2.33.

AutoCAD (DXF) lists all files in the current directory with the extension DXF (drawing exchange 
format).

Directories
Select the directory where the file is located.

Drives
Select the drive where the file is located.

Text equivalent: DELETE



Update command (File menu)
Earlier versions of ECW and FCD files (and current versions of DXF files) need to be updated to the
current version of the ECW file.    UPDATE may have to convert some old entities into new entities.   
For example, a wide line is converted into an unfilled multipoly.

This function is found in an EXternal Procedure (XP) named UPDATE.XP. Its availability is listed in 
the Installed Modules dialog box (Configure XPs).

Update/Save Multiple Drawings dialog box options
File Name
Select or type the name of the file(s) you want to update. Listed in this box are the files with the 
extension selected in the List Files of Type box.

List Files of Type
Select the type of file you want to see in the File Name box. 

EasyCAD Drawing lists all files in the current directory with the extension ECW.

EasyCAD 2.33+ Drawing lists all files in the current directory with the extension FCD and at 
least as current as Version 2.33. 

AutoCAD (DXF) lists all files in the current directory with the extension DXF (drawing exchange 
format).

UPDATE will load and display the file after the conversion process is completed. Press the SHIFT 
key while pressing the Left mouse button to select several files at once. In this case, the last file 
updated will be displayed.

Directories
Select the directory where the file is located.

Drives
Select the drive where the file is located.

Text equivalent: UPDATE



Menu command (File menu)
The MENU command loads a custom menu file. EasyCAD's standard menu file is called ecad.mnu.
Customize a menu file with a plain-text editor like NOTEPAD, or a word processor that saves ASCII 
text, non-document, DOS, or unformatted files.    You can change the number, order, title, and 
contents of any menu item.    You can also build alternate menus, scripts, and macros for complex 
or repetitive tasks, loading them instantly.

Select Menu dialog box options
File Name
Select or type the name of the file you want to open. Listed in this box are the files with the 
extension selected in the List Files of Type box. EasyCAD loads the menu file. Menu files end in
.mnu.  You can call a macro with a menu item.    When you load a drawing, EasyCAD looks in the 
installed directory for a menu file that matches the drawing name. For example, if you load 
solar.fcd, EasyCAD loads solar.mnu if such a file exists. If EasyCAD can not find a custom menu 
file for the drawing, it loads ecad.mnu.

List File of Type
Only    EasyCAD MNU files in the current directory are listed.

Directories
Select the directory where the file is located.

Drives
Select the drive where the file is located.

Text equivalent: MENU

Macro equivalent: MENUM

Related Topics
Custom menu suggestions



Custom menu suggestions (File menu)
If, for example, you use many circles and arcs in your work, you could build a custom menu file with
a menu item for each of the seven circle and six arc commands to bypass the CIRCLE and ARC 
sidebar menus. Another custom menu could call the CHANGE commands directly, bypassing the 
CHANGE sidebar. If you wish, you can add these menu items to the standard menu file, or to a 
customized menu with a different name.

To define a toolbar icon, use: #n,filename.bmp:command;
where n is the icon position, and filename.bmp is a 16x16 .BMPor .DIB bitmap file. For example:

 #20,mybitmap.bmp:VIEW; 
You can define up to 48 icons -- if they don't fit in the window, they won't show, but no harm will be 
done.

To define an accelerator key equivalent for a command, use the TAB key as the unique delimiter. 
Accelerator keys do not    work    while a menu is pulled down. A few examples:

Save[TAB]^S:SAVE; displays Save        Ctrl+S

Line[TAB]^F12:LINE; displays Line            Ctrl+F12

Point[TAB]CF9:POINT; displays Point        Ctrl+F9

Box[TAB]SF11:BOX; displays Box            Shift+F11

Path[TAB}SCF8:PATH; displays Path          Shift+Ctrl+F8

You can not use the F1, F10, or ALT keys in any combination. Note that both the caret (^) and the 
letter "C" can be used to represent the CTRL key, and the letter "S" represents the SHIFT key. If 
duplicate definitions exist in a menu file, the definition closest to the end of the file will be used.

To create a sidebar menu (sometimes called "submenus" or "daughter menus"), use the greater 
than (>) sign, then precede each item in the sidebar menu with at least one space. For example:

Lines>:
    Line:LINE;
    Double Line:DBLN;

In menu items (as well as macros and scripts), the sequence:            ^Dprompt        displays the 
prompt    text (ended with a Carriage Return only!) and waits for live input.

^D keeps the appropriate cursor and allows an entire pick cycle (MOVE ^D 0,0 1,1).

^D can be interrupted by a modifier or zoom command from the menu/icon bar, but only if the
menu file has a ^D following each command line input item. Look at the modifiers and icons 
in ecad.mnu.

^D forces live input for an entire getdata, which may be more than one point. For example, 
you now say BOX ^D  not  BOX ^D ^D. The exception to this rule is found with the modifier 
INTERSECTION OF. Two ^D's are needed because two different entities are requested.

Right now, any ^D that doesn't have a prompt spelled out "inherits" the prompt from the last 
^D that had one, even if that one is in a completely different macro!

Because loading a menu replaces the existing menu table in memory, EasyCAD ignores everything in
a menu item after MENUM <filename>. 

Related Topics
Menu Command



Script command (File menu)
The SCRIPT command loads and runs a script file (a series of EasyCAD commands    saved in a 
plain ASCII text file). EasyCAD displays a dialog box listing available script files (those with the type
extension .scr).    Select a script with the cursor or type a script file name.

Use a script to automate repetitive tasks.    Scripts can include ordinary EasyCAD commands (text 
equivalents of the ones in the standard menu) or special programming commands.

Type the name of a script file, or select a file with the mouse. EasyCAD reads and executes the text
in the script file just as if you had typed it all at the keyboard. Do not include blank lines in a script 
file. Type a carriage return at the end of each line in the script file. Unlike EasyCAD for DOS, the 
carriage return that ends each line of a script file is "counted" as a delimiter.

You can use a script file to execute a series of EasyCAD commands, but not to define macros. 
Unlike LOADMAC, running a script doesnt clear existing macros, although it does redefine any 
macros, variables or labels with the same names.

When you load a drawing, EasyCAD looks for a script file that matches the name of the drawing. 
For example, if you load threads.fcd, EasyCAD loads threads.scr if such a file exists.

Windows works hard to prevent unneeded redraws. This means if you use a script to load and view 
several drawings, you need to use the PAUSE command between each load.

Select Script File dialog box options
File Name
Select or type the name of the file you want to open. Listed in this box are the files with the 
extension selected in the List Files of Type box.

List File of Type
Only EasyCAD .SCR files in the current directory are listed.

Directories
Select the directory where the file is located.

Drives
Select the drive where the file is located.

Text equivalent: SCRIPT
Macro equivalent: SCRIPTM



Exit command (File menu)

The EXIT command closes EasyCAD and returns you to the Windows Program Manager.

If you have made any changes since the last time you SAVEd your drawing, EasyCAD displays a 
dialog box: "Save changes to FILENAME.ECW?" If you do want to quit without saving, select NO or
type N.    Select CANCEL to return to EasyCAD.

Text equivalent: EXIT    or    QUIT    or    END



 



The Clip menu

EasyCADs CLIP commands provide the same facilities as other Windows applications for working 
with the clipboard. COPY, CUT, and PASTE first ask for entities to be operated upon, and then the 
command is carried out. 

Clip commands
Copy
Cut
Paste
Options 



Copy command (Clip menu)

COPY places entities on the clipboard. EasyCAD makes three versions of data files available on 
the clipboard:

· EasyCAD format

· Windows Metafile format (WMF)

· Windows Bit-Mapped format (BMP)

COPY works within EasyCAD, after quitting and restarting EasyCAD, or between two separate 
copies of EasyCAD.

Text equivalent: CLIPCOPY

Related topics
Cut
Paste
Options 



Cut command (Clip menu)

CUT places entities on the clipboard and then removes them from the drawing, just like ERASE 
(Edit menu).    EasyCAD makes three versions of data files available on the clipboard:

· EasyCAD format

· Windows Metafile format (WMF)

· Windows Bit-Mapped format (BMP)

CUT works within EasyCAD, after quitting and restarting EasyCAD, or between two separate copies
of EasyCAD.

Text equivalent: CLIPCUT

Related topics
Copy
Paste
Options 



Paste command (Clip menu)

PASTE inserts entities (in EasyCAD format) from the clipboard into the current drawing.

PASTE works within EasyCAD, after quitting and restarting EasyCAD, or between two separate 
copies of EasyCAD.

NOTE: If text is copied from a word processor (or other Windows applications) to the clipboard, 
PASTE will insert it as a text entity using the current Text Specifications.

Text equivalent: PASTE

Related topics
Copy
Cut
Options 



Options command (Clip menu)

OPTIONS displays the Clipboard Specifications dialog box allowing you to specify the size of a 
bitmap (BMP), or the largest dimension of a Metafile (WMF).

Bitmap Size:
Horizontal Pixels
EasyCAD offers a default value of 320 pixels in the X-direction. A value of 1 to 999 may be 
specified.

Vertical Pixels
EasyCAD offers a default value of 320 pixels in the Y-direction. A value of 1 to 999 may be 
specified.

Metafile Size:
Largest Dimension
EasyCAD offers a default value of 5.000 Inches for its largest dimension. If you want a tall, thin 
entity or drawing to be captured, but later displayed in a landscape orientation, draw a larger BOX 
(Draw menu) around the entity or drawing. The box should be colored white and filled with a solid 
fill pattern.

Inches / Cm
Selects the units of measurement for the Metafile, only.

Text equivalent: CLIPOPT

Related topics
Copy
Cut
Paste
 



The View Menu

Commands in the View menu affect what you see in the drawing window. The auto-repeat feature 
may be used with the View menu commands.

Zoom commands determine the relationship between the drawing and the drawing window.    
You view all or part of your drawing by looking through the drawing window.

Layer commands control the status of the currently active layer and any other layers that may 
be hidden or frozen.

Views can be named, saved, and selected    for rapid recall and navigation in large drawings.

View commands
Redraw Save View
Background Select View
Origin
Zoom Layers

Pan Set Current
Window Hide, Hide All
Center Show, Show All
In, Out Freeze, Freeze All
Width Thaw, Thaw All
Height
Extents
Last

Redraw command (View menu)

REDRAW recalculates your drawing from the database, then redraws the screen. You can use the 
ESC key to cancel a lengthy redraw.

When you use editing commands, EasyCAD erases affected entities by drawing over them in the 
background color before drawing the changed versions of the entities. This can leave apparent 
holes in other entities and in the grid. REDRAW cleans these holes up.

Text equivalent: REDRAW



Background command (View menu)

BACKGROUND changes the background color of EasyCAD's drawing window and affects screen 
display only--EasyCAD leaves the background blank when you plot.    The default background color 
for new drawings is black (#0).

The prompt reads "Background color #:". Type a color number or select a color from the color bar.    
Press the right button or ENTER to keep the current background color.    EasyCAD redraws the 
screen in the new color.

Please note:    Color #16 is special. It can not be assigned as a color to an entity, but assumes the 
command line background color. It is currently light grey, allowing the dark grey highlight color (#14)
to be visible.

Text equivalent: BKGND



Origin command (View menu)

ORIGIN redefines the location of coordinate (0,0) in the current drawing. Use ORIGIN before saving
a drawing for use as a part. EasyCAD uses the (0,0) point as a handle to align with the insertion 
point when you later add the part to another drawing with INSERT PART, PART ARRAY, or CIRC 
PART ARRAY commands in the INSERT menu.

When you select ORIGIN, EasyCAD displays a crosshairs cursor and the prompt reads "New origin
point:". Select a point with the crosshairs and left button, or by typing coordinates. (The center or 
lower-left corner of the part is usually a good choice.) EasyCAD moves everything in your drawing 
so that the point you selected is at coordinates (0,0).

The UNDO command doesn't work for ORIGIN.

Text equivalent: ORIGIN



Zoom commands (View menu)

These commands determine the relationship between the drawing and the drawing window.    You 
view all or part of your drawing by looking through the drawing window.

Pan
Zoom Window
Zoom Center
Zoom In/Out
Zoom Width
Zoom Height
Zoom Extents
Zoom Last



Pan command (View menu)

PAN shifts your drawing under the drawing window (like the scroll bars but more precise). The 
prompt reads "Pan from:". Select a point with the crosshairs and left button, or type numeric 
coordinates. Now the prompt reads "to point:" and EasyCAD displays a rubber-band cursor. Select 
a new point. EasyCAD moves your drawing so that the "Pan from:" point appears at the "to point:" 
point in the drawing window.

Text equivalent: PAN



Zoom Window command (View menu)

    Zoom Window Icon/Command
ZOOM WINDOW lets you draw a selection rectangle or "window" to view part of your display in the 
drawing window.

The prompt reads "Window corner:". Use the crosshairs and left button or type coordinates to select
one corner of the view you want. Now the cursor becomes a stretching rectangle and the prompt 
reads "Opposite corner:". Select a second corner for the view. Tip: Use numeric coordinates to 
select off-screen points.    EasyCAD redraws your screen to show the part of your drawing that fits 
within the rectangle you drew.

Text equivalent: ZWIN



Zoom Center command (View menu)

    Zoom Center Icon/Command
ZOOM CENTER moves the center of the drawing window to a new spot in the drawing. This 
command has only one prompt, so it's often more convenient than PAN.

The prompt reads "New view center:". Use the crosshairs and left button or type numeric 
coordinates to select a new view center. (Tip: Use numeric coordinates to shift the view center to an
off-screen point.) EasyCAD moves your drawing under the window to center it on the point you 
selected, without changing the zoom factor.

Text equivalent: ZCEN
Related Topics
Pan



Zoom In, Out commands (View menu)

 Zoom In Icon/Command
ZOOM IN magnifies the view in the drawing window. (Entities in the drawing window appear larger, 
and you see less of your drawing.) EasyCAD's prompt reads "Zoom in by [default]:". Type a number
to indicate how much to magnify the view.

Text equivalent: ZIN

 Zoom Out Icon or Command
ZOOM OUT widens the view in the drawing window. (Entities in the drawing window appear 
smaller, and you see more of your drawing.) The prompt reads "Zoom out by [default]:". Type a 
number to indicate how much to widen the view.

Text equivalent: ZOUT



Zoom Width, Height (View menu)

Zoom Width
ZOOM WIDTH tells EasyCAD how much of your drawing to display in the drawing window.

The prompt reads "view width:". Enter a value in units or in feet-and-inches (you can include 
decimal or conventional fractions). EasyCAD redraws the drawing window, displaying the specified 
number of units across.

When you create a new drawing, EasyCAD uses a default    view width of 10.5 units, centered on 
coordinates (5,5).

Text equivalent: ZWID

Zoom Height
ZOOM HEIGHT tells EasyCAD how much of your drawing to display in the drawing window.

The prompt reads "view height :". Enter a value in units or in feet-and-inches (you can include 
decimal or conventional fractions). EasyCAD redraws the drawing window, displaying the specified 
number of units up and down.

Text equivalent: ZHGT



Zoom Extents command (View menu)

 Zoom Extents Icon/Command
ZOOM EXTENTS displays your entire drawing in the current window, shrinking or enlarging the 
view to fit.    The extents of your drawing are recalculated, reclaiming drawing space from deleted 
entities.

Text equivalent: ZEXT



Zoom Last command (View menu)

    Zoom Last Icon/Command
ZOOM LAST redraws the drawing window with the previous zoom magnification and position, even 
if you have used other commands since the last zoom.

Text equivalent: ZLAST
Related Topics



Save View command (View menu)

SAVE VIEW stores a view of your drawing. You can store many named views with each drawing, 
available whenever you work on it. Any named views contained in a drawing file will be included 
when that file is INSERTed as a PART into another drawing.

When you select SAVE VIEW, the Save View as dialog box appears.    Type in a new view name 
and then press ENTER or select the OK button. EasyCAD stores the view width and center 
coordinates of the current drawing window.

Use SELECT VIEW to recall the views you store with SAVE VIEW. You can also print the saved 
views by name.

Text equivalent: SVIEW
Macro equivalent: SVIEWM

Related topics
SELECT VIEW



Select View command (View menu)

SELECT VIEW displays the Select View dialog box with options for editing or deleting existing 
views.

Select View dialog box options
View Name

Select the view name from the drop-down list.    You can then edit or delete this view.    Two pre-
defined views are always present.    "Startup" is always remembered as the first view seen each
time the drawing is started.    "Last", when selected, displays the most recent view displayed 
before the view you see now, just like the ZOOM LAST command or icon.    These special 
"views" can not be edited or deleted.

New button    Click the to display the Define New View dialog box.    The specifications for the view 
are displayed and may be changed as follows:

Name    Type a new name for the view.

Center    Type new X,Y values, in numeric coordinates, to define a new view center.

Width    Type a new value, if desired, for the view width in EasyCAD units.

Height    Type a new value, if desired, for the view width in EasyCAD units.

Fixed width    Check this box to lock in the width of the view, letting the height adjust 
accordingly.

Fixed height  Check this box to lock in the height of the view, letting the width adjust 
accordingly.

Edit button
Click to display the Edit View dialog box.    The view to be edited is highlighted.    Type a new 
name for the view or change the values for the view specs as described above.

Delete button
Click to delete the selected view.

Help button
Click to display help for the dialog box.

Text equivalent: VIEW
Macro equivalent: VIEWM



Layers (View menu)

Layers are like transparent, overlapping sheets that you can use to organize your drawings.    For 
example, assign one layer of a house blueprint to structural members, another to electrical work, 
and a third to plumbing details. EasyCAD pre-defines two layers: Merge and Standard. The 
Standard layer is the default layer that most drawings get started on. The Merge layer has a special
meaning for parts. When you INSERT a PART, entities on the Merge layer in the part file move to 
the current work layer in the current drawing file. Any named layers contained in a drawing file will 
be included when that file is inserted as a part into another drawing.

Use the Layers icon  or the LAYERS command to access the Layers Management dialog box.

Multiple layers simplify editing of complex drawings. Use LAYERS, SET CURRENT (View 
menu) to select a layer to draw on. Only the current layer accepts new entities.    Select, or 
exclude, or change entities by layer. Protect layers by hiding or freezing them.    Use the 
SHOW and THAW commands (View menu) to show (display) and un-protect layers.

Hide individual layers so they don't show on screen or when you plot your drawing.

Freeze    individual layers to write-protect them. You can see and refer to entities on a frozen 
layer, but you can't erase them or modify them.

Move entities from one layer to another, using CHANGE, LAYER (Edit menu).

Copy entities from one layer to another, using COPY, COPY TO LAYER (Copy menu).

Layer commands
Set Current
Hide/Hide All
Show/Show All
Freeze/Freeze All
Thaw/Thaw All

Set Current command (Layers, View menu)

      Layers icon accesses Layer Management dialog box.
The SET CURRENT command displays the Layer Management dialog box allowing you to select 
the current work layer for new entities or select layers to HIDE, or FREEZE. Use COPY TO LAYER 
in the Copy menu to duplicate existing entities from layer to layer.

Layer Management dialog box options
Layer Status

Select a layer from the drop-down list to set as the current layer for entering new entities.    The 
current layer is indicated with an arrow (>).

Hide
Toggle this check box to hide or show the highlighted layer.    You could have also typed the 
commands HIDE or SHOW at the "Command:" prompt. Type HIDEA or SHOWA to hide or 
show all layers at once.    The    current layer cannot be hidden.

Freeze
Toggle this check box to freeze or thaw the highlighted layer.    You could have also typed the 



commands FREEZE or THAW at the "Command:" prompt.    Type FREEZEA or THAWA to 
freeze or thaw all layers at once. The current layer can not be frozen.

Set Current
Click to set the highlighted layer as the current layer for adding new entities .

New layer
Click to display the Layer Name dialog box.    Type a name (up to 31 characters) for the new 
layer then click OK.    Layer names can contain spaces.    You can define a new layer with a 
name even in the middle of the CHANGE LAYER    or    COPY TO LAYER commands.

Rename layer
Click to display the Layer name dialog box.    The layer to be renamed is highlighted.    Type a 
new name for the layer. The "Merge and Standard" layers can not be renamed.

Delete layer
Click to delete the selected layer name.    The "Standard" and "Merge" layers can not be 
deleted. If you delete a layer that has entities on it, EasyCAD keeps those entities on a layer 
named "Undefined", along with an internally-generated "ID number".    Entities can be easily 
recovered. Pick an Editing command, use SELECT BY, LAYER, type the # sign and a number.   
All entities with that Undefined    #number    will be selected for further editing.

Help
Click to display help for this dialog box.

You can type layer names containing spaces on the command line when using the SETLAYER 
command).    Layrer names exported to DXF have the _ character substituted for the space 
character.

Text equivalent: SETLAYER

Macro equivalent: NEWLAYER (creates a layer by name)

Macro equivalent: RENLAYER (renames a layer, except Merge & Standard)



Hide commands (Layers, View menu)

Hide
HIDE commands hides layers. Entities on hidden layers aren't affected by edit and copy operations.
Hidden layers aren't included in printed output..

After typing the command HIDE the prompt reads "Layer name [Dialog]:" type the layer name or 
press ENTER to see the Layer management dialog box.

Text equivalent: HIDE

Hide All
HIDE ALL hides all but the current layer. Use this command if you need to hide all but the current 
layer at once.    You may find it more convenient than using the Layer Management dialog box.

Text equivalent: HIDEA



Show commands (Layers, View menu)

SHOW commands display hidden layers.

Show
SHOW displays a hidden layer. After typing the SHOW at the "Command:" the prompt, reads "Layer
name [Dialog]:" type the layer name or press ENTER to see the Layer management dialog box.

Text equivalent: SHOW

Show All
SHOW ALL displays all hidden layers. You may find it more convenient than using the Layer 
Management dialog box.

Text equivalent: SHOWA



Freeze commands (Layers, View menu)

Freezing a layer is the same as "write-protecting" that layer.    You can see entities on frozen layers 
and refer to them with modifiers, but you can't select them for edit or copy operations.

Freeze
FREEZE freezes a layer.    After typing the command FREEZE the prompt reads "Layer name 
[Dialog]:", type the layer name or press ENTER to see the Layer management dialog box.

Text equivalent: FREEZE

Freeze All
FREEZE ALL freezes (write-protects) all but the current layer. Use this command if you need to 
freeze all but the current layer at once.    You may find it more convenient than the Layer 
Management dialog box..

Text equivalent: FREEZEA



Thaw commands (Layers, View menu)

Thaw
THAW un-freezes a layer. After typing THAW the "Command:" prompt reads "Layer name [Dialog]:" 
Type the layer name or press ENTER to see the Layer management dialog box.

Text equivalent: THAW

Thaw All
THAW ALL un-freezes. Use this command if you need to thaw all layers at once.    You may find it 
more convenient than the Layer Management dialog box.

Text equivalent: THAWA

 



The Draw menu
Commands under the DRAW menu add entities to your drawing.

Draw commands
Point Paths and Polys Dimensions
Line Splines/Spolys Fillet
Lines Arrows Chamfer
Circles Double Arrows Multipoly
Arcs Text Draw Symbol
Ellipses File Text 

Related Topics
Entities
Drawing concepts



Point (Draw menu)
POINT draws a single dot (one pixel). Points are usually used as temporary reference markers that 
you hide or remove when your drawing is complete.

1. When you select POINT, the prompt reads "Point at:"    Use the crosshairs and left button or type 
numeric coordinates to select a location for the point.

2. After drawing the point, EasyCAD lets you draw a series of points without re-selecting the 
command. Press the right button to stop drawing points.

Please note: On some high-resolution displays, a single pixel is very small and may be difficult to 
see using certain background color and entity color combinations.

Text equivalent: POINT



Lines (Draw menu)
When you select LINES, a sidebar menu appears with five ways to draw lines. Use the cursor and 
left button to select the method you want

When you see the "Command:" prompt after leaving a LINES command, you can press either 
button or ENTER to draw more lines of the same type, bypassing the sidebar menu. To change to a
different type of line, re-select LINES from the DRAW menu.

Line types:
Line
Double lines
Perpendicular line
Perpendicular at length
Tangent to two entities



Line (Draw menu)
In addition to being found in the sidebar menu, LINE is also listed under the DRAW menu by itself. 
Other types of lines, if frequenty used, can be moved or added to the DRAW menu by modifying 
ecad.mnu    with an ASCII text editor. See the Menu command for more information.

When you select LINE, the prompt reads "1st point:".

1. Select a starting point for the line by using the crosshairs and left button or by typing numeric 
coordinates.

2. Now the prompt reads "Next point:" and the cursor becomes a rubber-band (stretching) line 
anchored at the first point you selected. Use the cursor or type coordinates to select an ending 
point for the line. EasyCAD draws a line entity to replace the cursor, then stays in the LINE 
command so you can draw a series of connected lines. Press the right button to stop drawing 
lines.

Text equivalent: LINE



Double Lines (Lines, Draw menu)
The DOUBLE LINES commands draws double lines separated (or offset) by a specified distance.

To draw double lines select LINES-DOUBLE LINES from the Draw menu.
1. The prompt reads "Separation [1.000]". Press the right mouse button or ENTER to accept the 

default. Type a new value in units, feet and inches, etc., or use the left mouse button to drag the 
cursor , specifying a distance on the screen.

2. Now the prompt reads "Next point [Shift=Change Handle]".    Tip: You can change the line to which
the cursor is anchored by pressing the SHIFT key, moving the mouse nearest    the line you want 
to be the anchor, then releasing the SHIFT key. Select the next point, using the new anchor    as 
the "rubber-band cursor".    Press the right button to complete or end the command. Press the right
button again to begin another double line.

Text equivalent: DBLN



Perpendicular (Lines, Draw menu)
The PERPENDICULAR LINE command draws a line from an entity to a point perpendicular to the 
entity. To draw a perpendicular line select LINE, PERPENDICULAR LINE from the Draw menu.

1. The prompt reads "Entity".    Select the entity you want the line to be perpendicular to.

2. The prompt reads "Prp. point".    Select a point you wish to be the end of the line, then continue 
selecting points that describe other lines drawn perpendicular to the first reference entity, if 
desired.    Press the right button to end the command.

Text equivalent: LNPRP



Perpendicular at length (Lines, Draw menu)
The PERPENDICULAR AT LENGTH command draws a line of a specified length from an entity to a
point perpendicular to the entity. To draw a perpendicular line select LINES-PERPENDICULAR from
the Draw menu.

1. The prompt reads "Length [1.000]":    Select the length of the line to be drawn. Press the right 
button to accept the default or prior length. Type a new length in any units or use the left button to 
visually select two points the desired distance apart.

2. The prompt reads "Entity".    Select the entity from which you want the new line to be perpendicular
from.

3. Select a second point, anywhere along the line you are about to draw, then continue selecting 
points, if desired.    Press the right button to end the command.

Text equivalent: LNPRPL



Tangent to two entities (Lines, Draw menu)
TANGENT draws a line entity that is tangent to other entities.    You can even draw a line tangent to 
two points on the same entity (like a spline).    

Please note: This command is different from the TANGENT TO modifier, which lets you draw a line
segment from any point that is tangent to one other entity.

1. When you select TANGENT, the prompt reads "1st entity:" and "2nd entity:". Use the crosshairs 
and left button to select two circles or arcs. For example, there are four possible tangents between
any two circles or arcs: two on the outside and two that cross in the middle. EasyCAD lets you 
draw all four--just select the circles or arcs on the sides you want to use for the tangent.

2. EasyCAD draws the tangent line.

Related topics
Tangent to modifier 

Text equivalent: TANGENT



Circles commands (Draw menu)
When you select CIRCLES, a sidebar menu appears with six ways to draw circles. Use the cursor 
and left button to select the method you want. Use the auto-repeat feature to repeat a command. 
EasyCAD remembers the center and radius of each circle or arc you draw and offers them as 
default (prior) values the next time you draw a circle during the same work session. This feature lets
you draw concentric circles. Press the right button or ENTER to accept the default or enter a 
different value as explained under the individual circle commands.

· Each circle can be filled solid, or in a selection of crosshatch patterns.

· To select a fill pattern for new circles use ENTITY STYLE (Specs menu).

· To change the pattern of existing circles use CHANGE(STYLE), or EDIT in the Edit menu.

· To change a circle's radius use EDIT, DYNAMIC EDIT, or STRETCH in the Edit menu.

· To turn a circle into an arc use BREAK (Edit menu).

Circle types
Center & Point On 3 Point Circle
Diameter and Center Tangent to 3
Radius and Center Donut
2 Point Circle

Center and Point On (Circles, Draw menu)
Center and point On draws a circle from its center and a point on its circumference. To draw a 
center and point on circle select CIRCLES-CENTER AND POINT ON from the Draw menu.

1. The cursor becomes a crosshairs and the prompt reads "Center [.000,.000]". Press the right button
to accept the default or prior center.    Select a new center with the crosshairs and left button or 
type numeric coordinates.

2. The prompt reads "Point on circle:" and a stretching cursor is displayed.    Select a point on the 
circle, stretching the circle until it's the size you want, then press the left button.    Please note: 
While stretching the cursor, you can hold down the SHIFT key to "pick up" and move the circle. 
Release the SHIFT key to go back to stretching.    EasyCAD draws the circle.

3. Press the right button to continue drawing a series of center and point circles.

Text equivalent (to bypass dialog box): CIRP



Diameter and Center (Circles, Draw menu)
DIAMETER and CENTER draws a circle using a diameter measurement and a center point. To 
draw a diameter and center circle select CIRCLES-DIAMETER AND CENTER from the Draw 
menu.

1. The prompt reads "Diameter []:".    Specify the diameter. Press the right button to accept the default
or prior diameter. Select a new diameter using the left button to visually pick two points the desired
distance apart.    You may also type a new value for the diameter (for example, type 4 to draw a 
circle with a diameter of 4 units.) EasyCAD displays a circular cursor with the specified diameter.

2. The prompt reads "Center:". Use the cursor and left or type numeric coordinates to select the 
center.    TIP: to resize the diameter of the circle while moving the cursor, hold down the CTRL key. 
Release the CTRL key to resume moving the circle.

3. You are again prompted for "Center:"    Continue drawing circles with the same diameter by 
selecting a series of centers or, press the right button to end the command.

Text equivalent (to bypass dialog box): CIRD



Radius and Center (Circles, Draw menu)
RADIUS and CENTER draws a circle using a radius measurement and a center point. Use the 
auto-repeat feature to draw more circles without using the menu. To draw a Radius and center 
circle, select CIRCLES-RADIUS AND CENTER from the Draw menu.

1. The prompt reads "Radius []:"    Select the radius. 

2. EasyCAD displays a circular cursor with the specified radius. Press the right button to accept the
default or prior radius.    Select a new radius using the crosshairs and left button to visually select
two points the desired distance apart or, type numeric coordinates (for example, to draw a circle 
with a 2 unit radius, type 2 and press ENTER.)

3. The prompt reads "Center:".    Use the cursor and left button or, type numeric coordinates to select 
the center.    Continue drawing circles with the same radius by selecting a series of centers with 
the left button or, press the right button to end the command.

Text equivalent (to bypass dialog box): CIRR



2 Point (Circles, Draw menu)
2 Point Circle draws a circle using two points that define its diameter. To draw a 2 point circle select 
CIRCLES-2 POINT CIRCLES from the Draw menu.

1. The prompt reads "1st point:" and the cursor becomes a crosshairs. Select a point with the 
crosshairs or type numeric coordinates.

2. The prompt reads "2nd point:" A stretching circular cursor with a line connecting the endpoints is 
displayed    Use the cursor or type coordinates to select a point on the opposite side of the circle. 
EasyCAD draws the circle.

3. The prompt then reads "1st point:".    Continue drawing two-point circles until you press the right 
button to end the command.

Text equivalent (to bypass dialog box): CIR2



3 Point (Circles, Draw menu)
3 Point Circle draws a circle using three points on its circumference. To draw a 3 point circle. select 
CIRCLES-3 POINT from the Draw menu.

1. The prompt reads "1st point:". Select a point with the crosshairs and left button or type numeric 
coordinates.

2. EasyCAD prompts you for "2nd point:" and "3rd point:"    Select them as you did for the 1st point. 
EasyCAD adds a stretching circular cursor after you select the second point.

3. EasyCAD draws a circle through the three points, then asks again for "1st point:"    Continue 
drawing three-point circles until you press the right button to end the command.    Please note: If 
you select three points in a straight line, a circle would be mathematically impossible, so EasyCAD
displays an message box: "Can't create entity because: Three points are in a straight line."    Press
the OK button or enter to clear the message.

Text equivalent (to bypass dialog box): CIR3



Tangent to 3 (Circles, Draw menu)
TANGENT TO 3 draws a circle tangent to three other circles or arcs.    To draw this circle, select 
CIRCLES-TANGENT TO 3 from the Draw menu.

1. The prompt reads "1st entity:"    Select the 1st entity with the mouse.

2. The prompt reads "2nd entity:" and "3rd entity:"    Select them as you did for the 1st entity. 
EasyCAD draws a circle tangent to the three entities selected.

Often, multiple circles could be drawn, given three entities.    You can help EasyCAD draw the one 
you want by selecting the entities near their expected points of tangency.

Text equivalent: CIRTAN3



Donut (Circles, Draw menu)
The DONUT command builds an automatic 2-circle multipoly.    To draw a donut select CIRCLES, 
DONUT from the Draw menu. Press the right button to accept the default value or type numeric 
coordinates.

1. The prompt reads "Inner diameter[]:".    Specify the diameter of the inner circle (donut hole). Press 
the right button to accept the default value or type numeric coordinates.

2. The prompt reads "Outer diameter[]:".    Specify the diameter of the outside circle of the donut.    
Press the right button to accept the default value or type numeric coordinates.

3. The prompt reads "Center []:". Press the right button to select the center with the cursor pick-box 
or type numeric coordinates.

After you select the center you may continue drawing donuts or, press the right button to end the 
command.

Text equivalent: DONUT



 



Arc commands (Draw menu)
When you select ARCS, a sidebar menu appears with five ways to draw arcs. Use the cursor and 
left button to select the method you want. EasyCAD remembers the center and radius of each 
circle, or arc you draw and offers them as default or prior (suggested) values the next time you draw
an arc during the same work session. This feature lets you draw concentric arcs. Press the right 
button to accept the default or prior value or enter a different value as explained under the 
individual arc commands.

· To draw a different type of arc, re-select ARCS.

· To fill or crosshatch (make a "pie slice") an arc, use WEDGE.

· To select line, fill, and arrow styles for new arcs, use ENTITY STYLE (Specs menu).

· To change line, fill, and arrow styles of existing arcs use, CHANGE, STYLE (Edit menu).

· To change the radius of an arc, use EDIT, DYNAMIC EDIT, or STRETCH in the Edit menu.

Arc types
Center and Radius
Center, Start, End
Start, Middle and End
Start, End and Bulge
Chained
Wedge



Center and Radius (Arcs, Draw menu)
Center and Radius draws an arc from a center, radius measurement, and starting and ending 
angles. Use this command when you want precise control over arc angles. For example, you could 
start a quarter circle at exactly 45° and end it at 135°.

To draw an arc with the center and radius method:
1. Select ARCS-CENTER AND RADIUS (Draw menu.)

2. The prompt reads "Center []:".    Press the right button accept the default center.    Select a new 
center using the crosshairs and left button or type numeric coordinates.

3. The prompt reads "Radius []:". Press the right button to accept the default radius or, type a new 
value for the radius (for example, to draw an arc with a radius of 2 units, type 2 and press 
ENTER.)

4. The prompt reads "Starting angle:" and a rubber-band cursor is displayed stretching from the 
center of the arc. Type an angle or select a point at the desired angle from the center.

5. The fourth prompt asks for the "Ending angle:" of the arc. A stretching arc-shaped cursor is 
displayed, anchored at the starting point.    Type an angle or select a point when the arc looks the 
way you want.    Tip: While stretching the cursor, hold down the SHIFT key to "pick up" and move 
the arc. Release the SHIFT key to go back to stretching.

EasyCAD draws the arc counterclockwise from the starting angle to the ending angle, then asks 
again for "Starting angle:" and "Ending angle:".    Continue to draw a series of arcs with the same 
center and radius or, press the right button to end the command.

Text equivalent (to bypass dialog box): ARCR



Center, Start, End (Arcs, Draw menu)
Center, start, end is a simplified Center and Radius arc that combines the radius and starting angle 
in a single point.    To draw an arc with the center and radius method:

Select ARCS-CENTER, START, END from the Draw menu.
1. To define the center of the arc, press the right button to accept the default center.    Select a new 

center using the crosshairs and left button or type numeric coordinates.

2. Specify the starting point of the arc, by using the stretching circular cursor that is displayed or, type
coordinates to select a point the desired distance and angle from the center.

3. Specify the ending angle by using the stretching arc cursor that is displayed, pressing the left 
button when the arc looks the way you want, or type an angle.    Tip: While stretching the arc 
cursor, you can hold down the SHIFT key to "pick up" and move the arc.    Release the SHIFT key 
to go back to stretching.

EasyCAD draws the arc counterclockwise from the starting point to the ending angle.

4. Press the right button to continue drawing a series of arcs or press the right button at the "starting 
point:" or "ending angle:" prompt.

Text equivalent (to bypass dialog box): ARCS



Start, Middle and End (Arcs, Draw menu)
START, MIDDLE AND END draws an arc from a starting point, a point on the arc, and an ending 
point.    To draw an arc with the start, middle and end method:

Select ARCS-START, MIDDLE AND END from the Draw menu
1. Specify the 1st point by using the crosshairs and left button or type numeric coordinates.

2. Select the 2nd and 3rd points in a similar manner. You can enter the points either clockwise or 
counterclockwise.    A stretching arc cursor is displayed after you place the second point.

EasyCAD draws the final arc from the first point, through the second, and to the third point.

Please note: If you select three points in a straight line, an arc would be mathematically 
impossible, so EasyCAD displays a message box: "Can't create entity because: Three points are in 
a straight line."    Press the OK button or enter to clear the message.

Text equivalent (to bypass dialog box): ARC3



Start, End and Bulge (Arcs, Draw menu)
START, END AND BULGE works very much like Start, Middle and End except that you select the 
arc's starting and ending points first, then a point on the arc.    To draw an arc with the start, end and
bulge method:

Select ARCS-START, END AND BULGE from the draw menu
1. Select the 1st point using the crosshairs and left button or type numeric coordinates.

2. Select the 2nd and 3rd points in a similar manner. EasyCAD adds a stretching arc cursor after you 
place both ends.

3. You are again asked for a 1st point.    Continue drawing "bulge" arcs or, press the right button to 
end the command. Please note: If you select three points in a straight line, an arc would be 
mathematically impossible, so EasyCAD displays a message box: "Can't create entity because: 
Three points are in a straight line."    Click the OK button to clear the message.

Text equivalent (to bypass dialog box): ARCB



Chained (Arcs, Draw menu)
CHAINED ARC draws a series of arcs. The first point begins the first arc. The second point 
determines a direction that is the tangent of the first point on the arc.    The next point sets the end 
of the first arc and defines the tangent and starting point of the next arc.    To draw a series of arcs:

Select ARCS-CHAINED from the Draw menu
1. Select the 1st point by using the crosshairs and left button or by    typing numeric coordinates.

2. Select the 2nd point to define the direction (or tangent vector) for the previous point. You can enter 
this point by using the crosshairs and left button or, type numeric coordinates.

3. Select the 3rd point to be the end of the first arc and the starting point of the next arc. 

EasyCAD draws the first arc from the first endpoint, constrained by the tanget vector, to the second 
endpoint, then asks again for a next point. Continue drawing two-point arcs or press the right button
to end the command.

Please note: If you select two endpoints whose bearing angle matches the direction vector,    an 
arc would be mathematically impossible, so EasyCAD draws a line between the two endpoints.

Text equivalent: CARCD



Wedge (Arcs, Draw menu)
WEDGE draws an arc exactly like the ARCS-CENTER AND RADIUS command.    A three node 
path is added, creating a multipoly that can be filled or crosshatched. The first and last nodes are 
connected to the ends of the arc. The middle node is located at the center of the arc.

To draw a wedge do the following
1. Select ARCS-WEDGE (Draw menu.)

2. The prompt reads "Center [ ]:".    Press the right button or ENTER or to accept the default or prior 
center.    Select a new center using the crosshairs and left button or type numeric coordinates.

3. The prompt reads "Radius [ ]:".Press the right button to accept the default radius. Type a new 
value for the radius (for example, to draw an arc with a radius of 2 units, type 2 and press 
ENTER.)

4. The prompt reads "Starting angle:" and a rubber-band cursor is displayed stretching from the 
center of the arc. Type an angle or select a point at the desired angle from the center.

5. The fourth prompt asks for the "Ending angle:" of the arc. A stretching arc-shaped cursor is 
displayed, anchored at the starting point.    Type an angle or select a point when the arc looks the 
way you want.    Tip: While stretching the cursor, hold down the SHIFT key to "pick up" and move 
the arc. Release the SHIFT key to return to stretching.

EasyCAD draws the wedge counterclockwise from the starting angle to the ending angle, then asks
again for "Starting angle:" and "Ending angle:".    Continue to draw a series of wedges with the 
same center and radius or, press the right button to end the command.

When EasyCAD uses UPDATE to convert EasyCAD 2.33 (and newer) drawings, it translates a filled
arc into a filled WEDGE (or multiploy).

Text equivalent (to bypass dialog box): ARCW



Ellipse commands (Draw menu)
When you select ELLIPSES, a sidebar menu appears with four ways to draw ellipses and elliptical 
arcs. Use the cursor and left button to select the desired method.

· An ellipse has a major axis and a minor axis. You can draw ellipses at any angle.    The angle 
of the major axis is called the inclination of the ellipse.

· EasyCAD remembers the center of each circle, arc, or ellipse you draw and offers it as default
or prior values the next time you draw an ellipse during the same work session. This feature 
lets you draw concentric ellipses. Press the right button to accept the default or prior, or enter 
a different value as explained under the individual ellipse commands.

· The auto repeat feature may be used after drawing an ellipse, to draw more ellipses of the 
same type.

· To select a fill pattern for new ellipses use ENTITY STYLE (Specs menu).

· To change the pattern of existing ellipses use CHANGE, STYLE, or EDIT commands in the 
Edit menu.

· To change a ellipses' radius use EDIT, DYNAMIC EDIT, or STRETCH commands in the Edit 
menu.

Ellipse types:
Center and Axis Points
Circle at Angle to Window
Center and Inclination
Elliptical Arc



Center and Axis Points (Ellipses, Draw menu)
CENTER and AXIS POINTS draws an ellipse from its center and two special points on its 
circumference-the ends of its minor and major axes. Of all possible points on the circumference, the
ends of the major axis are farthest from the center, while the ends of the minor axis are closest.    To
draw this type of ellipse:

Select ELLIPSES-CENTER and AXIS POINTS from the Draw menu
1. Specify the center of the ellipse.    Press the right button to accept the default center.    Select a 

new center using the crosshairs and left button or type numeric coordinates.

2. Select the ellipse axis endpoint. Select one end of either axis of the ellipse. (EasyCAD doesn't 
care whether you select the major or minor axis first.)

3. EasyCAD displays a stretching ellipse cursor, and you prompted for the ellipse axis endpoint:". 
Stretch the ellipse until it's the size and shape you want, then press the left button.    Tip: While 
stretching the cursor, you can hold down the SHIFT key to "pick up" and move the ellipse.

Text equivalent (to bypass dialog box): ELIPP



Circle at Angle to Window (Ellipses, Draw menu)
CIRCLE AT ANGLE TO WINDOW draws an ellipse as if it were a circle at an angle to the plane of 
your screen. The greater the angle, the more squashed the ellipse.    For example, an ellipse at 0° 
to the screen looks exactly like a circle, and its major and minor axes are the same. An ellipse at 
90° looks like a straight line. In an ellipse angled 60°, the major axis is exactly twice as long as the 
minor axis.    Please note: Don't confuse angle to the screen with the inclination of the ellipse.    To 
draw an ellipse with this method:

Select ELLIPSES-CIRCLE AT ANGLE TO WINDOW from the Draw menu
1. Specify the center of the ellipse. Press the right button to accept the default center.    Select a new 

center using the crosshairs and left button or type numeric coordinates.

2. Select the ellipse axis endpoint.    The axis endpoint determines the ellipse's inclination. TIP: Press
the SHIFT key to "pick up" and move the ellipse while stretching it.

3. Select the "Angle to window" by typing an angle from 0 to 90 degrees, then press ENTER.

Text equivalent (to bypass dialog box): ELIPC



Center and Inclination (Ellipses, Draw menu)
This command draws an ellipse using numeric values for its inclination and its major and minor 
diameters.    To draw an ellipse with this method:

Select ELLIPSES-CENTER AND INCLINATION from the Draw menu.
1. Select the ellipse center. Press the right button to accept the default center.    Select a new center 

using the crosshairs and left button or type numeric coordinates. Now the prompt reads 
"Inclination:".    This is the angle along the major (long) axis, measured counterclockwise from 0° at
3 o'clock.

2. Select the inclination of the ellipse by typing an angle and pressing ENTER.

3. Next, EasyCAD asks twice for "Axis diameter:".    Select the ellipse axis diameter by typing the 
values for the major and minor axis diameters (the order doesn't matter).

Text equivalent (to bypass dialog box): ELIPI



Elliptical Arc (Ellipses, Draw menu)
EasyCAD prompts you to select center and axis endpoints as for an elliptical arc. To draw an 
elliptical arc:

Select ELLIPSES-ELLIPTICAL ARC, from the Draw menu:
1. Select the Center of the arc.

2. Select the Ellipse axis endpoint.

3. Select the other Ellipse axis endpoint.

4. Select Starting angle for the arc. EasyCAD displays a rubber-band cursor stretching from the 
center of the ellipse. Select a point at the desired angle from the center, or type an angle.

5. Select the Ending angle of the arc. EasyCAD stretches the elliptical arc to follow the cursor. Press 
the left button when the arc looks the way you want, or type an angle. TIP: While stretching the 
elliptical and elliptical arc cursors, you can hold down the SHIFT key to "pick up" and move the 
arc. Release the SHIFT key to go back to stretching.

When EasyCAD uses UPDATE to convert EasyCAD 2.33 (and newer) drawings, it translates a filled
elliptical arc into a filled multipoly, much like a WEDGE.

Text equivalent (to bypass dialog box): ELIPA



Paths and Polys (Draw menu)
Paths and Polygons share the common characteristics of being singular entities that are composed 
of multiple connected segments. Polygons have closure and paths do not. Polygons, Wide Paths, 
and Wide Polys can be filled or crosshatched.    Simple paths can not be filled.

BOX and REGULAR POLYGON also draw polygons. EasyCAD stores the same information for all 
entities of this type. Paths, Polygons, Smooth Polygons, Splines, Arrows and Double Arrows are all 
defined by a series of nodes and can be edited in similar ways--for example, with STRETCH or 
DYNAMIC EDIT in the Edit menu.

WIDE PATH and WIDE POLY have additional the additional characteristic of width.

Path and Polygon types:
Box
Path
Polygon
Regular Polygon
Wide Path
Wide Poly 



Box (Paths/Polys, Draw menu)
BOX is a shortcut command that enters a rectangular polygon entity.    To draw a box:

Select PATHS/POLY-BOX from the Draw menu.
1. Select the 1st corner.    Use the crosshairs and left button or type numeric coordinates to select 

one corner of the box.

2. The cursor changes to a stretching rectangle anchored at the first corner, and the prompt reads 
"opposite corner:". Select a point when the rectangle is the size and shape you want or type 
numeric coordinates for the new corner.

EasyCAD draws a box-shaped polygon entity.

Text equivalent: BOX



Path (Paths/Polys, Draw menu)
PATH draws a routed connection between two end points. A path looks like a series of connected 
lines but is more like an open-ended polygon with at least 2 node points. Paths are useful in 
mapping, and other applications where connections are important.    To draw a path:

Select PATHS/POLYS-PATH from the Draw menu.
1. Select the first point, using the crosshairs and left button or, type numeric coordinates.

2. Now the prompt reads "Next point:".    Select a node point on the path. EasyCAD draws one leg of 
the path (in grey), then prompts again for "next point:".

3. Continue selecting nodes. After placing the ending point of the path, press the right button to end 
the command.

· To reshape a path, move nodes in relation to others with the NODE EDIT commands, 
STRETCH or DYNAMIC EDIT in the Edit menu.

· To create two paths from one path, use SPLIT (Edit menu).

· To insert a gap in a path (creating two paths), use BREAK (Edit menu)

· Use the TRIMS commands to extend the first or last segment of a path.

· To add or delete nodes in a path, use the NODE EDIT commands (Edit menu).

Text equivalent: PATH



Polygon (Paths/Polys, Draw menu)
POLYGON draws a closed shape, optionally filled or crosshatched, with at least 3 sides.    To draw a
polygon:

Select PATHS/POLYS-POLYGON from the Draw menu.
1. Select the first point node (corner) of the polygon.    Use the crosshairs and left button or, type 

numeric coordinates.

2. Select the next point in the same manner as the first node was selected. EasyCAD draws one side
of the polygon (in grey), then prompts again for "next point:".

3. Continue selecting nodes (each additional node forms another polygon side). Press the right 
button to close the polygon.

EasyCAD draws the final line segment from the last point back to the first point, automatically 
closing the polygon.

· To select a pattern for new polygons, use ENTITY STYLE (Specs menu).

· To change the pattern of an existing polygon, use EDIT (Edit menu) or use CHANGE,ENTITY 
STYLE (Edit menu) to change several at once.

· To reshape a polygon, move nodes in relation to others with STRETCH or DYNAMIC EDIT 
(Edit menu).

· To make a gap in a polygon (creating a path), use SPLIT (Edit menu).

· To add or delete nodes in a polygon, use the NODE EDIT commands (Edit menu).

Text equivalent: POLY



Regular Polygon (Paths/Polys, Draw menu)
REGULAR POLYGON is a shortcut command for entering regular polygon entities like equilateral 
triangles, squares, or hexagons. You define the center and a corner of the polygon (the corner is a 
point on an imaginary circle that encloses the polygon). To draw a regular polygon:

Select PATHS/POLYS-REGULAR POLYGON from the Draw menu:
1. Select the number of nodes. Press the right button to accept the default or prior number of sides.    

Type a new value (for example, type 4 and press ENTER to draw a square.)

2. Select the center point for the polygon using the crosshairs and left button or, type numeric 
coordinates.

3. A dynamic cursor, anchored to the center of the entity appears.    The prompt reads "1st corner:", 
select the 1st corner for the polygon in the same manner the center point was selected.

Text equivalent: RPOLY



Wide Path command (Draw menu)
WIDE PATH draws a routed connection, optionally filled or crosshatched, with width between two 
end points. A wide path looks like an open-ended polygon with at least 2 node points. Wide paths 
are useful in printed circuit layout, and other applications where connections are important.    To 
draw a wide path:

Select PATHS/POLYS-WIDE PATH from the Draw menu.
1. The prompt reads "Width [1.000]". Press the right mouse button or ENTER to accept the default. 

Type a new value in units, feet and inches, etc., or use the left mouse button to drag the cursor , 
specifying a distance on the screen.

2. Select the first point, using the crosshairs and left button or, type numeric coordinates.

3. Now the prompt reads "Next point:".    Select a node point on the path. EasyCAD draws one leg of 
the path (in grey), then prompts again for "next point:".

4. Continue selecting nodes. After placing the ending point of the path, press the right button to end 
the command.

· To reshape a wide path, move nodes in relation to others with STRETCH or DYNAMIC EDIT 
in the Edit menu.

· To create two paths from one path, use SPLIT (Edit menu).

· To insert a gap in a path (creating two paths), use BREAK (Edit menu)

· Use the TRIMS commands to extend the first or last segment of a wide path.

· To add or delete nodes in a wide path, use the NODE EDIT commands (Edit menu).

Text equivalent: WPATH



Wide Poly command (Draw menu)
WIDE POLY draws a closed polygon shape with width.    The width, not the interior, can be 
optionally filled or crosshatched.    To draw a polygon, with at least 3 sides:

Select PATHS/POLYS-WIDE POLY    from the Draw menu.
1. The prompt reads "Width [1.000]". Press the right mouse button or ENTER to accept the default. 

Type a new value in units, feet and inches, etc., or use the left mouse button to drag the cursor , 
specifying a distance on the screen.

2. Select the first point node (corner) of the wide poly.    Use the crosshairs and left button or, type 
numeric coordinates.

3. Select the next point in the same manner as the first node was selected. EasyCAD draws one side
of the wide polygon (in grey), then prompts again for "next point:".

4. Continue selecting nodes (each additional node forms another polygon side). Press the right 
button to close the polygon.

EasyCAD draws the final path segment from the last point back to the first point, automatically 
closing the wide polygon.

· To select a fill pattern for new wide polygons, use ENTITY STYLE (Specs menu).

· To change the pattern of an existing wide polygon, use EDIT (Edit menu) or use 
CHANGE,ENTITY STYLE (Edit menu) to change several at once.

· To reshape a wide polygon, move nodes in relation to others with STRETCH or DYNAMIC 
EDIT (Edit menu).

· To make a gap in a wide polygon (creating a path) use SPLIT (Edit menu).

· To add or delete nodes in a wide polygon, use the NODE EDIT commands (Edit menu).

Text equivalent: WPOLY

 



Splines and Spolys (Draw menu)

Splines are smooth curves.    Bezier, Cubic B-, and Parabolic curves can be drawn. Smooth 
polygons (SPolys) are closed entities that can be filled with an appropriate entity style.

Splines and Spoly types
Bezier
Cubic B-Spline
Cubic B-Spoly
Parabolic Spline
Parabolic SPoly



Bezier (Splines/Spolys, Draw menu)

BEZIER draws an open smooth curve, determined by a first point, a last point, and two control 
points called a frame. The curve touches the first and last points and follows an average path 
among the other two nodes. A Bezier must have exactly 4 nodes.

To draw a Bezier curve
1. Select SPLINES and SPOLYS-BEZIER (Draw menu)

2. Select the first point for the Bezier.    Use the crosshairs and left button or type numeric 
coordinates.

3. Select the last point of the Bezier. Straight grey lines (the frame) connect the nodes while you 
work.

4. Select the two control nodes as needed to finish the command. 

Using frames
EasyCAD normally hides the frame that you used to define the Bezier. Force display of frames on 
or off by selecting TOGGLE FRAMES (Specs menu).

To reshape a Bezier
Move nodes in relation to others with STRETCH or DYNAMIC EDIT in the Edit menu. 

Text equivalent: BEZ



Cubic B-Spline (Splines/Spolys, Draw menu)

CUBIC B-SPLINE (smooth polyline) draws an open smooth curve defined by a series of node 
points called a frame. The curve touches the first and last points and follows an average path 
among the other nodes. A spline must have at least 3 nodes.

To draw a Cubic B-Spline
1. Select SPLINES and SPOLYS-CUBIC B-SLPINE (Draw menu).

2. Select the first point for the spline end. Use the crosshairs and left button or type numeric 
coordinates.

3. Select the next point for another node.

Straight grey lines (the frame) connect the nodes while you work.    Select additional nodes as 
needed. Press the right button to end the spline.

Using frames
EasyCAD normally hides the frame that you used to define the spline. To force display of frames on 
or off throughout your drawing select TOGGLE FRAMES (Specs menu), or press Ctrl-F on the 
keyboard.

To reshape a spline
Move nodes in relation to others with STRETCH or DYNAMIC EDIT in the Edit menu. 

To insert a gap in an existing spline creating two separate splines
Use BREAK (Edit menu).

Text equivalent: SPLINE



Cubic B-SPoly (Splines/Spolys, Draw menu)

CUBIC B-SPOLY (smooth polygon) draws a closed, curved shape defined by a series of node 
points called a frame. The curve doesn't touch the nodes. A smooth polygon must have at least 3 
nodes. Each smooth polygon can be solid filled or crosshatched.

To draw a Cubic B-SPOLY
1. Select SPLINES and SPOLYS-CUBIC B-SPOLY (Draw menu).

2. Select the first point for the smooth polygon.    Use the crosshairs and left button or    type numeric 
coordinates.

3. Select the next point (straight grey lines, or frames, connect the nodes while you work).    Select 
additional nodes as needed.    Press the right button to close the curve.

EasyCAD draws the frame around a smooth curve.

Using frames
EasyCAD normally hides the frame that you used to define the smooth polygon. You can force 
display of frames on or off throughout your drawing by selecting TOGGLE FRAMES (Specs menu).

To reshape a smooth polygon
Move nodes in relation to others with STRETCH or DYNAMIC EDIT in the Edit menu.

To insert a gap in an existing smooth polygon to create a spline
Use BREAK (Edit menu).

To select a fill pattern for new smooth polygons
Use ENTITY STYLE (Specs menu).

To change the fill pattern of existing smooth polygons
Use EDIT (Edit menu).

Text equivalent: SPOLY



Parabolic Spline (Splines/Spolys, Draw menu)

PARABOLIC SPLINE (smooth polyline) draws an open, curved shape defined by a series of node 
points called a frame. The curve draws through all the nodes. A parabolic spline must have at least 
3 nodes. 

To draw a Parabolic Spline
1. Select SPLINES and SPOLYS-PARABOLIC SPLINE (Draw menu)

2. Select the first point for the parabolic spline.    Use the crosshairs and left button or    type numeric 
coordinates.

3. Select the next point (straight grey lines, or frames, connect the nodes while you work.) Select 
additional nodes as needed.    Press the right button to end the spline.

Using frames
EasyCAD normally hides the frame that you used to define the parabolic spline. Force display of 
frames on or off throughout your drawing by selecting TOGGLE FRAMES (Specs menu).

To reshape a parabolic spline
Move nodes in relation to others with STRETCH or DYNAMIC EDIT in the Edit menu.

To insert a gap in an existing parabolic spline creating two separate splines
Use BREAK (Edit menu).

Text equivalent: PSPLINE



Parabolic SPoly (Splines/Spolys, Draw menu)

PARABOLIC SPOLY (smooth polygon) draws a closed, curved shape defined by a series of node 
points called a frame. The curve draws through all the nodes. A smooth polygon must have at least 
3 nodes. Each smooth polygon can be solid filled or crosshatched.

To draw a Parabolic Spoly
1. Select SPLINES/SPOLYS-PARABOLIC SPOLY (Draw menu).

2. Select the first point for the smooth polygon. Use the crosshairs and left button or, type numeric 
coordinates.

3. Select the next point (straight grey lines, or frames, connect the nodes while you work).    Select 
additional nodes as needed. Press the right button to close the curve.

EasyCAD replaces the frame with a smooth curve passing through all the nodes.

Using frames
EasyCAD normally hides the frame that you used to define the smooth polygons. You can force 
display of frames on or off throughout your drawing by selecting TOGGLE FRAMES (Specs menu).

To reshape a smooth polygon
Move nodes in relation to others with STRETCH or DYNAMIC EDIT in the Edit menu. 

To insert a gap in an existing smooth polygon to create a spline
Use BREAK (Edit menu).

To select a fill pattern for new smooth polygons
Use ENTITY STYLE (Specs menu)

To change the pattern of existing smooth polygons
Use EDIT (Edit menu)

Text equivalent: PSPOLY



Arrows (Draw menu)

The ARROWS commands draw entities (paths, arcs, or splines) with an arrowhead at the first node 
point.    Please keep in mind the following:
· The arrowhead shape and size are determined by ENTITY STYLE (Specs menu);

· You can create notes by combining ARROW entities with text entities.

Path Arrow
1. Select the first point.    Use the crosshairs and left button or, type numeric coordinates.

2. Select the next node point on the arrow.    Continue selecting nodes until you press the right button 
to end the arrow.

Text equivalent: PATHA

Arc Arrow
1. Select the first point.    Use the crosshairs and left button or, type numeric coordinates.

2. Select the 2nd and 3rd points of the arc in the same manner as you selected the 1st point.    

Text equivalent: ARCA

Spline Arrow
1. Select the first point.    Use the crosshairs and left button or, type numeric coordinates.

2. Select the next point Continue selecting nodes until you press the right button to end the arrow.

Text equivalent: SPLINEA



Double Arrows (Draw menu)

Double Arrows draws entities just like the ARROWS, except that it has arrowheads on both ends.
· The arrowhead shape and size are determined by ENTITY STYLE (Specs menu). 

· You can create notes by combining DOUBLE ARROW entities with text entities.

· If you use BREAK to insert a gap in the double arrow, EasyCAD replaces it with two single 
arrows.

Path Double Arrow
1. Select the first point.    Use the crosshairs and left button or type numeric coordinates.

2. Select the next node point on the arrow.    Continue selecting nodes until you press the right button 
to end the arrow.

Text equivalent: PATHDA

Arc Double Arrow
1. Select the first point.    Use the crosshairs and left button or, type numeric coordinates.

2. Select the 2nd and 3rd points of the arc in the same manner as you selected the 1st point. .

Text equivalent: ARCDA

Spline Double Arrow
1. Select the first point.    Use the crosshairs and left button or type numeric coordinates.

2. Select the next point.    Continue selecting nodes until you press the right button to end the arrow.

Text equivalent: SPLINEDA



Text command (Draw menu)

TEXT adds lettering (for labels, notes, etc.) to your drawing. EasyCAD draws text, with these 
properties, in a new drawing:

· Height (of a capital letter) = 0.20 units

· Angle = 0° (horizontal)

· Default or prior spacing below previous text entity = 150% of text height

· Stretch factor = 1.0000

· Justification = Left

Edit Text dialog box options
When you select TEXT, EasyCAD displays a text-editing window into which you can type up to 128 
characters on one line.
1. Select the Multi line option to enter more than one line of text. Type the desired text, while typing, 

you can:

· Use the keyboard arrow keys, HOME, and END to move the cursor within the editing 
window;

· Press DEL (Delete) to delete the character under the cursor;

· Press BACKSPACE to delete characters to the left of the cursor;

· Type special characters using the ALT key.
After you type the text the prompt reads "Text location:", and EasyCAD displays crosshairs as a 
dynamic cursor.
2. Select the text location. Select a different point with the cursor or, type numeric coordinates.

Tip: While placing the new text, you can stretch or shrink it by pressing the CTRL key and moving 
the mouse slowly up or down .This feature makes it very easy to fit text to existing objects without 
setting text height in advance. Stretching text this way does not reset EasyCAD's height value for 
new text--the next text entity you draw will still have the original current height. You can draw text at 
any height, angle, or spacing; with many True Type® fonts; and align text with any combination of 
Left, Center, Right., Top, Mid, and Bottom Justifications.

To set properties for new text
Use TEXT PROPERTIES (Specs menu).

To change the properties of existing text.
Use EDIT or CHANGE, TEXT PROPERTIES in the Edit menu.

Text equivalent: TEXT (display dialog box)
Macro equivalent: TEXTM (bypass dialog box)



File Text command (Text, Draw menu)

FILE TEXT inserts an ANSI text file into the current drawing, using the current Text Properties.    The
file is not required to have a TXT extension but "*.txt" will appear each time you use the File Text 
command.    EasyCAD displays the Open Text File dialog box listing existing files.

Open Text File dialog box options
1. Select an existing text file name with the cursor or type it's name.

2. Now the prompt reads "Text location:", and EasyCAD displays crosshairs as a dynamic cursor and 
a rectangle approximating the shape and size of the text about to be placed.    Select a different 
point with the cursor, or type numeric coordinates.

Text equivalent: TFILE (display dialog box)
Macro equivalent: TFILEM (bypass dialog box)

Related topics
Text 



Dimensions (Draw menu)

EasyCAD draws associative dimensions that    measure distances and angles of entities and 
displays their values.    When you make changes to the entities, EasyCAD updates the dimensions 
to reflect the new measurements.

When you select DIMENSIONS, EasyCAD displays a sidebar menu with six choices for creating 
dimensions:
· three ways to enter linear dimensions (horizontal, vertical, and parallel)

· angular dimensions

· circular (diameter) dimensions 

· radial dimensions

Dimensions
Horizontal
Vertical
Parallel
Angular
Radius
Diameter

Related Topics:
Drawing linear dimensions
Drawing circular dimensions
Dimension Style command



Drawing linear dimensions

Use DIMENSION STYLES (Specs menu) to set properties for dimensions you are about to draw. 
Use CHANGE-DIMENSION STYLE (Edit menu) to change the dimension styles you have already 
drawn.

Please note:    After you choose HORIZONTAL, VERTICAL, or PARALLEL, the prompt reads "1st 
point: [or ENTER to select entity]:". Use the crosshairs and left button or type numeric coordinates 
to select a point or press the right button (ENTER) to select an entity.    If you selected a first point, 
the prompt now reads "2nd point:". Select a point at the other end of the distance to be measured. 
The third prompt reads "Dimension at [inline]:". The default or prior value (between brackets) draws 
dimension text and arrows lined up with (in line with) the last dimension you drew. Press the right 
button to accept the default or prior value, or select a different location.

EasyCAD keeps leader lines at right angles to dimension arrows during all editing operations. Use 
EDIT (EDIT menu) to show or hide dimension leader lines.

Horizontal dimensions
measure only the horizontal distance (along the X axis) between two points (or of an existing 
entitiy), ignoring any vertical difference between the points. Dimension text and arrows are 
horizontal.

Text equivalent: DIMH

Vertical dimensions
measure only the vertical distance (along the Y axis) between two points (or of an existing entitiy), 
ignoring any horizontal difference between the points. Dimension arrows are vertical. You can 
control the orientation of vertical dimension text with DIMENSION STYLE (Specs menu). Check the
Text Position - Align with Arrows check box for vertical text.

Text equivalent: DIMV

Parallel dimensions
measure the actual distance, at any angle, between two points (or of an existing entity).

Text equivalent: DIMP



Angular (Dimensions, Draw menu)

ANGULAR dimensions measure an angle (in degrees) and displays that value. You supply the 
center, starting point and ending point of the angle. Optional leaders are drawn in the current line 
style.

When you select ANGULAR, the prompt reads "Angle vertex:". Use the crosshairs and left button or
type numeric coordinates to select a point (for example, the intersection of two lines). EasyCAD 
draws a rubber-band cursor from the center, and the prompt reads "Starting point:". The starting 
point sets both the radius of the dimension arc and its starting angle. Select the point. The prompt 
changes to "Leader end [no leader]:", and EasyCAD draws a rubber-band cursor stretching from 
the start point toward the center point. Press ENTER or the right mouse button to select the default 
or prior value (no leader) or stretch the cursor and press the left button when the leader is the 
desired size.

EasyCAD draws the leader in grey and displays another rubber-band cursor indicating the size of 
the arc. The prompt reads "Ending angle:". Stretch the cursor and press the left mouse button when
the dimension is the correct size. When EasyCAD asks for the size of the second leader, indicate it 
the same way as the first. EasyCAD draws the dimension counterclockwise from the starting point 
to the ending point.

Editing an angular dimension: Use EDIT (in the EDIT menu) to change the center, radius, leader 
line length, type, or angles of an angular dimension. Click the DSTYLES button to display the 
Select Dimension Style dialog box. 

Text equivalent: DIMA
Related Topics:
Drawing linear dimensions
Dimension Style command



Drawing circular dimensions

After you choose a circular dimensioning command, the prompt reads "Select circle or arc:". Use 
the pick cursor box and left button to select an appropriate entity. EasyCAD displays a dynamic 
cursor.    Now the prompt reads "Leader [no leader]:". You may:
· Stretch the leader    as desired, then press the left button to place the text or,

· Press the right button or ENTER to place the text and arrows inside the circle. EasyCAD uses 
your original entity selection point (on the arc or circle) and aligns dimension text to the bearing 
angle defined by the center of the circle and the selected point on the circle. Selecting a leader 
point inside the circle has a different effect.

EasyCAD places the dimension text. Diameter dimensions include the letter phi ( f ) as the first 
character in the dimension. Radius dimensions include the capital letter R. You can control the 
orientation of dimension text with DIMENSION STYLE (Specs menu). Use EDIT (Edit menu) to 
change the radius, leader length, or leader angle of a circular dimension.

Related Topics:
Dimension Style command
Drawing Linear dimensions



Radius (Dimensions, Draw menu)
RADIUS dimensions measure the radius of a circle or arc and displays that value. When you select 
RADIUS, the prompt reads "Select circle or arc:". Use the cursor pick box to select an entity. The 
prompt changes to "Leader end [no leader]:".    EasyCAD provides a rubber-band cursor that allows 
you to define the leader line. Leader lines are drawn in the current line style. Press the right button 
to draw a radius dimension inside the circle or arc.

Text equivalent: DIMR
Related Topics:
Dimension Style command
Circular dimensions



Diameter (Dimensions, Draw menu)
DIAMETER dimensions measure the diameter of a circle or arc and displays that value. When you 
select DIAMETER, the prompt reads "Select circle or arc:". Use the cursor pick box to select an 
entity. The prompt changes to "Leader end [no leader]:".    EasyCAD provides a rubber-band cursor 
that allows you to define the leader line. Leader lines are drawn in the current line style. Press the 
right button to draw a diameter dimension inside the circle or arc.

Text equivalent: DIMD
Related Topics:
Dimension Style command



Fillet (Draw menu)

FILLET draws an arc entity at the intersection of lines, circles, arcs, ellipses and splines for a 
smoothly rounded corner. Note: do not specify fillets of zero radius. A zero-radius fillet can not exist.
Use TRIM TO INTERSECTION instead.

Fillet entities
· That cross,

· That are already connected at their endpoints,

· That don't meet (as long as they aren't parallel or concentric).

When filleting the intersection of a line and a circle (or arc)
· Fillets can lie inside or outside the circle, and above or below the line.

· Select the entities on the sides where you want the fillet.

· EasyCAD doesn't trim either entity.

If you fillet the intersection of two arcs or circles

· EasyCAD can only draw external fillets--outside the curves of the existing entities.

To draw a FILLET
Select FILLET (Draw menu).    You are prompted for 1st and 2nd entities.
1. Select the 1st and 2nd entity. If you want them trimmed, select the entities on the ends you want to

keep.

2. Select the Fillet radius. Press the right button to accept the default or prior value, or enter a new 
value. A message box will be displayed if you ask for a fillet radius too large. If you specify a fillet 
radius of 0 (zero), EasyCAD extends or trims the original entities to their intersection point (no arc 
is drawn).

3. Specify trim. Select the YES button to accept the trim.    Select the NO button if you don't want to 
trim the entities,

Normally, EasyCAD trims or extends the selected lines or arcs to meet the ends of the fillet arc.

Text equivalent: FILLET



Chamfer (Draw menu)

CHAMFER draws a line entity near the intersection of two entities for a beveled corner. You can 
add a chamfer to entities that cross, entities that are already connected at their endpoints, or 
entities that do not meet (as long as they are not parallel). Note: do not specify chamfers of zero 
length. A zero-length chamfer should not be created.    Instead, use TRIM TO INTERSECTION.

When you select CHAMFER, EasyCAD prompts you for "1st entity:" and "2nd entity:"
1. Select the 1st and 2nd entity. Select two non-parallel entities.

2. Enter the Chamfer distance. The chamfer distance specifies how far from the intersection of the 
selected entities to put the chamfer line.    Press the right button to accept the default or prior value
or, enter a new value. EasyCAD draws the chamfer line.

Normally, EasyCAD trims or extends the selected lines or arcs to meet the ends of the fillet arc.    If 
you specify a chamfer distance of 0 (zero), EasyCAD extends or trims the two lines to their 
intersection point, and a zero-length chamfer line will be drawn.

1. Specify trim. Select the YES button to accept the trim.    If you do not want EasyCAD to trim the 
entities, select NO and press ENTER.

Text equivalent: CHAMFER



MultiPoly (Draw menu)

MULTIPOLY (Multiple Polygons) collects existing entities and turns them into a new entity. This 
entity can be filled with a fill pattern defined as part of an entity style. An enclosed entity inside a 
filled area will leave a hole, or unfilled area. The entities that can be included in a multipoly are 
lines, arcs, circles, ellipses, paths, polygons, splines, text, and existing multipolys.

The entities you want to be in the mutipoly must exist before selecting the MULTIPOLY command. 
In order for the fill style to be contained, the bounding entities must share endpoints. Otherwise, the
fill pattern may leak out.    When a multipoly is created ,all affected entities are changed to the 
current color, layer, and style.    DONUT and WEDGE are examples of multipolys that EasyCAD 
builds "on-the-fly".    Multipolys can also be used to group entites together, although it does affect 
the layer, color, and style of those entites.

Drawing a multipoly
Select the entities as prompted by the Select Entity dialog box.    EasyCAD replaces the selected 
entities with a mulitpoly entity, giving it the current layer, color, and line and fill style.

Editing a multipoly
To work on the multipoly as a whole use commands like MOVE and ROTATE in the Edit menu.

EXPLODE the multipoly back to its original entities for individual editing.

To add new entities, use MULTIPOLY to select the existing multipoly along with the new entities.

Text equivalent: MPOLY2

 



The Edit menu

Edit menu commands change the size, angle, scale, location, and other properties of entities. You 
can UNDO Edit commands and use the auto-repeat feature.    Some Edit commands work on one 
entity at a time while others allow you to select multiple entities before performing the command.

Edit commands
Single-Entity Edit Multiple-Entity Edit

Undo Break Erase ScaleXY
Edit Split Change Rotate
Dynamic Edit Trims Drag Connect
Offset Chain Node Edit Move Mirror
Offset One Arrowhead Stretch Front

Scale Explode

Related Topics
Selecting entities



Undo command (Edit menu)
EasyCAD marks the entities affected each time you use a DRAW, EDIT, or INSERT command.    
After completing the command, select UNDO to put the entities back the way they were or to 
remove the newly added entities. You can use UNDO until you make a new selection, SAVE, or 
otherwise close your drawing.

Please note: If you repeat an editing command unintentionally (by pressing a mouse button), press
the Cancel button to quit the entity selection dialog box without choosing a selection method. Once 
you start the selection process, you won't be able to undo the previous command.

To redo the command (undo the UNDO), select UNDO again, or press either button. (You can do 
this repeatedly, flipping back and forth between "before" and "after" versions of your drawing with a 
single button press.)

After you are satisfied with the UNDO or REDO, you could SAVE your drawing to compress it, 
permanently removing the unused versions of the entities. This is important if the command you 
undid affected a lot of entities (for example, undoing a large PART ARRAY or other COPY menu 
command).

Text equivalent: UNDO



Edit command (Edit menu)

The EDIT command is a general-purpose command that lets you modify most entities one at a time,
using dialog boxes for changing numerical values. The prompt reads "Entity to edit:". Select a single
entity (remember to select text entities on their base line). EDIT works differently depending on the 
type of entity you select.

Note: The values in dialog boxes can be modified with algebraic expressions. For example, select 
a circle. After pointing to the end of the Radius value in the Edit Circle dialog box, enter *2. The 
radius will double in length. Click OK to display the larger circle.

Text equivalent: EDIT

Related Topics



Dynamic Edit command (Edit menu)

The DYNAMIC EDIT command is a general-purpose command that lets you modify most entities 
one-at-a-time, using visual screen methods to modify them. The SHIFT and CTRL keys can also be
used to modify individual entities.

Text equivalent: DYNEDIT



Offset Chain command (Edit menu)
Offset Chain    works with "connected" lines, circles, arcs, ellipses, elliptical arcs, paths, 
polygons, and splines.    Entities must share endpoints to continue the sequence or "chain".    
If more than two entities share the same endpoint, EasyCAD must make a best guess as to 
the direction the chain is to take. Offsets of splines and ellipses are now paths that are really 
parallel to the originals.

Select OFFSET CHAIN from the Edit menu.

1. The prompt reads "Distance [0.250]:".    Use the crosshairs and left button to visually specify a 
distance or type a new value.    Press the right button to accept the default.

2. The prompt reads "Chain:". Select an entity whose endpoint is shared with at least one other 
entity. 

3. The prompt reads "Pick a side:". Indicate on which side of the entities you want the offset to be 
drawn. 

4. The command will execute, drawing a continuous offset next to every entity that continues the 
"chain".

Text equivalent: OFFSET



Offset One command (Edit menu)

Offset One    works with lines, circles, arcs, ellipses, elliptical arcs, paths, polygons, and splines.

Select OFFSET ONE from the Edit menu.

1. The prompt reads "Distance [0.250]:".    Use the crosshairs and left button to visually specify a 
distance or type a new value.    Press the right button to accept the default.

2. The prompt reads "Entity:". Select an entity. 

3. The prompt reads "Pick a side:". Indicate on which side of the entity you want the offset to be 
drawn. 

4. The command will continue, asking for another entity, and then a side. Press the right button or 
ENTER to finish the command.

Text equivalent: OFFSET1



Break command (Edit menu)

BREAK makes gaps in all entities except points, text, and dimensions. If you BREAK a line, arc, 
path, or spline, EasyCAD creates two entities where there was one. BREAK turns a circle into an 
arc, a polygon into a path, or a smooth polygon into a spline. If you BREAK an arrow or double 
arrow, EasyCAD doesn't add arrowheads--it replaces an arrow with an arrow and a path, or a 
double arrow with two single arrows. 

Select an entity, then select start and end points for the gap. EasyCAD breaks the entity and 
removes the portion selected.

To restore the original entity, select UNDO from the EDIT menu.

Break Tips:
· If the break start and end points are the same, EasyCAD creates two entities, even though you 

can't see the place where they join. If you break a line or arc at one of it's endpoints, EasyCAD 
creates two entities (one is very short). To shorten or extend an arc or line, use TRIM.

· When you break a polygon or smooth polygon, EasyCAD always keeps node #1. When you 
break a circle, EasyCAD removes the portion of the circle you selected at the "entity to break:" 
prompt.

· If snap locking is turned on when you use BREAK, EasyCAD breaks the entity where it passes 
nearest to a snap point. You can use modifiers like ON, % ALONG or DEGREE to break at 
specific points on the entity, or use the SNAP button on the command bar.

Text equivalent: BREAK



Split command (Edit menu)

SPLIT divides an entity into two entities of the same type.

To reverse the operation, select UNDO from the Edit menu.

Text equivalent: SPLIT



Trim commands (Edit menu)

TRIMS commands trim or extend selected entities. Entities that can be trimmed include lines, 
paths, arcs, elliptical arcs, and splines. Trim will extend paths (but not splines) past their endpoints. 
Points, text, dimensions, and closed entities can not be trimmed. When you select TRIMS, a 
sidebar menu appears with four different methods for trimming entities.

Trims:
Trim
Trim to entity
Trim to intersection
Trim to length



Trim command (Edit menu)

TRIM trims or extends an entity to a new endpoint.

The prompt reads "Entity to trim:". Select a point on the end of the entity you want to keep. Now the
prompt reads "Trim to point:". Select a new endpoint for the entity. EasyCAD erases the end of the 
line opposite the selection point, beyond the "Trim to:" point.

If snap locking is on when you use TRIM, EasyCAD trims the entity to the point closest to the 
nearest snap point.

To restore the original line
select UNDO (EDIT menu)

Text equivalent: TRIM



Trim to entity command (Edit menu)

TRIM TO ENTITY trims or extends selected entities to their intersection with another entity.

The prompt reads "Trim to:". Select a point on the entity to which you will trim other entities.    Now 
the prompt reads "Entity:". The entity (or entities) you select will be trimmed to the previously 
chosen entity.

To restore the original line
select UNDO (EDIT menu)

Text equivalent: TRIMTO



Trim to intersection command (Edit menu)

TRIM TO INTERSECTON trims or extends two entities to a new endpoint at their intersection.

The prompt reads "1st entity:". Select a point on the first entity you want to trim or extend. Now the 
prompt reads "2nd entity:". Select a point on a second entity. Both entities will be redrawn, sharing a
common endpoint.

To restore the original line
select UNDO (EDIT menu)

Text equivalent: TRIMINT



Trim to length (Edit menu)

TRIM TO LENGTH trims or extends an entity to a pre-defined length.

The prompt reads "Length [default]:". Enter a new length or accept the prior value with the right 
mouse button. Now the prompt reads "Entity:". The entity (or entities) you select will be trimmed to 
the pre-defined length. Select each entity near the end you wish to keep.

This command will trim an arc to its actual "arc length".

To restore the original line, select UNDO from the EDIT menu.

Text equivalent: TRIML



Node Edit commands (Edit menu)

The NODE EDIT commands allow you to insert and delete nodes in entities that have nodes as 
control points, such as paths, wide paths, polygons, wide polys, and splines.

Insert Node
The prompt reads "Insert node at:". Select a point on the entity you wish to modify. Select a point for
the new node. The endpoints of the orignal entity stay in place, and EasyCAD draws two new 
segments from the endpoints to the new point. Paths, wide paths, polygons, wide polys, and splines
can have a maximum of 508 nodes.

Text equivalent: INSNODE

Delete Node
The prompt reads "Delete node at:". Select a point on the entity near the node you wish to delete. 
The node is deleted and a new segment draw between the two previously adjoining nodes. Paths, 
wide paths, polygons, wide polys,and splines must have at least two nodes.

Text equivalent: DELNODE



Arrowhead command (Edit menu)

ARROWHEAD toggles the current ARROW style on the nearest end of a selected path or arc.    If 
you apply an arrowhead to a line, EasyCAD turns that line into a path.

To reverse the operation, select UNDO from the Edit menu.

To change the style of the arrow, select ENTITY STYLE from the Specs menu

Text equivalent: AHEAD



Erase command (Edit menu)

The Erase command removes the selected entities from your drawing.

Please note: EasyCAD erases entities from your screen by drawing over them in the background 
color (usually black). This may leave apparent holes in other entities, especially if the erased 
entities were filled or crosshatched. Select REDRAW from the VIEW menu to clean up the screen.

To recover the entities, select UNDO from the EDIT menu.

Text equivalent: ERASE



Change commands (Edit menu)

When you select CHANGE, a sidebar menu appears listing the properties of entities that you can 
modify. All entities have a color and are drawn on a layer and in an entity style. In addition, 
dimensions have their own styles, and text entities have many features unique to text. Use the 
cursor and left button to select one of the options.

The UNDO command works with all variations of CHANGE.

Change commands:
Change Color
Change Layer
Change Entity Style
Change Dimension Style
Change Text Properties



Change-Color (Edit menu)

CHANGE-COLOR redraws entities in a different color. After you select entities to modify, the prompt
reads "New color:". You can:

· Select a different color from the palette with the left button;

· Press the right button or ENTER to change to the current color;

· Type a color number and press ENTER.

Text equivalent (to bypass dialog box): CHANGEC



Change-Layer (Edit menu)

CHANGE-LAYER moves entities to a different layer. After you select entities to modify, the prompt 
reads "New layer name [Dialog]:". Type an existing layer name, or press the right button or ENTER 
to display the Layer Management dialog box. Highlight the name of the layer you wish to move the 
entities to, then click OK or press ENTER.

Text equivalent: CHANGEL

Related topics
Copy to Layer command 
Set Current Layer command 



Change-Entity Style (Edit menu)
CHANGE-ENTITY STYLE redraws entities in a different , pre-defined entity style.    After you select 
entities to modify, the prompt reads "New style name [Dialog]:". You can:

· Type a pre-defined style name and press ENTER;

· Press the right button or ENTER to display the Select Style dialog box. Highlight the entity 
style you wish to change the entities to.

Note:  If there is only one entity style defined, then all entities in that drawing have the same entity 
style. Changing one feature of that entity style affects all entities in the drawing.

Text equivalent: CHANGES

Related topics
Select Entity Style 
New Entity Style 
Edit Entity Style 
Edit command 



Change-Dimension Style (Edit menu)
CHANGE-DIMENSION STYLE redraws dimensions in a different dimension style. After you select 
dimensions to modify, the prompt reads "New dimension style name [Dialog]:". You can:

· Type a dimension style name and press ENTER;

· Press the right button or ENTER to display the Select Style dialog box. Highlight the 
dimension style you wish to change the entities to.

Note:  If there is only one dimension style defined, then all dimensions in that drawing have the same 
dimension style. Changing one feature of that dimension style affects all dimensions in the drawing.

Text equivalent: CHANGED

Related topics
Select Dimension Styles 
New Dimension Style 
Edit Dimension Styles 
Edit command 



Change-Text Properties (Edit menu)

CHANGE-TEXT PROPERTIES redraws selected text with different properties. Text properties 
include Font, Metrics, and Character style. After you select text to modify, EasyCAD displays the 
Change text properties dialog box. The current text specifications are displayed. Clicking on and 
changing any value (or font name) will result in the selected entities acquiring the new property 
values. This action does not change the current text specifications, only the existing selected 
entities.

Text equivalent: CHANGET
Related topics
TEXT PROPERTIES



Drag command (Edit menu)

DRAG moves selected entities dynamically--you see the entities moving on-screen.    It is possible 
to drag an entire drawing, but this command works best when you drag only a few entities at a time.

After you select entities to drag, the prompt reads "Drag from:".    Select a point somewhere among 
the entities you want to drag.    The exact location is not important.    Now the prompt reads "Drag 
to:"    As you move the mouse, the entities move to follow.    If snap locking is turned on, the entities 
jump over positions between snap points.    Press the left mouse button when the entities are where
you want them placed.

To reverse the drag, select UNDO from the Edit menu.

Text equivalent: DRAG

Related Topics
Move



Move command (Edit menu)

MOVE moves the selected entities in relation to the rest of the drawing, using a displacement 
(distance and direction) that you specify with two points.

After you select the entities to move, the prompt reads "Move from:". Use the crosshairs and left 
button or type coordinates to select a base point for the move. Now the prompt reads "to point:". 
Select a second point. EasyCAD calculates the distance and direction between the points, and 
moves the selected entities accordingly.

You can force the selected entities to move only horizontally or only vertically by turning on 
orthogonal locking.

To reverse the move, select UNDO from the EDIT menu.

Text equivalent: MOVE

Related Topics
Drag



Stretch command (Edit menu)

STRETCH reshapes most entities by moving some of their end or node points in relation to the 
others. 

First, EasyCAD asks you to select the entities to stretch. Usually, you will enclose the points to be 
moved in a selection rectangle (window), optionally using NOT to protect certain entities from the 
command.

Now the prompt reads "Stretch points in window [Pick window]:".    EasyCAD is asking you to draw 
a selection rectangle around the ends or node points you want to move. If you selected entities with
a window in the previous step, you can use that same window to select points by pressing the right 
button. If you selected entities by another method, pressing the right button cancels the command. 
In any case, you can draw a new window around the points to move.

Finally, the prompt reads "Move from:". Select a point with the crosshairs and left button or by 
typing coordinates. EasyCAD displays a rubber-band cursor, and the prompt reads "to point: " . 
Select a point to indicate the distance and direction you want the points in the window to move. 
EasyCAD moves the endpoints that were inside the stretch window, leaving other endpoints where 
they were.

To restore the original versions of the entities, select UNDO from the EDIT menu.

Stretch Tips:
· You can force the selected points to move only horizontally or only vertically by turning on 

orthogonal locking

· Enclosing the center of a circle, ellipse, or arc in the window will move the entity.

Text equivalent: STRETCH

Related Topics
Stretching circles, arcs and dimensions



Stretching circles, arcs and dimensions

Stretching circles
To change the radius of a circle, include just a point on it's circumference in the stretch window. 
If the window includes the circle's center, it moves without stretching.

Stretching arcs
To change the radius of an arc, include just it's midpoint in the stretch window. Stretch either 
endpoint to change the angles of the arc. Use the DEGREE modifier to stretch the arc to a 
specified angle. If the stretch window includes both endpoints, or the midpoint and one 
endpoint, the arc moves without stretching

Stretching linear dimensions
To change the distance a dimension measures, include the end of one leader line in the stretch 
window. To move dimension text and arrows closer to or farther from the object being 
dimensioned, include the left arrowhead (or both arrowheads) in the stretch window. If you 
select ends of both leader lines, the dimension moves without stretching. In all cases, 
dimension arrows stay at right angles to the leader lines.

Stretching angular dimensions
To change the radius of the dimension arc (but not the angle), include just it's midpoint in the 
stretch window. Stretch either arrow end to change the angle measured by a dimension. You 
can use the DEGREE modifier to stretch it to a specific angle. Stretch the inner end of a leader 
to make it longer or shorter. If you include the dimension's center in the stretch window, the 
dimension moves without stretching.

Stretching circular dimensions
To change the radius or diameter of the dimension (and the circle or arc it's attached to), 
include an arrow tip in the stretch window. Stretch the end of a leader to change it's angle or 
make it longer or shorter. If you include the dimension's center in the stretch window, the 
dimension (and arc or circle) moves without stretching.

Stretching ordinate dimensions
Stretch the origin point to change the (0,0) point from which other leaders are measured. 
Stretch the text end of the origin leader (the ".000") to make the leaders longer or shorter (all 
the text will move to stay in line). Stretch individual dimension points to change the distance 
they measure.



Scale command (Edit menu)

SCALE shrinks or enlarges the selected entities. After you select the entities to scale, the prompt 
reads "scale by [2]:". Enter a scaling factor. For example, to make the entities twice as large as they
are now, press ENTER. To make them half as large, type .5 and press ENTER.

Now the prompt reads "scale center:"--the point around which EasyCAD should scale the entities. 
Use the crosshairs and left button or type coordinates to select a point. EasyCAD redraws the 
entities at the new scale. (The scale center remains fixed.)

To reverse the scaling operation, select UNDO from the EDIT menu.

Text equivalent: SCALE
Related Topics
SCALEXY



Scale XY command (Edit menu)

SCALE XY reshapes selected entities, scaling them by different amounts horizontally (x) and 
vertically (y).    After you select entities to scale, the prompt reads "Scale X by [1]:", then "Scale Y by
[1]:". Type a scaling factor (to make the entities twice as wide without changing their height, type 2 
and press ENTER twice.)

Now the prompt reads "Scale center:".    Select a point around which to scale the entities, EasyCAD
redraws the entities at the new scale.    (The scale center remains fixed.)

To reverse the scaling operation, select UNDO from the EDIT menu.

Text equivalent: SCALEXY



Rotate command (Edit menu)

ROTATE turns selected entities around a specified center. After you select the entities to rotate, the 
prompt reads "Rotate by angle [90.000]:", with the last angle you used suggested as a default or 
prior value. (The default is 90° when you start a new work session.) You can:

· Press the right button or ENTER to accept the default or prior rotation.

· Type a positive or negative angle, which can include VALUES like 90.0005° or 22+1/2°. 
(Remember that positive angles turn counterclockwise.) For example, to turn the entities 45° 
clockwise, type 45 and press ENTER.

Next, the prompt reads "Rotate center [0.000,0.000]:"--the point around which EasyCAD should 
turn the entities. Use the crosshairs and left button or type coordinates to select a point. EasyCAD 
rotates the entities around the center, which remains fixed.

To reverse the rotation, select UNDO from the EDIT menu.

Text equivalent: ROTATE



Connect command (Edit menu)

CONNECT moves, scales, and rotates an entity or entities, connecting it to other entities. You 
supply EasyCAD with four points, two on the entity to be moved (source entity) and two on the 
target entity.

First, EasyCAD asks you to select entities to edit. Select only the entity or entities that should be 
changed to make the connection. For example, to move an arc so it connects to two lines which 
stay in place, select the arc, not the lines.

After you select the entities to be moved, the prompt reads "connect from 1st point:". Select a point 
on the source entity. Now the prompt reads "connect to:". Select a point on the target entity. 
EasyCAD prompts for "connect from 2nd point:" and another "connect to:" point. Select points on 
the source and target entities. EasyCAD calculates the changes needed to fit the "connect from" 
points to the "connect to" points.

When selecting connect points, use modifiers like ENDPOINT to get an exact fit.

To reverse the operation, select UNDO from the EDIT menu.

Text equivalent: CONNECT



Mirror command (Edit menu)

MIRROR transforms an entity into a mirror image of itself, flipped over a mirror line that you specify.
This line is not actually drawn

After you select the entities to Mirror, the prompt reads "Mirror line start:", then "Mirror line end:". 
Select starting and ending points for the mirror line, which can be drawn at any angle. EasyCAD 
flips the entities.

To reverse the mirroring, select UNDO from the EDIT menu.

Text equivalent: MIRROR
Related Topics
MIRROR COPY



Front command (Edit menu)

FRONT brings entities to the front of your screen. After you select the entities, EasyCAD moves 
them to the end of the drawing file. Because EasyCAD draws entities in the order that it finds them 
in the file, entities at the end appear to be on top of or in front of other entities.

For example, a filled polygon drawn after a line appears in front of the line on-screen, hiding it. You 
could use FRONT to select the line to be in front of the polygon.

If the entity style of the polygon uses a fill pattern that is transparent and not totally opaque, the line 
will be seen behind the fill pattern.

The UNDO command does not    work after using FRONT.

Text equivalent: FRONT



Explode command (Edit menu)

EXPLODE reduces the complexity of entities down to more basic components.

· Points, lines, circles, arcs, wide paths, and wide polys do not reduce.

· Multipolys and symbol references will be reduced to the original entities.

· Lines that were converted to paths in a multipoly will be exploded as paths.

· ,Ellipses will be reduced to polygons

· Polygons and splines will be reduced to a series of lines.

· Multi-line text will be reduced to individual single lines of text.

· Vertical text will be reduced to individual letters.

· Dimensions reduce to text, lines, and poygons representing the arrowheads.

Explode can also be useful for removing errant blocks, symbols, or special entities found after 
importing some DXF files produced by third parties.

To reverse the operation, select UNDO from the Edit menu.

Text equivalent: EXPLODE
Related Topics
MULTIPLOYS 
 



The Copy menu

Commands in the Copy menu add new entities to your drawing by duplicating existing entities or by
inserting parts.    EasyCAD marks the entities added as new when you use Copy commands. You 
can edit the copies or make copies of the copies by choosing PRIOR from the entity selection 
dialog box.

COPY, SCALED COPIES, ROTATED COPIES, and MIRRORED COPIES select only the copies 
added to the drawing, not the originals.

Copy commands
Copy
Scaled Copies
Rotated Copies
Mirrored Copies
Copy to Layer
Rectangular array
Circular Array



Copy command (Copy menu)

To copy entities:

Select COPY (Copy menu)
1. Select the entities to copy using the Entity selection dialog box.

2. Select the copy origin (prompt reads "Copy origin:"). This is a base point that EasyCAD uses to 
determine copy placement. The cursor turns into crosshairs.    Select a point on the entity or 
entities to be copied using the crosshairs and left button or type coordinates.

3. Select a location for the copy (prompt reads "Copy to:") use the cursor and left button or type 
coordinates.

EasyCAD calculates the distance and direction between the points and copies the selected entities 
accordingly. The prompt still reads "Copy to:" and a rubberband Is attached to the reference entity. 
You can make multiple copies, selecting a new location for each, until you press the right button.

You can force the copies to line up horizontally or vertically with the originals by turning on 
orthogonal locking.

To remove the new entities, select UNDO from the EDIT menu. If you made multiple copies, UNDO 
removes them all.

Text equivalent: COPY



Scaled Copies command (Copy menu)

SCALED COPIES shrinks or enlarges copies of selected entities. After you select the entities to 
scale and copy, the prompt reads "Scale by [2]:". Enter a scaling factor.    For example, to make the 
copies of the entities three times as large as the originals, type 3 and press ENTER. To make them 
half as large, type .5 and press ENTER.

Now the prompt reads "Scale center [0.00,0.00]:"    This is the point around which EasyCAD will 
scale the new entities. Accept the default, use the crosshairs and left button, or type coordinates to 
select a new scale center point.    EasyCAD draws the new entities at the selected scale.    The 
scale center remains fixed as the new entities grow or shrink around it.

To reverse the scaling operation
Select UNDO from the EDIT menu.

Text equivalent: SCLCPY



Rotated Copies command (Copy menu)

ROTATED COPIES works like ROTATE except that instead of rotating the selected entities, it 
makes a rotated copy, of the entities, leaving the originals in place.

To rotate a copy:
1. After you select entities to copy, the prompt reads "Rotation by angle [90]:", with the last angle you 

used suggested as a prior value. Enter an angle using one of the methods described for ROTATE 
under the EDIT menu.

To remove the new entities:
Select UNDO from the EDIT menu.

Text equivalent: ROTCPY



Mirrored Copies command (Copy menu)

MIRRORED COPIES works like MIRROR  except that instead of flipping the selected entities, it 
makes a mirror-image copy of them, leaving the originals in place. This is useful for drawing objects
that are symmetrical about any axis. Draw one side of the object, then use MIRRORED COPIES for
the other side.

To mirror copy:
1. After selecting entities to copy, select start and end points for the mirror line as described for 

MIRROR. You can use modifiers like ENDPOINT to lock the mirror line onto the edges of the 
entities you are copying, ensuring a perfect connection between originals and copies.

To remove the new entities:
Select UNDO from the EDIT menu.

Related topics
Mirror 

Text equivalent: MIRCPY



Copy to Layer command (Copy menu)

COPY TO LAYER copies selected entities to a different layer leaving the originals in place.    After 
selecting the entities to be copied, the Layer Management dialog box is displayed.    Select the layer
and click OK when you are done.. EasyCAD copies the entities to the selected layer (you can check
this with the LIST command in the Info menu.)

Text equivalent: LAYERCPY
Related topics
Layers 



Rectangular array (Copy menu)

RECTANGULAR ARRAY makes a rectangular array (regularly spaced rows and columns) of 
copies.    Build rectangular arrays using entities in you drawing or parts and symbols inserted from 
another file.

To build a rectangular array:
1. After you select entities to copy, the prompt reads "Number of columns [1]:". EasyCAD is asking 

for the number of horizontal copies to draw. Type the total number of objects in each row, including
the original.

2. The next prompt reads "Number of rows [1]:". EasyCAD is asking for the number of vertical copies 
to draw. Type the total number of objects in each column, including the original.

3. Now the prompt reads "Repeat origin:". This is a base point that EasyCAD uses to determine 
spacing between copies. Select a point on the object to be copied.

4. Finally, the prompt reads "2nd row, 2nd column:". This offset from the base point tells EasyCAD 
both the horizontal and vertical distance you want between parts in the array. EasyCAD draws a 
rubber-band cursor from the "Repeat origin" to help you judge the spacing. Use the cursor and left 
button to select the point.

To remove the new entities:
Select UNDO from the EDIT menu.

Text equivalent: REPEAT

Related topics
Part Array 



Circular Array command (Copy menu)

CIRCULAR ARRAY makes multiple copies arranged in rings.    Build circular arrays using entities in 
you drawing or parts and symbols inserted from another file.

To build a circular array
1. After you select entities to copy, the prompt reads "Number of spokes [1]:". EasyCAD is asking for 

the number of copies to draw per revolution. Type the total number of spokes, including the 
original. 

2. The next prompt reads "Number of rings [1]:". EasyCAD is asking for the number of concentric 
rings of copies to draw. Type the total number of rings, including the original..

3. The prompt reads "Array center [0.00,0.00]:". Select a point.

4. Now the prompt reads "Copy origin:". This base point determines spacing between copies. Select 
a point on the entity or entities to be copied.

5. Next, EasyCAD prompts for "Angle between spokes [60.000]:". The default spaces the spokes 
evenly to make a full circle.

If you asked for more than one ring, the prompt reads "Distance between rings:" (distance from the 
origin of the original to the corresponding point on the first copy in the next ring). Enter a 
measurement.

Finally, EasyCAD draws the array.

To remove the copies:
Select UNDO from the EDIT menu.

Text equivalent: CARY
Related Topics
Circ Part Array 

 



The Insert Menu

Commands in the Insert menu share these features: UNDO, Auto-repeat, and entity selection. 
EasyCAD temporarily marks the entities added when you use Insert commands. You can edit or 
make copies of the inserted entities by choosing PRIOR, from the entity selection dialog box.

Insert commands
Insert Part Ungroup 
Part Array Define Symbol
Circ Part Array List SymDef
Write Part Delete SymDef
Group Draw Symbol

Parts commands (Insert menu)

A part is any EasyCAD drawing that you insert into another drawing.    If your work uses repeated 
elements like furnishings, electronic components, or standard details, save each element as an 
individual drawing file.    The PART commands let you use such elements over and over without 
ever having to construct them again.

To create a part file
· Make an EasyCAD drawing in the usual way, using ORIGIN (View menu) to set the (0,0) point as

explained below;

· Use WRITE PART to save selected entities from an existing drawing as a separate file.
When EasyCAD inserts one file into another as a part, it puts the inserted file's origin or (0,0) 
coordinate on the "insert at:" point.    When you start a new drawing, the (0,0) point is below and to 
the left of    the screen.    When you create a drawing to use as a part, use ORIGIN (View menu) to 
set the (0,0) point to a logical point in the part--the center or lower-left corner is usually a good 
choice.

Normally, entities that you insert as parts keep the layer assignments that they had in the original 
part file (so you can have multi-layer parts). If you want EasyCAD to insert the part on the current 
work layer instead, draw the entities in the part file on the Merge layer.  If you forgot to set a part up 
this way, it is easy to move the newly inserted part to the current layer -- just select CHANGE, 
LAYER, PRIOR, then DO IT. Press the right button to display the Layer Management dialog box, 
then click OK to accept the current layer.

Commands for inserting parts:
· INSERT PART adds one part at a time;

· PART ARRAY builds a rectangular array (rows and columns);

· CIRC PART ARRAY builds a circular array (spokes and rings).

Each time you insert a part, you can scale and rotate it as needed.    If units in the part file are 
different from the units in the current drawing, EasyCAD does the conversion for you.    For 
example, If you insert a 48" desk with units defined as Inches into a floor plan with units defined as 
Feet, the desk is 4 units long in the floor plan.

EasyCAD groups each part as you add it to your drawing, treating the entire part as a single entity. 
To modify individual entities within inserted parts, you can turn group locking off temporarily with the
UNLOCK button, or press Ctrl-L.



Related Topics
Insert Part
Part Array
Circ Part Array
Write Part



Insert Part command (Insert menu)

INSERT PART adds any other EasyCAD drawing, as a part, to the working drawing.    One part at a 
time is inserted.    To insert a part:

Select INSERT PART from the Insert menu.
1. Select a drawing using the cursor, or type a drawing file name from the list of available drawings.

2. The prompt reads "Scale by [1.000]:". Enter the scale factor by pressing    the right button or 
ENTER to accept the default of no scaling (same size as the original part).

3. The prompt reads "Rotate by angle [0.000]:". Enter a rotation factor by pressing the right button or 
ENTER to accept the default of no rotation (just as it looks in the original, or enter an angle 
between 0 degrees and 360 degrees.    For example type 45 and press ENTER to rotate the part 
45 degrees counter-clockwise.

4. The prompt reads "Insert at:". Enter an insertion point by use the crosshairs and left button, or type
coordinates to select an insertion point for the part.

EasyCAD draw the contents of the part file at the insertion point, then repeats the prompt "Insert 
at:".

5. Continue inserting copies of the part until you press the right button to end the command.
To remove the new entities, select UNDO (Edit menu).    If you inserted multiple parts, UNDO 
removes them all.

Text equivalent: PART (display dialog box)
Macro equivalent: PARTM (display dialog box)
Related Topics
Working with parts
Part Array
Circ Part Array
Write Part



Part Array command (Insert menu)

PART ARRAY builds a rectangular array (rows and columns) from multiple copies of a part file, 
arranging the parts in regularly spaced columns and rows.    To create an array of parts:

Select PART ARRAY from the Insert menu.
1. Select a drawing using the cursor, or type a drawing file name from the list of available drawings. 

The prompt reads "Scale by [1.000]:".

2. Enter the scale factor.    Press the right button or ENTER to accept the default of no scaling (same 
size as the original part). The prompt now reads "Rotate by angle [same]:".

3. Enter a rotation factor.
· Press the right button or ENTER to accept the default of no rotation (just as it looks in the 

original), or

· Enter an angle between 0 degrees and 360 degrees.    Each individual part will be rotated by
this angle about its origin.    For example, type 45 and press ENTER to rotate the part 45 
degrees counterclockwise. The prompt reads "Number of columns[1]:".

4. Enter the number of columns you want the array to have. The prompt reads "Number of rows[1]".

5. Enter the number of rows you want the array to have.    The prompt reads "Insert 1st part at:".

6. Enter an insertion point.

7. EasyCAD draw the contents of the part file at the insertion point. The prompt reads "2nd row, 2nd 
column:". This offset from the insertion point tells EasyCAD both the horizontal and vertical 
distance between parts.    A rubber-band cursor appears from the "insert at" point to help you judge
the spacing.    When you are satisfied with the distance, press the left button.

To remove the new entities
Select UNDO (Edit menu).    If you inserted an array of parts, UNDO removes them all.

Text equivalent: PARY (display dialog box)
Macro equivalent: PARYM (bypass dialog box)
Related Topics
Working with parts
Insert Part
Circ Part Array
Write Part



Circ Part Array command (Insert menu)

CIRC PART ARRAY (Circular Part Array) inserts multiple parts arranged in rings.    It's like a 
combination of CIRCULAR ARRAY and PART ARRAY. The angle of the first spoke (from the center 
to the "copy origin" or insertion point) determines the angle of each part in the array.    To draw a 
circular part array:

Select CIRC PART ARRAY from the Insert menu.
1. Select a drawing using the cursor, or type a drawing file name from the list of available drawings. 

The prompt reads "Scale by [1.000]:". Enter the scale factor.    Press the right button or ENTER to 
accept the default of no scaling (same size as the original part). The prompt now reads "Rotate by 
angle[same]:".

2. Enter a rotation factor.    Please note: The default (no rotation) inserts parts in the first spoke 
exactly as they appear in the part file.    This makes a difference when the first spoke is not at 0º.    
Press the right button or ENTER to accept the default of no rotation (just as it looks in the original, 
or enter a different angle.

3. The prompt reads "Number of spokes [1]:".    Enter the desired number of spokes you want the 
array to have.

4. The prompt now reads "Number of rings [1]:".    Enter the desired number of rings you want the 
array to have.

5. The prompt reads "Array center:". Select the location for the placement of the array center.    Use 
the crosshairs and left button, or type coordinates to select an insertion point for the center.

6. The prompt now reads "Insert 1st part at:".    Select an insertion point for the first part (on the inner 
ring of the first spoke). EasyCAD draws the first part.

7. The prompt reads "Angle between spokes [ ]:".    Enter the angle between spokes.    The value of 
the angle is pre-calculated    to space the parts evenly around a full circle. You may over-ride this 
value with a different angle.

8. If you told EasyCAD to insert more than one ring, the prompt reads "Distance between rings:".    
Enter a measurement.

EasyCAD completes the array.

To remove the new entities,
Select UNDO (Edit menu). If you inserted an array of parts, UNDO removes them all.

Text equivalent: CPARY (display dialog box)
Macro equivalent: CPARYM (bypass dialog box)
Related Topics
Working with parts
Insert Part
Part Array
Write Part



Write Part command (Insert menu)

WRITE PART saves selected entities from the current drawing as a separate drawing.    Use this 
command to create a library of parts. To use write part:

Select WRITE PART from the Insert menu
1. EasyCAD asks you to select the entities to be included in the part file.

2. After you select the entities to include in the new part, the prompt reads "Part origin point:". Select 
the part origin. This is the (0,0) point for the new part file.    EasyCAD will align the new part's 
origin with the insertion point when you insert the part into another file.    Usually, you will select a 
point on the lower-left corner or center of the entities to be included in the part.

3. After you select an origin point, the Save File As dialog box appears. Select a file to hold the new 
part.    A list of existing drawings is displayed.    Type a new or existing file name, or select an 
existing drawing with the cursor.

4. EasyCAD copies the selected entities into the specified file. If entities you select for the part are 
already part of a group, they will be double-grouped when the new part is inserted into another 
drawing.    You may wish to ungroup the selected entities before using WRITE PART.

Text equivalent: WRITE (display dialog box)
Macro equivalent: WRITEM (bypass dialog box)
Related Topics
Working with parts
Insert Part
Part Array
Circ Part Array



Group command (Insert menu)
GROUP combines multiple entities so they act like a single entity,    Use GROUP to create 
structures composed of multiple entities that you want to keep together.    Each group is assigned a 
unique number that identifies itself.    Entities pasted from the clipboard are not grouped, but groups 
pasted from the clipboard receive new numbers.

When you insert parts with INSERT PART, PART ARRAY, or CIRC PART ARRAY, each part 
becomes a group with its own number.

Groups can be nested within other groups. For example, a drawing of a cabinet can be a group, 
treated as a single entity. The cabinet can include other groups like doors, drawers, and shelving 
units.    If the total number of groups in a drawing exceeds 64,000, EasyCAD just stops grouping the
newest additions. 

To break groups temporarily throughout your drawing, select the UNLOCK button, or press Ctrl-L. 
Select the UNLOCK button again to restore group locking. When the button is IN, EasyCAD ignores
grouping and acts on each entity individually. When the button is OUT, EasyCAD acts on groups as 
a whole.

With group locking ON, the single-enitiy EDIT commands will operate on an individual entity in a 
group, while multiple-entity EDIT commands will operate on the entire group, even if some entities 
in the group are on hidden layers.

To break a group permanently, use the UNGROUP command. UNDO does not work after GROUP.

Text equivalent: GROUP (display dialog box)
Related Topics
Edit menu 
Insert menu 
Ungroup 



Ungroup command (Insert menu)
UNGROUP permanently removes a single level of grouping from the selected entities. Because 
entities can be part of more than one group, and groups can be part of other groups, you may have 
to use UNGROUP more than once.

UNDO does not work after UNGROUP.

Text equivalent: UNGROUP (display dialog box)
Related Topics
Group 



Symbol commands (Insert menu)

A symbol is a named collection of entities that defines a complex object--each symbol acts like a 
single entity.    Like parts, symbols provide a mechanism for handling repeated elements.    To use 
symbols, create a    symbol definition that EasyCAD stores in an invisible section of the current 
drawing file.    Then you insert copies of the symbol, called symbol references, throughout the 
drawing.    Because each reference is only an image of the symbol definition, you can add hundreds
of symbols without excessive memory usage.

You can revise references to a symbol throughout a drawing by deleting the original symbol 
definition. Creating a new symbol with the original name will allow the new symbol to be redrawn at 
all the referenced locations. You can rotate, scale, or move individual symbol references, but you 
can not make internal changes without exploding the symbol.
In contrast, parts add actual entities to your drawing, just as if you drew each part yourself.    You 
can edit individual entities in parts.    Symbols offer some advantages over parts, but they redraw 
slower and are harder to use.

Note: Symbols in drawing files imported from other application programs may appear to be ill-
behaved. If possible, have the exporting program "explode" their symbols or "blocks" before 
importing or updating the drawing.

Commands for managing symbols:
· DEFINE SYMBOL creates a named symbol definition;

· LIST SYMDEF displays or prints a list of symbol definitions;

· DELETE SYMDEF removes a symbol definition and/or references to it;

· DRAW SYMBOL inserts symbol references at any angle or scale. 

To create a symbol definition, draw the individual entities, then use DEFINE SYMBOL to give it a 
name (up to 30 characters) and an origin point.    EasyCAD moves the entities that make up the 
symbol definition to the drawing's invisible symbol area, ready to be referenced by DRAW 
SYMBOL.

Symbol definitions are part of the current drawing only.    To share symbols among several 
drawings, create a drawing file that contains nothing but symbol definitions,    You can then use 
INSERT PART to add the symbol definitions to any drawing.

To modify symbols, delete the symbol definition, keep the references, then make a new definition 
with the same name.

If symbols appear to behave eractically, EXPLODE them. 

Related topics
EXPLODE 



Define Symbol command (Insert menu)

DEFINE SYMBOL collects entities to make a symbol definition.    To create a symbol definition:

1. Select DEFINE SYMBOL.    The prompt reads "Symbol name:".    Type a name (no spaces), then 
press ENTER.

2. The Entity Selection dialog box appears, select the entities to be included in the symbol.

3. The prompt reads "Symbol origin:".    Select a point, usually at the lower-left or center of the new 
symbol.    The symbol will disappear.    Use DRAW SYMBOL to create references to the symbol 
that can be seen.

UNDO (Edit menu) brings back the entities that went into the symbol, but does not un-define the 
symbol!    Use LIST SYMDEF to see names of symbol definitions and DELETE SYMDEF to erase a 
definition.

Please note: When you select entities for a new symbol definition, you can include references to 
other symbols.    Keep in mind that nested symbols slow EasyCAD down, especially if the 
references are scaled or rotated.

Text equivalent: DEFSYM

Related Topics
List SymDef
Delete SymDef
Draw Symbol
Working with symbols
Creating symbol libraries



List Symbol Definition command (Insert menu)

LIST SYMDEF provides information about symbol definitions available in the current drawing.    A 
text box similar to the LIST command is displayed.    The unique symbol definitions are listed, 
indented five spaces and identified with the word "def".    All references are listed with the word 
"draw" preceding them.    The order of the list follows the rules for order in the drawing file, including
the use of the FRONT command.

Text equivalent: LISTSYM

Related Topics
Define Symbol
Delete SymDef
Draw Symbol
Working with symbols
Creating symbol libraries



Delete Symbol Definition command (Insert menu)

DELETE SYMDEF deletes a symbol definition.    If the current drawing contains references to the 
deleted definition, the references disappear from your screen--however, they are still in the drawing.
If you make a new symbol definition with the same name, the references reappear the next time 
you use REDRAW (View menu) or a zoom command.    This feature lets you update symbols 
throughout your drawing--for example, replacing desks throughout an office plan with a re-designed
model.

Choose a symbol name.    You may delete that symbol's definition, or all references to it, or both 
(removing all traces of the symbol).    Of course, if neither check box is checked, nothing will 
happen.

UNDO does not work with this command.

Text equivalent: DELSYM

Related Topics
Define Symbol
List SymDef
Draw Symbol
Working with symbols
Creating symbol libraries



Draw Symbol command (Draw and Insert menu)

DRAW SYMBOL adds a symbol reference to your drawing.    A symbol reference is an image of a 
symbol definition that you have stored in the invisible symbol area of your drawing.    You can scale 
and rotate each reference as it is inserted.

Select a symbol from the list, set the Rotaion, X Scale, and Y Scale, then click OK.    The prompt 
reads "Insert at:".

EasyCAD draws an image of the symbol at the insertion point, then repeats the prompt.    Continue 
inserting symbols until you press the right button or ENTER to end the command.

Please note:    Although EasyCAD doesn't have specific commands for drawing symbols in 
rectangular or circular arrays, you can do this very easily--just insert one symbol, then select 
PRIOR for the COPY or ARRAY commands.

Text equivalent: SYMBOLD

Related topics
Define Symbol
List SymDef
Delete SymDef
Working with symbols
Creating symbol libraries



Creating symbol libraries

While you can create and use symbols within any drawing, symbols can be a more effective tool if 
you take time to set up a symbol library.    Follow these step-by-step instructions:

1. Start a new drawing with a name that indicates it's a library, for example elecsym for electrical 
symbols or offcfurn for office furniture.

2. Create a symbol with EasyCAD's drawing and editing commands, then use DEFINE SYMBOL to 
turn it into a symbol definition.

3. Repeat Step 2 for each symbol.    When finished, your symbol library still looks like an empty 
drawing.    Be sure to save it before continuing!

4. Use INSERT PART to add the symbol library to your current drawing.    The symbol definitions are 
invisible, so you will not see anything yet.    Do not insert the library more than once.

5. Draw symbol references as required.

Related topics
Define Symbol
List SymDef
Delete SymDef
Draw Symbol
Working with symbols

 



The Specs menu

The SPECS (Specify) menu controls some of EasyCAD's precision drawing features like Grids, 
Frames, and Crosshairs. Other commands set formats and styles for entities, text, and dimensions.

Specs commands
Select Grid Toggle Group Lock Select by
Align Grid Entity Style Configure XPs
Toggle Frames Dimension Style Units
Toggle Crosshairs Text Properties

Select Grid command (Specs menu)

SELECT GRID displays the Select Grid System dialog box    with options that control the grid 
system.    Grids are classified as either rectangular or circular. Horizontal and vertical grid spacing 
may be set independently. You may edit existing grids to create new grids, allowing for even greater
control of your drawing environment. EasyCAD has one rectangular grid and one circular grid 
already set up for you to use. They can be edited, modified, even renamed, but these two can not 
be deleted.

Select Grid System dialog box options
Grid Name

Select one of the pre-defined grids or a grid that you have defined.    

Standard Rectangle is a rectangular grid with editable values for horizontal (X) and vertical 
(Y) grid spacing, Grid origin, and Snap division.

Standard Circular is a circular grid with editable values for Angular and Radial spacing, Grid 
Center, and Snap divisions.

Grid Class
EasyCAD currently supports two kinds of grids: Rectangular and Circular.

Switches
Grid      Click this checkbox to display a regular pattern of grid dots to help you keep track of 

distances and sizes.    The dots are only a visual aid and are not part of your final drawing. 

Toggle the display of the grid with the Grid button  on the command line, or type 
GRIDON or GRIDOFF at the command prompt.

Snap    locking makes points that you select on screen jump to coordinates at a spacing that you choose.  

SNAP may also be toggled with the Snap button  on the command line, or by typing SNAPON 
and SNAPOFF at the command prompt.
Cursor snap    Cursor snap locks the cursor to the snap points.    When snap locking is on, cursor snap 
makes cursors "jump" to snap points instead of moving smoothly over the screen. Toggle with the 

CsrSnap button  on the command line. 
Ortho    locking temporarily forces new lines to be horizontal or vertical.    Rubber-band cursors also lock 
to horizontals and verticals when orthogonal locking is on. Toggle on and off with the Ortho button

 on the command line.
You can type grid names containing spaces on the command line when using the SGRID 
command). Grid definitions are saved with each drawing file.



Text equivalent: SGRID
Text equivalent to turn grids on and off: GRIDON, GRIDOFF, GRIDTOG

Related Topics
Editing rectangular grids
Editing circular grids
Working with snap locking



Editing rectangular grids

The Edit Rectangular Grid System dialog box is displayed when a rectangular grid is selected for 
editing, or when creating a new grid.

Edit Rectangular Grid System dialog box options
Name
Displays the name of the grid being edited. If you are creating a new grid, type a new name. You 
can change the name of an existing grid by typing over the existing name.

Spacing parameters
Snap divisions
Displays the number of snap points per grid unit.

Spacing
Displays the distance between grid dots in the current distance display format and number of 
decimal places.

Options 
Turn the Square Grid option off to allow different values for X spacing and    Y spacing.

Grid origin
The origin (0,0) point of the grid can be different than the (0,0) point set by ORIGIN (Specs menu).

Related topics
Select Grid command



Editing circular grids

The Edit Circular Grid System dialog box is displayed when a circular grid is selected for editing, or 
when creating a new grid.

Edit Circular Grid System dialog box options
Name
Displays the name of the circular grid being edited. If you are creating a new grid, type a new name.
You can change the name of an existing grid by typing over the existing name.

Spacing parameters
Angular
Displays the angle (in degrees) between spokes in the circular grid pattern.

Radial
Displays the distance between rings in the circular grid pattern.

Snap divisions 
Displays the number of snap points per circular grid unit.

Grid Center
Displays the origin (0,0) point of the circular grid. It can be different than the (0,0) point set by 
ORIGIN (Specs menu).

Related topics
Select Grid command



Align Grid command (Specs menu)

Use the ALIGN GRID command to reset visual alignment of the grid dots. This command does not 
reset the origin point (0,0) of the drawing.

To align the grid
1. Choose ALIGN GRID (Specs menu).

2. When asked to "Align grid to point"
· Press the right mouse button or ENTER to accept the default or prior value or,

· Click the point on the screen for new grid alignment or,

· Type the coordinates of the point for new grid alignment.

Text equivalent: AGRID



Toggle Frames command (Specs menu)

TOGGLE FRAMES displays or hides wide path, smooth polygon, and spline frames.    The 
TOGGLE FRAMES command should not be used in macros, use the FRAMEON and FRAMEOFF 
commands (not listed in any menu.)

You can also type the text equivalents of these three commands at the command prompt to turn 
frames on or off.

Text equivalent for TOGGLE FRAMES:    FRAMETOG
Text equivalent for FRAME ON:    FRAMEON (for use in macro programming)
Text equivalent for FRAME OFF:    FRAMEOFF (for use in macro programming)

Related topics
Splines and Spolys
Wide Path  



Toggle Crosshairs command (Specs menu)
TOGGLE CROSSHAIRS displays or disables the full-screen crosshair cursor used for second and 
susequent point (or entity) selections.    The TOGGLE CROSSHAIRS command should not be used
in macros, use the XHON and XHOFF commands (not listed in any menu.)

The current state of the crosshair cursor is saved with each individual drawing file.

Text equivalent for TOGGLE CROSSHAIRS:    XHTOG
Text equivalent for CROSSHAIRS ON:    XHON (for use in macro programming)
Text equivalent for CROSSHAIRS OFF:    XHOFF (for use in macro programming)



Toggle Group Lock command (Specs menu)
GROUP LOCK affects groups created with the GROUP or INSERT PART commands.    When 
locking is turned ON (the normal state of the UNLOCK button), the single-enitiy EDIT commands 
will operate on an individual entity in a group, while multiple-entity EDIT commands will operate on 
the entire group, even if some entities in the group are on hidden layers.

Group locking can be toggled ON and OFF with this menu item or by pressing CTRL-L. 

To break groups temporarily throughout your drawing, select the UNLOCK button, or press Ctrl-L.. 
Select the UNLOCK button again to restore group locking. When the button is IN, EasyCAD ignores
group locking and acts on each entity individually. When the button is OUT, EasyCAD acts on 
groups as a whole.

Text equivalent for TOGGLE GROUP LOCK:    LOCKTOG
Text equivalent for GROUP LOCK ON:    LOCKON (for use in macro programming)
Text equivalent for GROUP LOCK OFF:    LOCKOFF (for use in macro programming)

Related Topics
Group  
Ungroup 
Insert Part 



Entity Style command (Specs menu)

 ENTITY STYLE displays the Select Style dialog box listing available styles, and the properties of 
the current line, fill, and arrow styles. Use this command to apply, create, edit and delete styles.    When 
you choose a different style from the list, the style will only be applied to new entities that are drawn.    
Some combinations of entities and styles are not logically possible.    You can not, for example, put an 
Arrowhead on a point, or fill a line.To change the style of an individual entity, use the EDIT command. To 
change the style of a collection of entities already drawn, use CHANGE-ENTITY STYLE . Both can be 
found in the Edit menu.

Select Style dialog box options
Available styles

Select a style from the list to apply, edit or delete.    Styles may be named for easy recall.    
The selected style will be the current style applied to new entities.

Line style
Displays the current line style.    To edit the line style, click once with the left button, or select 
the Edit button.

Fill style
Displays the current fill style.    To edit the fill style, click once with the left button, or select the
Edit button.

Arrow style
Displays the current arrow style.    To edit the arrow style, click once with the left button, or 
select the Edit button.

OK button
Click to save the settings, and end the command.

Cancel button
Click the to end the command, keeping the prior settings.

New button
Click to display the Define New Entity Style dialog box. The dialog box will initially take on 
the settings of the highlighted style in the Select Style dialog box.

Macro equivalent: NEWSTYLE (bypass dialog box)

Edit button
Click to display the Edit Entity Style dialog box. The currently selected style will become 
available for modification.

Macro equivalent: EDSTYLE (bypass dialog box)

Delete button
Click to delete the selected style.    Please note: The styles "Solid Line" and "Solid Fill" 
cannot be deleted, but they can be modified.

Help button
Click to display help for this dialog box.

You can type style names containing spaces on the command line when using the STYLES 
command.



Text equivalent: STYLES (displays dialog box)

Macro equivalent: SETSTYLE (bypass dialog box)

Macro equivalent: RENSTYLE (bypass dialog box)

Related topics
Define New Entity Style
Edit Entity Style 
Change Entity Style command 
Edit command 



Define New Entity Style (Specs menu)

To define a new line, fill, or arrow style, choose ENTITY STYLE (Specs menu) and click the New 
button.    The Define New Entity Style dialog box is displayed. The dialog box will initially take on the
settings of the highlighted style in the Select Style dialog box.

Note: before you CHANGE the style of an entity, define the new entity style first.

Define New Entity Style dialog box options
Style attributes

Name    Type a name for the new style you are creating.

Outline on    Enables lines to be drawn in a line style and around fill patterns.

Fill on    Enables multipolys and other closed entities to be drawn with a fill pattern. The fill 
pattern can be transparent, but redraws slower.

Line Style
Select      A drop-down list provides the various line styles that can be used.

Pen width    Sets the width of the line style to a number of pixels on the screen (and on the 
printer).

Pattern Length    If the "Scale to view" checkbox is not checked, the selected line pattern will 
be drawn over the specified distance (in current EasyCAD units), then repeated as needed.

Scale to view    If checked, the line pattern will remain visible as you zoom in and out.

Fill Style
Select      A drop-down list provides the various fill styles (patterns or crosshatches) that can 

be used.

Transparent     If checked, the background "color" of the selected fill style will be transparent. 
Other entities and special effects can be seen behind these fill styles. Please note: 
Transparent fill styles take twice as long to draw as opaque fill styles.

Arrowhead Style
Select      A drop-down list provides the various arrowhead styles

Length      Specifies the point-to-base length of the selected arrowhead in EasyCAD units.

Height      Specifies the height (or width) of the selected arrowhead.

Related topics
ENTITY STYLE command 



Edit Entity Style (Specs menu)

To modify an existing line. fill. or arrow style choose ENTITY STYLE (Specs menu) , select the style
you wish to modify, and click the Edit button. The Edit Style dialog box is displayed.

Edit Entity Style dialog box options
Style attributes

Name    The name of the selected style can be changed.

Outline on    Enables lines to be drawn in a line style and around fill patterns.

Fill on    Enables multipolys and other closed entities to be drawn with a fill pattern. The fill 
pattern can be transparent, but redraws slower.

Line Style
Select    A drop-down list provides the various line styles that can be selected.

Pen width    Sets the width of the line style to a number of pixels on the screen (and on the 
printer).

Pattern Length    If the "Scale to view" checkbox is not checked, the selected line pattern will 
be drawn over the specified distance (in current EasyCAD units), then repeated as needed.

Scale to view      If checked, the line pattern will remain visible as you zoom in and out.

Fill Style
Select    A drop-down list provides the various fill styles (patterns or crosshatches) that can be

selected.

Transparent     If checked, the background "color" of the selected fill style will be transparent. 
Other entities and special effects can be seen behind these fill styles. Please note: 
Transparent fill styles take twice as long to draw as opaque fill styles.

Arrowhead Style
Select    A drop-down list provides the various arrowhead styles

Length    Specifies the point-to-base length of the selected arrowhead in EasyCAD units.

Height    Specifies the height (or width) of the selected arrowhead.

Related topics
ENTITY STYLE



Dimension Style command (Specs menu)

The DIMENSION STYLE command displays the Select Dimension Style dialog box. Values for 
height, position, and precision (number of decimal places) for individual dimensions can be 
displayed and changed. Use this command to define arrowheads and select a text font for 
dimensions about to be drawn throughout your drawing.

To change the dimension style for a single dimension, use the EDIT command. For a collection of 
dimensions already drawn, use CHANGE-DIMENSION STYLE in the Edit menu.

Note: before you CHANGE the style of a dimension, define the new dimension style first.

Select Dimension Style dialog box options
Style Name
A scrolling list of style names appear.    The current dimension style is highlighted.

OK button
Click to apply and/or save any changes made to the selected highlighted style.

Cancel button
Click to end the dialog box without saving any changes.

New button
Click to display the Define New Dimension Style, allowing you to create a new dimension style, 
based on the highlighted style.

Macro equivalent: NEWDSTYLE (bypass dialog box)
Edit button
Click to display the Edit Dimension Style, allowing you to edit the selected dimension style.

Macro equivalent: EDDSTYLE (bypass dialog box)
Delete button
Click to delete the selected dimension style.    You can not delete the "Standard" style, but it can be 
modified.

Help button
Click to see help for this dialog box.

You can type dim style names containing spaces on the command line when using the DSTYLES 
command.

Text equivalent: DSTYLES (displays dialog box)
Macro equivalent: SETDSTYLE (bypass dialog box)
Macro equivalent: RENDSTYLE (bypass dialog box)

Related topics
EDIT 
CHANGE-DIMENSION STYLE 



Edit Dimension Style dialog box (Spec menu)

Changes made to the options in this dialog box affect dimensions already drawn in the current 
drawing. The Define New Dimension Style dialog box has the same features and functions, except 
where noted below. To change the dimension style for a single entity, use EDIT (Edit menu); for a 
collection of entities use the CHANGE DIMENSION STYLE command (Edit menu).

Edit / Define New Dimension Style dialog box options
Name

A dimension style name appears, if you are editing an existing dimension style.    A blank box
is displayed if you are defining a new dimension style. You may over-write the exixting name 
( unless it is "Standard" ), or type a new name if defining a new dimension style. You can edit
the "Standard" dimension style, but you can not rename or delete it. New styles may be 
based on the "Standard" dimension style.

Arrowhead
Select - A drop-down list provides the various arrowhead styles. Click on one to select it.

Length - Specifies the relationship of arrowhead length to dimension text height in    
EasyCAD units.

Height - Specifies the height (or width) of the selected arrowhead in EasyCAD units.

Leaders
Offset - Specifies the distance from the edge of a dimensioned entity to the start of the leader

line.

Length - Specifies the distance of the leader line beyond the extension line.

Radial Dimension Options
Always draw inside - Check this box to specify that text and arrows always be drawn inside 

the entity.

Text
Font - Select a font for dimension text and numbers from the drop-down list of available fonts.

Height - Specify the height of dimension text in EasyCAD units.

Prefix - Type a prefix for dimension text, for example, a prefix of "approx." (in feet-and-inches)
would display      "approx.    12 3/4".

Suffix - Type a suffix for dimension text, for example, a suffix of    "+/-.005" for a tolerance (in 
decimal inches) would display    " 12.75 +/-.005".

Decimal Places - Specify the number of decimal places to be displayed for individual 
dimensions drawn in this style.

Aligned with arrows - Specify dimension text alignment.    If not checked, dimension text will 
always display horizontally.

OK button
Click to apply, and/or save any changes made to the selected dimension style.

Cancel button
Click to end the command without saving any changes.

Help button
Click to see help on the dialog box.



Macro equivalent: EDDSTYLE (bypass dialog box)

Related topics
EDIT
CHANGE-DIMENSION STYLE



Text Properties command (Specs menu)

 Text Properties icon
TEXT PROPERTIES displays the Select text properties dialog box with choices for height, angle, 
line spacing, stretch, justification, and fonts for text you are about to draw.

To change a single existing text entity use EDIT in the Edit menu . To change a group of existing 
entities use CHANGE TEXT PROPERTIES in the Edit menu.

Select Text Properties dialog box options
Metrics
Height sets the height of a capital letter. The default text height is 0.2 units high. To change, type a 
new value in units or in feet-and-inches (for text 1/2 unit high, type .5 or 1/2).

Macro equivalent: TSPECH (bypass dialog box)

Angle sets the angle (any angle) at which text may be drawn. Positive angles are measured 
counterclockwise. For best results, use angles between -90° and 90°. The default angle is 0 
degrees horizontal. To change, type a positive or negative angle.

Macro equivalent: TSPECA (bypass dialog box)

Spacing sets the baseline of new text entities. The default spacing of each new text entity is 
specified at 150% of its height below the last text. (If the new text is 1 inch high, it's base line is 
1+1/2 inches below the old text, making the lines 1/2 inch apart.)    To change, type a different value.

Macro equivalent: TSPECP (bypass dialog box)

Stretch sets the proportion of the text entity. The default stretch is 1 unit. A value of 2 would 
produce text that is twice as wide as normal. To change, type a different value.

Macro equivalent: TSPECT (bypass dialog box)

Justify sets text baseline justification. The default justification is Bottom Left. To change, select a 
different option.

Macro equivalent: TSPECJ (bypass dialog box)

Font
TrueType ™    fonts that are installed in Windows are listed. The default is specified to be 
Arial    but can be changed by the user.

Macro equivalent: TSPECF (bypass dialog box)

Character style
Select the checkboxes for the desired effects for the selected font. Styles may combined to 
produce differing effects. No character style effects are selected for new drawings.

Macro equivalent: TSPECS (bypass dialog box)

Text equivalent : TSPEC (displays dialog box)

Related topics



EDIT
CHANGE TEXT PROPERTIES 
CHANGE DIMENSION STYLE 



Select by command (Specs menu)

SELECT BY displays a dialog box allowing you to set the selection method used for EDIT and 
COPY menu commands.    FULL DIALOG is the default and allows the full use of the Entity 
Selection dialog boxes.    If you choose EACH or WINDOW, EasyCAD marks the entities you select,
then carries out the operation without further choices.

Text equivalent: SELBY

Related topics
Selecting entities 



Configure XPs (Specs menu)

eXternal Procedures are assembly-language or C modules that let qualified third party developers 
add new commands and entities to EasyCAD.    (Each module can contain many commands.)    
Unlike macros, external procedure commands run at full EasyCAD speeds and otherwise act just 
like normal EasyCAD commands (they Undo, they repeat properly, modifiers work with them, and 
so on).

External modules can include custom associative dimensions, parametric symbols such as walls 
with intelligent windows and doors, real-time process control, date/time stamping, simulation 
modeling, pop-up calculators--almost anything programmers can imagine and tell their computers to
do. CONFIGURE XPs lets you load eXternal Procedures modules.    The Installed Modules dialog 
box is displayed.

Currently, EasyCAD provides four XPs that are preloaded at Installation.    They include several 
commands and modifiers (reflected in the ecad.mnu) that demonstrate the seamless integration of 
the XP interface.    For example, if FILLET or CHAMFER stop working for you, something has 
happened to one of these files, ECW1.XP

Installed Modules dialog box options
Install
Displays the Install XP Module dialog box. Select the name of the module you want installed by 
typing or clicking with the mouse. It will then be listed as installed in the Installed Modules dialog 
box.

Remove
To remove an XP module:
1. Highlight the module you wish to remove.

2. Click the Remove button.

3. EasyCAD asks, with an alert box "Remove Filename.XP?".

4. Click Yes to remove the module.

Removing an Installed Module does not delete the file itself from the hard disk.    Depending on 
several factors, you may find a maximum number of XPs you can have installed at the same time.    
Removing unused modules will free up room for new modules.

About
Displays a text screen listing module information.    This information is provided by the author of the 
individual XP commands.    A list of commands found in the XP text screen along with a short 
description of each function should appear.

Text equivalent: MODULES



Units command (Specs menu)

The UNIT command tells EasyCAD how to relate its internal unit system to the real world. You can 
define EasyCAD's units as anything you wish.    When you start a drawing, the default EasyCAD 
unit equals one inch in the real world.    INCHES, FEET, MILLIMETERS, and METERS are pre-
defined shortcuts for changing to some commonly used units. You can define other units, such as 
miles or microns, and assign them to the CUSTOM units definition.    Units should be defined before
you start to draw.    Otherwise, you may have to SCALE individual entities later on.

Units dialog box options
Drawing units

Inches equates each EasyCAD unit to one inch.

Feet equates each EasyCAD unit to one foot.

Millimeters equates each EasyCAD unit to one millimeter.

Meters equates each EasyCAD unit to one meter.

Custom equates each EasyCAD unit to whatever you want.

Inches per unit
This is the conversion factor EasyCAD needs to calculate dimensions and for printing your drawing 
to scale.    Enter a new number of inches per unit.    For example, to define each unit as one mile, 
type 63360 (5280 feet per mile times 12 inches per foot).

Macro equivalent: UNITM (bypass dialog box)

Distance display format
Numeric - Displays distances with no unit labels, to the number of decimal places you set 

with the DECIMAL PLACES value. For example, if a line measures 9.8765 units long, 
EasyCAD displays it as      9.877,    if you set decimal places to three. EasyCAD uses this 
format when you start a new drawing.

Decimal Inches - Displays distances with the (") symbol for inches, to the number of decimal 
places you set with the DECIMAL PLACES value.

Fractional Inches - Displays distances in US measurements, labeled in pure inches. They 
are displayed to the nearest one to 1/128th of an inch, . For example, if a distance 
measures 1.5 units long, EasyCAD displays it as    1 1/2",  if the drawing units are Inches. If 
you change drawing units to Feet, EasyCAD displays the same distance as 18".

Feet and Inches - Displays distances in US measurements, labeled in feet (') and inches (") 
to the nearest one to 1/128th of an inch. For example, if a distance measures 1.5 units long,
EasyCAD displays it as  0'1 1/2",  if the drawing units are Inches. If you change drawing 
units to Feet, EasyCAD displays the same distance as    1'6".

Macro equivalent: SETFRAC (bypass dialog box)

Meters    - Displays measurements in meters (M) but does not scale or change the Units of 
the distance being measured.

Millimeters - Displays measurements in millimeters (mm) but does not scale or change the 
Units of the distance being measured.

Macro equivalent: DISTFMT (bypass dialog box)



Decimal places
The number of decimal places you select affects the LIST and DISTANCE commands, tracking, and
dialog boxes. When Inches or Feet and Inches are selected as the distance display format, this 
changes to display inches to the nearest one to 1/128th of an inch.

Macro equivalent: SETDECP (bypass dialog box)

Text equivalent: UNITS

Related Topics
DISTANCE command 
LIST command

 



The Mod menu
The MOD menu includes several modifiers that lock to exact points on existing entities.With wide 
paths and wide polys, modifiers connect to points on their center lines.

To use a modifier
1. Activate a command (such as LINE) that prompts for a point.

2. Select a modifier to lock the first point to an existing entity. EasyCAD asks what entity the 
modifier refers to.

3. Pick a point on the entity within the cursor's pick box.    If EasyCAD does not find an appropriate 
entity after using the left button once, you must re-select the modifier again, then continue with the
command.

Using the function keys with modifiers
Many of the function keys have been pre-assigned to some of the modifiers using EasyCADs 
standard menu, ecad.mnu. 

Defining a function key equivalent for a modifier
Include in the menu file a line with a modifier, then a tab, then, for example, F2. SF2, CF2 or SCF2 
(Shift+F2, Ctrl+F2 or Shift+Ctrl+F2 respectively can also be used).    You can not use the Alt key, 
F1, or F10 in any combination.
Modifiers

Ref. Point On (F9) Angle to
Same X Percent Along (F7) Bearing
Same Y Distance Along (F8) Tangent to (F10)
Center (F4) Degree Intersection of (F6)
Midpoint (F3) Parallel to (F11) Like (F2)
Endpoint (F5) Perpendicular to (F12)



There is some hidden junk on this page that I cant get rid of...



Reference Point modifier (Mod menu)

EasyCAD stores the coordinates of the last point used in drawing or editing an entity--for example, 
the end of a line. EasyCAD uses this stored point as a reference point for the SAME X (vertical-
lock) and SAME Y (horizontal-lock) modifiers and to calculate the three forms of relative 
coordinates. You can use the REF POINT modifier to change the reference point to any other point.

First, select a drawing or editing command, then select REF POINT. The prompt reads "Reference 
point:". Select a new point with the crosshairs, use a modifier, or type coordinates.

REF POINT is especially effective used in combination with other modifiers to set the reference 
point to the endpoint, center, etc., of an existing entity.

Text equivalent: REF
Related Topics
Using the reference point modifier



Using the Reference Point modifier
1. This exercise uses REF POINT with MIDPOINT, another modifier, to draw a line starting two units 

to the right of the midpoint of an existing line. For this example to make sense, you should 
understand relative coordinates, and the MIDPOINT modifier.

2. Use LINE (DRAW menu) to draw a vertical line, then press the right button to end the command.

3. Select LINE (DRAW menu).

4. The prompt reads "1st point:", as usual. Select REF POINT from the MOD menu (instead of 
selecting a point).

5. The prompt reads "Reference point:". Select MIDPOINT (Mod menu).

6. The prompt reads "Select reference entity:". EasyCAD is asking which entity you want the middle 
of.

7. Use the cursor pick box and left button to select the existing line.

8. EasyCAD sets the reference point to the midpoint of the existing line. Relative coordinates will be 
calculated from this new reference point.

9. Type @2,0 and press ENTER.

10.EasyCAD draws the first point of your new line 2 units to the right of the new reference point--the 
middle of the old line.

11. The prompt reads "next point:". Select a point to complete the new line.



Same X modifier (Mod menu)

SAME X is a special modifier that aligns points vertically with the reference point by keeping the x 
coordinate the same as the last point. (It's like a one-time ORTHO lock.) First select a drawing or 
editing command, then SAME X. EasyCAD's prompt doesn't change. When you select the next 
point for the entity you are drawing, EasyCAD locks the point to the nearest point that lines up 
vertically with the last point used in drawing or editing.    For example, select the first point of a line. 
When EasyCAD prompts for "next point:", select SAME X from the MOD menu. The prompt still 
reads "next point:". Use the cursor and left button to select a point. EasyCAD draws the line from 
the first point to a point directly above or below the first point. In other words, EasyCAD gives the 
new point the same x coordinate as the first point, and the y coordinate you picked with the cursor.

You can combine SAME X with REF POINT to align a new entity with an existing entity. For 
example, to align a new circle with the center of an existing circle: Select CENTER & RADIUS from 
the CIRCLE dialog box. When EasyCAD asks for a center point, select REF POINT from the MOD 
menu. Select CENTER, then select an existing circle. EasyCAD resets the reference point to the 
center of the circle. The prompt reads "center point:" again. Select SAME X from the MOD menu, 
then select a point below the old circle. EasyCAD draws the new circle with it's center perfectly 
aligned with the center of the old circle.

Text equivalent: SAMEX
Related Topics
SAME Y modifier



Same Y modifier (Mod menu)

SAME Y is a special modifier that aligns points horizontally with the reference point. First select a 
drawing or editing command, then SAME Y. EasyCAD's prompt doesn't change. When you select 
the next point for the entity you are drawing, EasyCAD locks the point to the nearest point that lines
up horizontally with the last point used in drawing or editing

Please see SAME X for examples.

Text equivalent: SAMEY
Related Topics
SAME X modifier



Center modifier (Mod menu)

CENTER locks to the center of existing entities. As with all modifiers, you must first select a drawing
or editing command. The prompt reads "Select reference entity:". Select a point on the entity you 
want the center of. Please refer to the chart below for the effect of the CENTER modifier on various 
types of entities.

Entity Center locks on to
Arc, Circle, or Ellipse Center
Arrow, Dbl Arrow, Dimension, 
Line, Path, or Polygon

Middle of entity's total length

Point On the point
Smooth Polygon or Spline Middle of entity's total length
Text Middle of text, along baseline

Text equivalent: CEN (or press function key F4)



Midpoint modifier (Mod menu)

MIDPOINT locks to the midpoint of certain entities. As with all modifiers, you must first select a 
drawing or editing command. When you select MIDPOINT, the prompt reads "Select reference 
entity:". Select a point on the entity you want the midpoint of. Please refer to the chart below for the 
effect of MIDPOINT on various types of entities.

Entity Midpoint locks on to
Arc Halfway along arc
Arrow, Dimension, Line, Path, 
or Polygon

Middle of nearest line segment

Circle Nearest quarter-circle (0°, 
90°,180°,270°).

Ellipse Nearest end of either    axis
Point On the point
Smooth Polygon or Spline Middle of nearest frame segment
Text Middle of text, along baseline

Text equivalent: MID (or press function key F3)



Endpoint modifier (Mod menu)

ENDPOINT locks to the endpoint of certain entities. As with all modifiers, you must first select a 
drawing or editing command. The prompt reads "Select reference entity:". Select a point on the 
entity you want the endpoint of. Please refer to the chart below for the effect of ENDPOINT on 
various types of entities.

Entity Endpoint locks on to
Arc Nearest end of arc
Arrow, Dimension, Line, Path, 
or Polygon

Nearest end of total length

Circle Nearest quarter-circle (0°, 90°, 
180°, 270°).

Ellipse Nearest end of either axis
Point On the point
Smooth Polygon or Spline Nearest frame node
Text Nearest end of text, along 

baseline

Text equivalent: EPT (or press function key F5)



On modifier (Mod menu)

ON locks to a point mathematically on any entity selected within the cursor's pick box. As with all 
modifiers, you must first select a drawing or editing command. The prompt reads "Select reference 
entity:". Select a point on the entity you want to lock to.

Text equivalent: ON (or press function key F9)



Percent Along modifier (Mod menu)

PERCENT ALONG selects a point at a specified percentage of the reference entitys length. For 
most referenced entities, PERCENT ALONG treats the nearest endpoint from the selection point as 
its beginning. For example, 75% of a line is three-fourths of the way along its length, starting at the 
end nearest the selection point. As with all modifiers, you must first select a drawing or editing 
command.    The prompt reads "% value [0%]:". Enter a number. For example, to select a point 1/4 
of the way along a line, type 25 and press ENTER.    Now the prompt reads "Select reference 
entity:". Select a point on the entity you want a percentage of (remember that the selection point on 
the reference entity controls which end EasyCAD starts from when calculating the percentage 
distance).    You can use percentage values less than 0% or more than 100% on some entities. For 
example, you could use 125% to select a point 1/4 of the way beyond the end of a line.

Entity Percent Along locks on to
Arc, Elliptical Arc Percentage of length, from nearest 

selected end
Arrow, Dimension, Line, 
Path, or Polygon

Percentage of line segment length, from
end or node nearest selection point

Circle Percentage of circumference, 
counterclockwise from 0° end

Ellipse Percentage of circumference, 
counterclockwise from higher end of 
major (long) axis 

Point On the point
Smooth Polygon or 
Spline

Percentage of length along curve, from 
1st node (values <0% or >100% act like 
0%)

Text Percentage of length along baseline, 
from end nearest selection point

Text equivalent: % (or press function key F7)



Distance Along modifier (Mod menu)

DISTANCE ALONG selects a point at a specified distance of the referenced entitys length. For most
referenced entities, DISTANCE ALONG treats the nearest endpoint from the selection point as its 
beginning. As with all modifiers, you must first select a drawing or editing command.    The prompt 
reads "Distance along [0.000]:". Enter a number. For example, to select a point 1.5 inches of the 
way along a 10-inch line, type 1.5 and press ENTER.    Now the prompt reads "Select reference 
entity:". Selecting a point on the entity you reference controls which end EasyCAD starts from when
calculating the distance.    You can use distance values less than 0 on some entities. For example, 
you could use -2 to select a point 2 units beyond the end of a line.

Entity Distance Along value locks to
Arc, Elliptical Arc Distance along circumference, from 

nearest selected end
Arrow, Dimension, Line, 
Path, or Polygon

Distance from end or node nearest 
selection point

Circle Distance along circumference, 
counter-clockwise from 0° end

Ellipse Distance along circumference, 
counter-clockwise from higher end 
of major (long) axis.

Point On the point
Smooth Polygon or 
Spline

Distance along curve, from 1st node
(values <0 act like    0)

Text Distance along baseline, from end 
nearest selection point

Text equivalent: DIST (or press function key F8)



Degree modifier (Mod menu)

DEGREE selects a point at a specified number of degrees around an arc, circle, ellipse, or elliptical 
arc. (Angles are measured counterclockwise from zero degrees at 3 o'clock.) First select a drawing 
or editing command, then DEGREE.    The prompt reads "Degrees [same]:".    Enter an angle. For 
example, to select the 1 o'clock point on a circle, type 60 and press ENTER. Now the prompt reads 
"Select reference entity:". Select a point on the reference entity.

Please note: On an ellipse or elliptical arc, DEGREE selects points at a true bearing angle from the
center of the ellipse. For example, points 10° apart around an ellipse are not evenly spaced on its 
circumference.

Text equivalent: DEG



Parallel to modifier (Mod menu)

PARALLEL TO locks the rubber-band cursor parallel to an existing reference entity. You can use 
PARALLEL whenever EasyCAD prompts you for a point. The reference entity can be a line, text, 
polygon side, spline, and so on (any entity except an arc, circle, or ellipse).

Usually you will place at least one point before selecting PARALLEL TO The prompt reads "Select 
reference entity:".

1. Select a point on the reference entity. EasyCAD returns to the command you were using, but now 
the rubber-band cursor locks to the same angle as the reference entity. The prompt changes to 
"Select point:"; 

2. Stretch the cursor in either direction until it looks the way you want, then select the next point for 
your command.

Some suggestions for PARALLEL TO:
· Draw a line parallel to a polygon side;

· Draw an arc that starts at the same angle as a polygon side;

· Underline or box angled text;

· Place parts parallel to an existing line;

· Stretch a polygon, maintaining the angle of one of its sides.

Text equivalent: PRL (or press function key F11)



Perpendicular to modifier (Mod menu)

PERPENDICULAR TO locks the rubber-band cursor perpendicular to (at right angles to) an existing
reference point . You can use PERPENDICULAR TO whenever EasyCAD prompts you for a point. 
The reference entity can be a line, text, polygon side, spline, and so on (any entity except an arc 
circle, or ellipse).

Usually you place at least one point before selecting PERPENDICULAR TO (or pressing F12. The 
prompt reads "select reference entity:". 

1. Select a point on the reference entity. EasyCAD returns to the command you were using, but now 
the rubber-band cursor locks at the angle of the reference entity plus (or minus) 90°. The prompt 
changes to "Select point:";

2. Stretch the cursor in either direction until it looks the way you want, then select the next point for 
your command.

Text equivalent: PRP (or press function key F12)



Angle to modifier (Mod menu)

ANGLE TO locks the rubber-band cursor at an angle you specify to an existing reference refpoint. 
You can use ANGLE TO whenever EasyCAD prompts you for a point. The reference entity can be a
line, text, polygon side, spline, and so on (any entity except an arc, circle, or ellipse).

Usually you will place at least one point before selecting ANGLE TO. The prompt reads "Angle to 
add [same]:". The prior value (in brackets) is the angle EasyCAD calculated the last time you used 
PARALLEL TO, PERPENDICULAR TO, ANGLE TO, or BEARING (Bearing Angle). You can: 

· Accept the default or prior value angle by pressing the right button or ENTER;

· Type a positive or negative angle, which can include amounts like 11.05 or 22+1/2.

Now the prompt reads "entity:". Select a point on the reference entity. EasyCAD adds the angle you
entered to the angle of the reference entity, locking the rubber-band cursor to the resulting angle. 
Usually you place at least one point before selecting ANGLE TO. The prompt reads "Select 
reference entity:". 

1. Select a point on the reference entity. EasyCAD returns to the command you were using, but now 
the rubber-band cursor locks at the angle of the reference entity plus (or minus) 90°. The prompt 
changes to "Select point:";

2. Stretch the cursor in either direction until it looks the way you want, then select the next point for 
your command.

Text equivalent: ANG



Bearing modifier (Mod menu)

BEARING locks the rubber-band cursor to a bearing angle that you specify. You can use BEARING 
whenever EasyCAD prompts you for a point. Unlike PARALLEL, PERPENDICULAR, and ANGLE 
TO, this modifier doesn't ask for a reference entity--the angle is measured counter-clockwise from 
0° at 3 o'clock (horizontal). The BEARING modifier works a little like polar coordinates, except that 
here you specify distance visually instead of typing both an angle and distance.

Usually you will place at least one point before selecting BEARING. The prompt reads "Angle 
[prior]:". The prior value (in brackets) is the angle EasyCAD calculated the last time you used 
PARALLEL TO, PERPENDICULAR TO, ANGLE TO, or BEARING.    You may:

1. Accept the default or prior angle by pressing the right button or ENTER;

2. Type a positive or negative angle, which can include amounts like 11.05 or 22+-1/2.

EasyCAD returns to the command you were using, but now the rubber-band cursor locks to the 
angle you specified. The prompt changes to "Select point:". 

· Stretch the cursor in either direction until it looks the way you want, then select the next point for 
your command.

Tip: Use the prior angle to draw a series of parallel entities without having to select a reference 
entity over and over. Use PARALLEL TO for the first entity (this sets the default angle). Use 
BEARING for the rest of the parallel entities, pressing the right button each time to accept the prior 
angle.

Text equivalent: BRNG



Tangent to modifier (Mod menu)

TANGENT TO selects a point on a circle, arc, ellipse, spline, or smooth polygon that forms a 
tangent from the last point selected. You can use TANGENT TO whenever EasyCAD prompts you 
for a point. Usually you will place at least one point before selecting TANGENT TO. The prompt 
reads "Tangent to:".    Select an entity.    EasyCAD draws the line or line segment tangent to that 
entity.

Text equivalent: TAN



Intersection of modifier (Mod menu)

INTERSECTION OF locks to the point where two entities intersect.    The entities don't actually have
to cross, EasyCAD calculates the true intersection of the entities.    As with all modifiers, you must 
first select a drawing or editing command.    When you select INTERSECTION OF you are 
prompted for a "First entity" and a "Second entity".    Select a point on each of the two entities.

Text equivalent: INT (or press function key F6)



Like modifier (Mod menu)

The like modifier allows you to select or retrieve entities based on the common features (layer, 
color, style or dimension style) of an existing entity. Text properties can also be retrieved. LIKE, 
unique to the other modifiers, can be used to enhance the editing commands by refering to 
properties (not points) of entities.

For example, to change the color of selected entities to be the same color as a next-picked entity:
1. Use CHANGE to select the entities whose color you wish to modify.

2. After selecting DO IT, the prompt reads "New color:".

3. Select LIKE from the MOD menu (or press F2).

4. The prompt reads "Like entity:"

5. Select an entity that has the desired color.

6. All selected entities will now have the desired color.

Another example is to move all entities that share a common layer:
1. Use the MOVE command to Select by LAYER.

2. The prompt reads Entities on layer name [Dialog]:

3. Select LIKE from the MOD menu (or press F2).

4. The prompt reads "Like entity:"

5. Select an entity that is on the desired layer.

6. All entities that share that layer name will be selected to be moved.

Text equivalent: LIKE (or press function key F2)

Related topics
Entity selection dialog box
Selecting entities
Edit menu 

 



The Info menu

Commands under the INFO menu calculate and display coordinates, angle, distance, and area of 
entities. Others count and total entities as well as provide information about them.

Info commands
List Coordinate Length along
Count All Bearing Area
Count Distance Calculate

List command (Info menu)

The LIST command shows "vital statistics" on each entity selected. Some examples:

· The x,y coordinates of significant points (start, end, center, nodes, etc.);

· Layer, color, and style of each entity;

· Node lists of paths, polygons, and splines;

· Multipolys and their sub-records;

· Text specifications;

· Area of polygons.

LIST screen menu features:
· File menu allows you to save the list on the screen to a file as a TXT text file, print the LIST 

as displayed on the screen (if you have a printer connected to your computer), and set up 
your printer.

After selecting entities to LIST, EasyCAD displays a text window with as much information as will fit 
on one screen. Use the scroll bar to view more pages or press OK to return to your drawing.

Please note: LIST displays the name, insertion point, scaling, and rotation of every symbol 
reference. You cannot select symbol definitions using LIST (or any editing command). Instead, 
select LIST SYMDEF from the INSERT menu to see list information about symbol definitions.

Text equivalent: LIST



Count commands (Info menu)

The COUNT command totals selected entities (like LIST without the detail).

Text equivalent: COUNT

The COUNTA command does the same thing for an entire drawing, very quickly.

Text equivalent: COUNTA



Coordinate command (Info menu)

COORDINATE finds the x,y coordinates of any location in your drawing.

The prompt reads "Point to identify". 

1. Select a point with the crosshairs and left button.
EasyCAD displays the x,y coordinates in a message box, using the current distance display format 
(feet-and-inches, numeric, etc.) controlled by the UNITS command (in the SPECS menu). Press the
right button or any key to clear the message.

Text equivalent: ID



Bearing command (Info menu)

BEARING calculates the angle (measured counterclockwise, from zero degrees at 3 o'clock) of an 
imaginary line between two points.

The prompt reads "Bearing from:"

1. Select a point with the crosshairs and left button, or type coordinates.

2. Now the prompt reads "to:". Select a second point. EasyCAD displays the angle in a message box.

Text equivalent: BEARING



Distance command (Info menu)

DISTANCE calculates the distance between two points.

The prompt reads "From point:"

1. Select a point with the crosshairs and left button, or type coordinates.

2. Now the prompt reads "To:".    Select a second point. EasyCAD displays the distance in a message
box, using the current distance display format (feet-and-inches, numeric, etc.) controlled by the 
UNITS command (in the SPECS menu).

Please note: You can also use LIST (in the INFO menu) to find the length of an existing line entity.

Text equivalent: DIST



Length along command (Info menu)

LENGTH ALONG calculates the distance along an entity between two points on that entity.

The prompt reads "Select entity:"

1. Select an entity with the crosshairs and left button.    Now the prompt reads "From point on entity 
[entire entity]:"

2. Select a point. Pressing ENTER will return the entire length of the selected entity.

3. If you selected a point on the entity, the prompt now reads To point on entity:.

4. EasyCAD displays the distance in a message box, using the current distance display format (feet-
and-inches, numeric, etc.) controlled by the UNITS command (in the SPECS menu).

Text equivalent: LENGTH



Area command (Info menu)

AREA calculates the area bounded by an imaginary polygon, a real polygon, a smooth polygon, a 
circle, or an ellispe.

1. The prompt reads "1st point [or ENTER to select entity]:"

2. Select a point. Pressing ENTER will return the area of circles and ellipses.

3. If you selected a point with the left button, the prompt reads "next point:". Select a second point, 
then continue selecting points around the area you want to measure.

4. Press the right button to complete the imaginary polygon. EasyCAD displays the area in a 
message box.

Text equivalent: AREA



Calculate command (Info menu)

The CALCULATE command accepts an algebraic expression (with parenthesis) and returns a value
in EasyCAD units.

Text equivalent: CALC

 



The Macros menu

Understanding Macros
EasyCADs macro language is a text replacement facility. Here is how it works:

EasyCAD keeps a lookup table or dictionary of macro names and their definitions. Whenever 
EasyCAD gets a term (a word or value ended by a delimiter) from your typing, from a script, or from
a menu, it checks the macro table to see if that term has been defined as a macro name. If it has, 
EasyCAD replaces the macro name with the stored text.

You can store text in a macro name, either by defining a name with the MACRO and ENDM (End 
Macro) commands, or by using the name as a destination variable for a command like GV (Get 
Value). The stored text can be:

· A single value (for example, 2 stored in the name RED);

· A renamed command (for example, DSTYLE stored in the name DIMS);

· A command with one or more parameters (for example, the name SQUARE could contain
RPOLY 4 to let you start a 4-sided regular polygon by typing SQUARE);

· A series of commands making up a macro program.

You can use text equivalents of EasyCADs menu commands in a macro program. You can also use
the special macro programming commands explained in the Macro Command Reference. These 
special commands let you write programs that:

· Ask the user (yourself or another, less experienced user) to enter points, values, text, and
other data (prompting for user input);

· Store the data in variables (storing data in variables);

· Use the stored data in drawing and editing operations;

· Make calculations based on stored data (calculating with variables);

· Compare values in variables and make decisions based on the results (controlling 
program flow);

· Jump to a label within the macro or repeat a series of commands (controlling program 
flow);

· Call other macros as subroutines, for up to 16 levels of nesting.

You do not have to write programs to use the special macro commands. For example, if you want to
draw several lines radiating from a common point, you could use GP (Get Point) to store the point in
a function key, then press the key to enter the first point of each line. Using macro commands from 
the keyboard can help you learn how they work.    If you intend to write complex macros (using 
branching, looping, and so on), this discussion assumes that you are already familiar with basic 
programming concepts. 

Related topics
Load Macros
Edit Macros
Save Macros



Clear Macros
Macro Command Reference
Macro Tips 

-



Load Macros (Macro menu)
Clears any existing macro definitions, then loads a new macro table from a macro file. (This is 
faster than defining macros by using EDIT MACRO.) Type a file name or select a file with the 
mouse.

 EasyCAD ignores everything in a macro item after LOADMACM <filename>. 

When you start a work session, EasyCAD looks for the file ecad.mac, and loads it if it finds it in the 
current directory. (EasyCAD's designers have provided such a file that assigns commonly used 
modifiers to function keys.) When you load a drawing, EasyCAD looks for a macro file that matches
the name of the drawing. For example, if you load bolt.fcd, EasyCAD loads bolt.mac if such a file 
exists. The custom macro file for the drawing overrides ecad.mac.

Text equivalent: LOADMAC

Macro equivalent: LOADMACM

Related topics
Edit Macros
Save Macros
Clear Macros
Macro Command Reference
Macro Tips 



Edit Macros (Macro menu)
When you select EDIT MACROS, EasyCAD displays a text-editing window    with which you can 
edit or modify the current macro table. Select the Multi-line option to enter more than one line of 
text. While typing, you can:

· Use the keyboard arrow keys, HOME, and END to move the cursor within the editing 
window;

· Press DEL (Delete) to delete the character under the cursor;

· Press BACKSPACE to delete characters to the left of the cursor;

· Type special characters using the ALT key.

· Use Windows' CUT (^X), COPY (^C), and PASTE (^V) functions to transfer text in and out
of a plain-text word processor, like Notepad.

The current macro table is the area in memory that EasyCAD uses to store the active macro 
definitions. As such, if you make changes to the current macro table, they will be forgotten at the 
end of the session or when another macro file is loaded in its place. Use SAVE MACROS to make 
those changes permanent.

Text equivalent: EDITMAC

Related topics
Load Macros
Save Macros
Clear Macros
Macro Command Reference
Macro Tips 



Save Macros (Macro menu)

Saves all existing macro definitions to a macro file for later loading with LOADMAC. Type a file 
name or select a file with the mouse. Use caution when saving over an existing macro file. The best
strategy is to create, edit and test a set of macros using small individual macro files. Do not save 
the macros in one big macro file until they are thoroughly debugged, and keep a backup copy of the
macro files in case you want to change the macros later.

Text equivalent: SAVEMAC

Macro equivalent: SAVEMACM

Related topics
Load Macros
Edit Macros
Clear Macros
Macro Command Reference 
Macro Tips 



Clear Macros (Macro menu)
Completely clears the macro table, eliminating all macro, label, function key, and variable 
definitions. If your macros do not work and you can not figure out why, conflicting macro and 
variable names are usually to blame. Use CLEARM, then reload the macros one at a time from 
their individual files. 

Text equivalent: CLEARM

Related topics
Understanding Macros 
Load Macros
Edit Macros
Save Macros
Macro Command Reference 
Macro Tips 



Macro Command Reference
Related topics
Understanding Macros 
Load Macros
Edit Macros
Save Macros
Clear Macros
Macro Tips 

1. Comments can only be inserted in the .MAC file outside of MACRO/ENDM boundaries. See 
ecad.mac for examples.

2. A macro is defined by the sequence:

MACRO name
....
.....macro commands
....
ENDM

Note that neither MACRO or ENDM is valid from the command line. 200 macros    (max.) can
be defined at any one time, not to exceed a total file size > 64 Kbytes.

3. Variable names start with letters, (_) or ($) followed by digits, letters,    (_)s    or    ($)s. Variable 
names are limited to 32 characters.

4. In macros, scripts, or menu items, the sequence: ^Dprompt

displays the prompt text (ended with CR only!) and waits for live input.

^D forces live input for an entire getdata, which may be more than one point. For example, 
you now say BOX ^D  not  BOX ^D ^D. 

^D keeps the appropriate cursor and allows an entire pick cycle (MOVE ^D 0,0 1,1).

^D can be interrupted by a modifier or zoom from the menu/icon bar, but only if the menu file 
has a ^D for each command line input. Look at the modifiers and icons in ecad.mnu.

Right now, any ^D that doesn't have a prompt spelled out "inherits" the prompt from the last 
^D that had one, even if it's in a completely different macro!

5. The variable setting commands are:

FUNCTION SYNTAX

Get Point GP    variable    point.expression

Get Value GV    variable    real.expression

Get Number GN    variable    integer.expression

Get Word GW    variable    text.word.string

Get Line GL    variable    text.string (not delimited by space or tab)

Store distance between points GDIST    variable    point.expression    point.expression

Store angle point to point GBRNG    variable    point.expression    point.expression

Store X coordinate of point GETX    variable    point.expression

Store Y coordinate of point GETY    variable    point.expression



Values stored by these functions are formatted as numeric with 9 decimal places. The expressions 
are delimited by : a space, a semicolon, the equal sign, the ENTER key, or the TAB key. They can 
contain variable names defined above, the math operators (+ - * / ( )    ), and units operators ( ' , " , 
cm , mm , M , KM ). Note:The expression analyzer does not support unary minus. This means that 
if A=2, -A doesn't work. But 0-A works fine (-2).

6. Nothing is case sensitive.    The order of operations are:

parenthesis    (highest priority)
multiply or divide
add or subtract
units conversion operators
add or subtract after a units postfix operator (lowest priority)

7. Labels are a colon followed by a letter and then optionally more letters or digits or the    _ 
character.    Do not use the starting colon on a label reference (GO/IF) but use it where the label 
occurs:

:MyLabel
.....
..... other macro commands
.....
GOTO MyLabel

8. The control transfer commands are:
GO label
GOTO label
IFP    real.expression    label (if expression >0 then go to 
label)
IFZ    real.expression    label (if expression =0 then go to 
label)
IFN    real.expression    label (if expression <0 then go to 
label)

9. Use the PAUSE command to load and display several files in sequence. Pause will force a 
redraw after each file and ask for a keypress to continue.

Commands to bypass dialog boxes
Although you can drive the Select Entity dialog boxes from a macro (MOVE A D 0,0 1,1) and the 
dialog boxes will not display, there are some commands intended for use in macros and scripts 
when you want to bypass other dialog boxes. Note: these commands do not ask user confirmation 
before destructive actions (like loading a different file).

Bypass status buttons/dialogs with:
XHON, XHOFF, XHTOG Crosshairs effect control

ORTHON, ORTHOFF, ORTHOTOG Orthoginal effect control

CSNAPON, CSNAPOFF, CSNAPTOG Cursor Snap action control

SNAPON, SNAPOFF, SNAPTOG Snap action control

GRIDON, GRIDOFF, GRIDTOG Grid view control



FRAMEON, FRAMEOFF, FRAMETOG Frame view control

At any prompt for a filename, precede the filename with (#) to have EasyCAD substitute the 
directory where EasyCAD (ecw.exe) is installed. For example, if EasyCAD is in c:\ecadwin, then 
"menum #custom" loads the menu c:\ecadwin\custom.mnu and 
"loadm #dwgs\sample\square" loads the drawing c:\ecadwin\dwgs\sample\square.ecw.

Bypass file-selection dialogs with:
PARTM Insert part by name

PARYM Part array by name

CPARYM Circular part array by name

WRITEM Write part by name

LOADM Load drawing by name

RENAMEM Rename drawing

SAVEASM Save drawing as name

MENUM Load menu by name*

SCRIPTM Run script by name

LOADMACM Load macro file by name*

SAVEMACM Save macro file by name

TFILEM Insert text file by name

*Because loading a menu replaces the existing menu table in memory, EasyCAD ignores 
everything in a menu item after MENUM <filename>.    Same story with "code" in a macro after 
LOADMACM <filename>.

Bypass text-entry dialog with:
TEXTM Insert text typed on command line

Bypass view dialogs with:
VIEWM Zoom to view by name

SVIEWM Save current view as name

Bypass select by dialog (set selection method for subsequent List, Move etc) with:
SELSAVE Save select by status (use before SELBYE, SELBYA etc)

SELREST Restore select by status

SELBYD Select by: dialog

SELBYE each

SELBYW window

SELBYL layer name (or LIKE mod)

SELBYA all entities

SELBYC color # (or LIKE mod)

SELBYS style name (or LIKE mod)



SELBYP prior selection

Preset any select method with SELBYA, SELBYE etc. See "spokes" macro in ecad.mac.

At any prompt for a layer, style or dimension style, you can:

Enter a name (including spaces) delimited by (;) or CR, or
Enter an ID number preceded by (#), or
Use the LIKE modifier, or
(If live) press the Right-button to get the dialog box.

Bypass layer dialogs with:
SETLAYER Make a layer the current layer.

NEWLAYER Create new layer by name (use hide/thaw etc.)

RENLAYER Rename layer (not allowed for layers 0 and 1)

Bypass style dialogs (see examples in ecad.mac) with:
SETSTYLE Set current style by name

RENSTYLE Rename style (not allowed for styles 0 and 1)

EDSTYLE Edit style* by name (or LIKE mod)

NEWSTYLE Create new style definition

*Style flags (can be added ie 2+4=filled w/transparent fill):

1 style is outlined

2 style is filled

4 transparent fill style

8 non-metric lstyle (scale to screen)

Bypass dimension style dialogs with:
SETDSTYLE Set current dimension style by name

RENDSTYLE Rename dimension style (not allowed for dstyle 0)

EDDSTYLE Edit dimension style*/** by name (or LIKE mod)

NEWDSTYLE Create new dimension style definition

*Dimension Style text flags (can be added ie 1+16=over and aligned):

0 Text centered in dimension line

1 Text over dimension line

2 Text under dimension line

16 Text aligned with dimension line

**Dimension style flags:

16 Force inside arrow for radius/diameter dimensions

Bypass text specs dialog with:
TSPECF Set font by name (or LIKE mod)

TSPECH Set text height



TSPECA Set text angle

TSPECP Set text spacing

TSPECT Set text stretch factor

TSPECJ Set text justification*

TSPECS Set text style**

*Text justification codes:

Left Center Right

Top 6 7 8

Middle 3 4 5

Bottom 0 1 2

**Text style flags (can be added ie 16+32=bold italic):

1 Vertical

16 Bold

32 Italic

64 Underscore

128 Strike-out

Bypass Units dialog with:
UNITM Set inches per drawing unit

SETDECP Dec. places for dialogs, list, etc (not dimensions)

DISTFMT Distance format code*

SETFRAC Fraction rounding code for fractions of inches**

*Distance format codes:

0 Straight numeric

1 Decimal inches

2 Fractional inches

3 Feet and Inches

4 General Metric

5 Millimeters

**Fraction rounding codes - display to nearest:

0 Whole number

1 1/2

2 1/4

3 1/8

4 1/16

5 1/32

6 1/64

7 1/128





Macro Tips

Defining a macro
EasyCAD keeps a single dictionary or table of macro definitions in memory. The entire macro table 
(200 macro names and their contents) has to fit in 64K. EasyCAD builds its macro table from a 
macro file (like ecad.mac) loaded with the LOADMACM command. When you load a macro file, 
pre-existing macro definitions are cleared and replaced by the new macros in memory. 

Use EDITMAC (Macros menu) or    a plain-text editor to create and edit the macro file. 

Begin each macro with the MACRO command and the name of the macro. End each macro with 
the ENDM command on a line by itself. When your macros are thoroughly tested, use SAVEMAC to
save them in a  macro file with the type extension .mac. 
 To run each macro, type its name.

Macro names
A macro program or variable name can be any combination of characters ended by a space or 
semicolon--any word. Names can be as long as you want, but shorter names result in faster-
running macros, because EasyCAD has to read and interpret each character every time you run the
macro.

There are three ways to store text in a macro name:

· The MACRO command defines names that can be programs or variables;

· The Get commands like GW (Get Word) store data in names that are usually used as 
variables;

· Within a macro definition, you can define a word as a label by preceeding it with a colon 
(:). Several of the special macro commands jump to labels.

Delimiters
A delimiter tells EasyCAD where a command or parameter ends. A delimiter can be a:

· Space (    )

· Semicolon (;)

· the Equal sign (=)

· the ENTER key (carriage return)

· the TAB key

· the right mouse button

When you define macros, you should keep these rules in mind:

1. Some commands require an extra delimiter before your macro can continue to the next 
command. These include:

· Commands that automatically repeat or continue until you press the right button to end 
them. Examples include many DRAW commands and the CALC command for calculating 
with variables.

· Commands that switch to a text window, requiring a key or button press to return to the 



drawing window. Examples include COUNT and LIST. 

· Commands like DISTANCE (in the Info menu) that display an alert box.

2. SPACE or    TAB    is always a delimiter except in the parameters (responses) that follow these 
commands:

· ^Dprompt (Some text that asks for some input)

· In values to be entered in editable dialog-box items

3. SEMICOLON is always a delimiter inside a macro definition. Because a semicolon does act as a 
delimiter in a script or macro, it is impossible to include literal semicolons in macro parameters. 

4. ENTER (carriage return) and the right mouse button only work from the keyboard. EasyCAD 
"counts" the carriage returns that end each line in a macro, menu or script file.

Function keys
A function key (for example, F2) is a special kind of macro name. The function key F1 is very 
special: it provides context-sensitive help anywhere in the program and can not be used for 
anything else. Also, the F10 key is used by Windows to access the menu bar, as is the ALT key. 
EasyCAD recognizes the rest of the function keysthe 10 standard function keys (F2-F9, F11, F12) 
and the same keys combined with the CTRL key, and/or the SHIFT key. You can refer to a function 
key by its name (F2, CF1, SF6, SCF9, etc.), or just press the key or key combination.

To define a function key in a macro file, enter MACRO, then the name of the function key (F4, SF1, 
etc.), then the text you want to store in it. Enter ENDM on a line by itself to end the definition. This 
example in a macro file stores the modifier TAN (Tangent) in F9:

MACRO F9
TAN
ENDM

Function key variables are also useful when you are working within EasyCAD for storing a point or 
a value to use over and over during a work session. Define the function key with the MACRO and 
ENDM commands, or use a get command like GP (Get Point) to store data in a function key.

Note: In ecad.mnu, several function keys have been pre-defined to select modifiers. For example, 
F4 enters the CEN (Center) modifier. Several CTRL-ALPHA keys (^A, ^S) are also defined there.

Programming macros
1. Unlike true programming languages, a macro language does not know the difference between a 
macro used as a program, a macro used as a variable (a point, value, or other data), and literal text
(an EasyCAD command, a file name, or text to be drawn). It is up to you to avoid name conflicts. 

2. Terms that would be macro expanded can avoid expansion by preceeding them with an 
exclamation mark (!). This lets you define a new macro called COLOR that can call !COLOR 
(EasyCAD's color command) inside itself yet use the original command.

3. Within a macro table, make sure that each variable, label and macro name you use is unique. 
Also, never use an EasyCAD command (text equivalent) as a macro name (unless you want to 
redefine what that command does). Never use numbers as macro or variable names. Try to avoid 
using file names. If you write macros for other users, consider starting all macro, label, and variable 
names with a dollar sign ($) or some other unlikely character to avoid name conflicts.

4. Variables are never further expanded.    A value defined with MACRO/ENDM will be expanded as
long as necessary.



5. To run a macro, type its name. You can also run a macro by including its name in the menu data 
part of a menu item, if you make sure the necessary macro definitions get loaded (as a .MAC file) 
along with the menu (.MNU).

6. A macro can call another by name, effectively running it as a subroutine. EasyCAD allows up to 
16 levels of nested macros. When EasyCAD finishes performing the text in the called macro, 
control returns to the next command in the calling macro. Under some conditions (such as the user 
canceling by pressing the right button at a prompt), you may want to end all macros and return to 
the Command:  prompt without returning to the calling macro. To do this, use EXITAM (Exit All 
Macros).

7. For debugging macros, there are the very primitive STEP/NOSTEP commands which will cause 
a warning box to display at each new command, and to display the evaluated value of each real 
expression or component of a point coordinate. There is currently no way to shut off    STEP until a 
NOSTEP command occurs.

Related Topics
Understanding Macros 
Load Macros
Edit Macros
Save Macros
Macro Command Reference 

 



The Help Menu
Some general tips on using the On-Line Help System:

Use the Search facilities.    Every command and concept can be accessed through a 
keyword search.
Use the Bookmark feature to mark a frequently accessed topic.
Use the Annotation feature to include your own comments or notes on a topic.
Use the Print button to easily print a topic.

Contents
Current command Help  
Search for Help on
How to Use Help
About EasyCAD
EasyCAD Status



Contents command (Help menu)
    Help Icon/Command

The Contents command displays the EasyCAD Help Contents. You may also access this Help 
window by clicking the "?" icon or typing "HELP" at the command prompt.

Text equivalent: HELP or ?



Current command Help (Help menu)
When ever a command is in progress, select this menu item to display the help topic for that 
command. The function key F1 can also be used to get the current command topic.



Search for Help on...(Help menu)
The Search window of the Help System is displayed.    Type a word, or select one from the list with 
a double-click.    Topics that you can go to appear in the lower half of the window.    Select one of 
those topics, then click GO TO.

Text equivalent: HELPSEARCH



How to Use Help (Help menu)

If your are new to Help, the basics are included here.    You can use the scroll bar and click any 
underlined topic you wish to view.

Text equivalent: HELPHELP



About EasyCAD (Help menu)

About displays an dialog box with your EasyCAD version and serial numbers. If you have trouble 
with EasyCAD, please make a note of these numbers to report to our Technical Support 
Department at (602) 967-8633.

Text equivalent: VER



EasyCAD Status... (Help menu)

The Status command displays a dialog box listing free memory resources.

· System percentage specifies how much memory is available to be used by the core Windows 
internal structure.

· GDI percentage specifies how much memory is available for managing graphics and printing.

· User percentage specifies how much memory is available for controlling user input and output.    
This includes the keyboard, mouse, communications ports and window management.

· Free memory specifies the amount of resource memory available for use.

Text equivalent: STATUS

 





UNDO command

EasyCAD marks the entities affected each time you use a DRAW, EDIT, or INSERT command.    
After completing the command, select UNDO to put the entities back the way they were or to 
remove the newly added entities. You can use UNDO until you make a new selection, SAVE, or 
otherwise close your drawing.



select same feature

To edit or copy the entity or entities drawn with the last command, choose PRIOR from the entity 
dialog box.    For example, you can draw a box , then rotate it.



automatic series feature

Automatic series works with most entities and commands.    After drawing a single entity, you can 
continue drawing a series of the same entity type with the same entry options.    Press the right 
mouse button to exit the command.    (The whole series would be affected by UNDO or and EDIT 
command using selection by same.)



auto-repeat feature

When you see the "Command" prompt after leaving a command, press either button or ENTER to 
repeat without selecting it from the menu.



entity selection

You can select entities by criteria like location, layer, entity type, or color. You can combine criteria 
to select, for example, only arcs that are green and are on layer 4.    See "Using the entity selection 
dialog box" 



default or prior value

For many commands, EasyCAD displays a prompts followed by a default value in brackets, like 
this: "Radius [1.5000]:".    This is a suggested response EasyCAD will use if you press the right 
mouse button or ENTER, just as if you had typed it.    If you want to change the default, type a 
different value.



menu bar

Each word in the menu bar across the top of the screen is the title of a pull-down menu from which 
you may choose commands.



color bar

The color bar on the left shows the colors available on your display. The current color is marked 
with a check mark. Use the palette to select a different color at any time, even in the middle of 
drawing or editing.



reference point

The last point used in drawing an entity, or the last point selected in an editing operation, or the next
point indicated after selecting REF PT. from the Mod menu.



grid

EasyCAD can display a regular pattern of grid dots to help you judge distances and sizes. A grid 
can be rectangular or circular. Grids can have names for indivdual patterns, but only one grid can 
be active at a time.



snap and cursor snap

Snap locking makes points that you select on screen jump to coordinates at a spacing that you 
choose.    Set snap locking    or cursor snap on or off in the middle of any command using the 
Command line icon.



switches

Switches give on/off control over certain aspects of your drawing environment. You can temporarily 
force new lines to be horizontal or vertical (Ortho lock) or get a continuous readout of screen 
coordinates (Tracking). Group Unlock, Grid and Snap are also switches. Use the Command line 
buttons to control switches.



angle delta

Represents the number of degrees between the spokes of a circular grid.



radial delta

Represents the number of units between grid dots on the spokes of a circular grid.



frames

Imaginary lines connecting the nodes defining smooth polygons and splines.



absolute coordinates

Cartesian coordinates, counted in EasyCAD units from (0,0).



relative coordinates

Relative coordinates tell EasyCAD to draw from the reference point (last selected point) to a 
coordinate location a relative x,y distance away. Use @X,Y.



polar coordinates

Polar coordinates use the "less-than" sign (<), a bearing angle, and a distance (rather than a pair of
X,Y coordinates) to select a location in your drawing. Use    < angle,distance.



relative polar coordinates

These are like polar coordinates except that you use a tilde (~) instead of the "less than" sign (<), 
and the angle you enter is relative to the angle defined by the last two points you used.



symbol

A symbol is a named collection of entities that defines a complex object--each symbol acts like a 
single entity.    Like parts, symbols provide a mechanism for handling repeated elements.



part

A part is any EasyCAD drawing that you insert into another drawing.    Parts provide the best handle
for using repeated elements.



group

A group is a combination of multiple entities that act like, and are treated as, a single entity.    You 
can GROUP and UNGROUP collections of entities.



message box

A mid-screen window containing a message from EasyCAD to alert you of a potential problem.



dialog box

A temporary window that appears requesting information.    The dialog must be closed by selecting 
or typing responses , or by using the CANCEL button.



zoom out

Zoom out widens the view in the drawing window. More of the drawing can now be seen, but with 
less detail.



zoom in

Zoom in magnifies the view in the drawing window. Less of the drawing can now be seen, but with 
greater detail.



unit

Until you tell it otherwise, EasyCAD assumes that one unit represents one inch in the real world. 
Set units to feet, meters, or something else in the UNITS (Specs menu) dialog box.



ortho locking

Orthogonal locking temporarily forces new lines to be horizontal or vertical.    Use the Ortho button 
to toggle on or off.



entities

Entities are the individual geometric items (like lines, circles, arcs, etc.) from which a drawing is 
built.



entity color

All EasyCAD entities must have a color number from 0 to 15, displayed on the left side of the 
drawing window on the color bar.



background color

The color of the drawing window.    Background color may be any of EasyCAD's displayed colors, or
a special color #16 that is the color of the command line.



sidebar menu

The "daughter menus" or sub-lists that are displayed when you select a menu item that has a (>) 
beside it.



fill pattern

An assortment of patterns or crosshatchings with which circles, ellispes, polygons, multipolys, and 
other closed entities can be drawn.



DXF files

These are files that conform to the AutoCAD Drawing Exchange Format.    The DXF SAVE and DXF
OPEN commands write and read files per Release 12 of AutoCAD. Do not confuse them with DWG 
files, which can only be written and read by AutoCAD.



associative dimensions

EasyCAD draws associative dimensions to measure distances and angles.    When you modify the 
size or shape of entities, EasyCAD updates all dimensions in the drawing to reflect the new 
measurements.



concentric

A common center for repeated entities.    Circles, arcs, and ellipses may be drawn with concentric 
centers.



numeric coordinates

X,Y coordinates expressed in numbers using the "Cartesian" coordinate system.



angle to the screen

The "apparent" deviation from circular that would be seen if the entity on the screen were to be 
turned into the screen a number of degrees.



inclination

The angle along the major (long) axis of ellipses.



icon bar

The icon bar, to the right of the drawing screen, allows quick access to several useful functions 
such as zooms.    The icon bar may be used in the middle of other commands



zooms

Commands in the View menu that determine how much of your drawing appears in the drawing 
window at one time.



copies

Duplicated entities, created by using the commands in the Insert menu. 



bearing angles

EasyCAD's system of angles, ranging from 0º (zero degrees) to 360º, measured counterclockwise 
from 0º at "3 o'clock".



modifiers

Modifiers work within commands, allowing you to lock to specific points on existing entities when 
you draw or edit other entities.



origin

The (0,0) point for the coordinate system used by EasyCAD. It can be changed with the ORIGIN 
(View menu) command.



scroll bars (PAN)

EasyCAD has horizontal and vertical scroll bars that provide much the same function as PAN (View 
menu.)    Scroll bars are located at the right and bottom edges of the drawing window.    After every 
zoom to extents, the scroll bar buttons are repositioned to the middle of their respective sides.    
Display the scroll bars with the     Tools button.



tracking/status line

The tracking/status line (below the command line) displays the cursor location when activated.



metrics

Text property metrics specify measurements such as height, angle, spacing, stretch, and the 
placement (justification) of text entities.



paper inches

The PRINT (File menu) dialog box uses this number to produce printer output that is scaled to 
relate to actual drawing distances.



major axis

The longer diameter or, inclination, of an ellipse.



minor axis

The shorter diameter of an ellipse.



group locking

GROUP LOCK affects groups created with the GROUP or INSERT PART commands.    Locking is 
ON when the UNLOCK button is OUT.    The single-enitiy EDIT commands will operate on an 
individual entity in a group, while multiple-entity EDIT commands will operate on the entire group, 
even if some entities in the group are on hidden layers.
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Frequently Asked Questions (FAQ)
This is a collection of notes, questions, and answers fielded by the tech support 
staff. Hopefully, your question has already been asked -- many of those answers 
can be found below. 

 Q:    Why do I have to set ENTITY STYLES (names for each different LINE STYLE, 
DIMENSION STYLE, FILL STYLE and/or LAYER NAME) in each new drawing that I start?

A:  You dont !    When you start a work session, EasyCAD automatically loads a default drawing 
named WORK.ECW.    You should define all of your ENTITY STYLES, DIMENSION STYLES, and 
LAYER NAMES in this drawing and SAVE it.    When you want to start a new drawing, with 
WORK.ECW loaded, use the SAVE AS command from the FILE menu and type in the name for the 
new drawing.    You will now be working in the new drawing file with all of your ENTITY STYLES, 
etc. that were defined in the WORK.ECW drawing file ready to use.    Consider the WORK.ECW 
drawing as a "template" file.    It is usually a good idea not to draw in the WORK.ECW file.    When 
you do a SAVE AS to start a new drawing, you do not have to ERASE unwanted entities before you 
start to draw.

 Q:    Why do all of the lines or fill patterns in a drawing change when I use EDIT in the 
ENTITY STYLE dialogue box and choose a new LINE STYLE or FILL STYLE?

A:  There is only one LINE STYLE (i.e. Solid Line) and one FILL STYLE (i.e. Solid Fill) defined by 
name in EasyCAD.    If you select the CHANGE, ENTITY STYLE (Edit menu) command and click 
the EDIT button, you are modifiying the currently selected style to have different features. 
Everything that has been drawn using that style name will be redrawed to reflect the changes made
to the currently selected style.    You should use the NEW button, type in a new style name, and 
then change the style features using the scroll boxes.    This new style name will now be the 
selected style and all new entities drawn will be of that style. You can then use CHANGE, ENTITY 
STYLE    to force entities with an existing style to be redrawn with the newly-defined style.

Q:    What do the two LAYER names MERGE and STANDARD mean?

A:    The DOS versions of EasyCAD and FastCAD had NUMBERED LAYERS.    EasyCAD for 
Windows has NAMED LAYERS.    If entities are drawn on the MERGE LAYER (old LAYER #0), and 
saved in a drawing file, and that file is inserted into another drawing file with the INSERT PART 
command, its entities will be placed in the drawing on the CURRENT WORK LAYER. If entities are 
drawn on LAYER NAME STANDARD (old LAYER #1), or on any other layer name that you have 
defined, the INSERT PART command places them in the current drawing on the same layers used 
in the part file.

Q:    How do I plot to a file for a printer or a plotter?

A:    EasyCAD for Windows uses all Windows drivers for printers and plotters. These drivers come 
on the Windows installation disks or are provided by the manufacturer of your device.    When a 
driver is installed in Windows and is selected as the default printer, the EasyCAD PRINT command 
will show a selection box in the lower left corner of the dialogue box labeled "Print to File". If you 
check this box and then select the "OK" button you will be prompted for the name you wish to give 
the file.    This file can then be sent to the printer or plotter at a later time.

If you are EXPORTing your drawing files to DXF in order to use another program's facility to print 
them, consider generating a Plot-to-File.

Q:    Why does my printer not print correctly?

A: Most of the problems associated with printing seem to be due to the original printer drivers that 
come with your Windows installation disks. Even drivers supplied with your printer may not be up-
to-date. Most printer vendors have updated drivers for Windows available at little or no charge. 



Typical symtoms include: True-Type text does not print; text does not print at an angle; text seems 
to "jump around"; fill patterns do not print; circles look like ellispes; etc.    Many printer problems with
Windows are caused by drivers that are out-of-date and probably have since been fixed by the 
manufacturer of your printer or plotter.    Contact the manufacturer for updated drivers.    HP 
LaserJet III users: try Window's LaserJet II driver if you are having problems.

Q:    Why are there patterns in the color bar instead of solid colors?

A:    You are using a 16-color Windows video driver.    EasyCAD needs at least a 256-color video 
driver in order to accurately represent the drawing colors.    While in the Program Manager, use the 
Windows Setup facility to change your video driver.

Q:    Why do I not get any FILL PATTERNS on my pen plotter (Hewlett-Packard, Houston 
Instruments, Calcomp, etc.) or laser printers running in HPGL or HPGL2 mode?

A:    The FILL PATTERNS in EasyCAD use the bit-mapped patterns built into Windows.    Since pen 
plotters only understand vector patterns, the bit-mapped fill patterns can not be printed accurately 
with pen plotters or laser printers emulating them with HPGL or HPGL2 plotter languages.

Q:    Will my old SCRIPTS and MACROS written for EasyCAD or FastCAD for DOS work with 
EasyCAD for Windows?

A:    NO!    The SCRIPT and MACRO language has changed.    Print    the help topic on the MACRO 
COMMAND REFERENCE to get a list of the available commands.

Q:    Why can't I program my function keys    F1, F10 and any ALT key with function keys?

A:    These function keys are intercepted by Windows and can not be programmed by EasyCAD.    
Define other control keys and function keys (also called accelerator keys) in a menu file, by 
including (before the colon) a tab followed by ^A, etc., or F2, SF3, CF6, SCF3 etc. See how it's 
done in ecad.mnu.    Note that accelerator keys defined in a menu have precedence over keys 
defined in macros.

Q:    Why does text in the drawing window change length at different zoom factors?

A:     EasyCAD has to ask Windows to place the True-Type text starting at a given point and to be a 
certain number of pixels in height. There is a +/- 1/2 pixel accuracy per character which, if working 
with a 20-character line of text, can result in a +/- 10 pixel discrepency.

For example, ZOOM IN on some text, filling the drawing window with it. Windows now has more 
that enough pixels to accurately display the text. If you put a BOX around that text, then ZOOM 
OUT, the text may appear to change in width, relative to the box. PRINT the text at several different 
scale factors. The text should appear well-behaved, because most printers have enough resolution
to allow the text and box to print properly.    A "fine-tuning", if necessary, can be applied to individual 
text entities with the Stretch factor in the CHANGE, TEXT PROPERTIES command (Edit menu).

What are XP Modules?    eXternal Procedures are assembly-language or C program modules that 
let qualified third party developers add new commands and entities to EasyCAD.    The Setup 
program creates, and EasyCAD uses, a file called ecad.ini, located in your Windows directory. It 
currently contains two sections:

      1)    [Modules]    contains the    eXternal Procedures EasyCAD has available, and in which 
directory they can be found.

      2)    [User]    contains the Name, Organization, and Serial Number.of the Registered User.
Currently, EasyCAD provides four XPs that are preloaded at Installation.    They include several 
commands and modifiers (reflected in the ecad.mnu) that demonstrate the seamless integration of 
the XP interface.    For example, if FILLET or CHAMFER stop working for you, something has 
happened to one of these files, ECW1.XP .

If you encounter an error message, "Error attempting to load XXXXX.XP". Attempt to load in 



future?", you have probably renamed the directory EasyCAD is in, or moved the ecad.ini    file from 
the Windows directory. If you select NO, the XP module will be removed from the Installed Modules 
list. If you select YES, EasyCAD will continue to ask the question at the start of each session, until 
the problem is resolved.

Fractional parts of units (or feet and inches) now require use of the plus sign (+) when entering 
distance values on the Command Line: 6+1/2".

When you install a newer version of EasyCAD for Windows into the same directory, the Setup 
program will rename the existing ecad.mnu to ecadold.mnu, and rename the existing ecad.mac to 
ecadold.mac, just in case you have modified them.

Features and Functions that are attached to each drawing file:
Portrait/Landscape printer orientation 
Crosshairs ON/OFF
Layer names and their HIDE/FREEZE status
Grid patterns and Grid names
Entity styles and names
Dimension styles and names
Views and names

 




